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Introduction to

the Training
\ETITEL

Objectives of
the Training

TRAINING MANUAL

his training manual is prepared as part of the grand
research project on Improving Quality of Teaching
English Language Through ICT Tools: Arba Minch,
Sawla And Arba Minch Community Secondary Schools in
Focus funded by Arba Minch University. This project is
the first of the two consecutive projects planned to be
implemented by a team of experts from the College of
social sciences and Institute of Technology of the university. This
part of the two projects aims to improve the quality of teaching
English through ICT tools while the follow up project focuses on
the students with the aim of improving students’ ICT skills for
learning English Language skills. As phase two of the project aims
to train Teachers to use ICT tools for English Language Teaching,
this training manual is prepared to assist English Language Teachers
through a self-help training material. The manual included a number
of topics of ICT for ELT. Unit one is on Basic Computer Skills, unit
two is on Microsoft PowerPoint for audio-video supported lessons,
Websites and MOOCs for English Language teaching, unit four is
on Mobile devices for accessing ICT tool supported lessons, unit
five is Mobile Applications for English Language Teaching and
Learning, unit six is on Facebook group for English language
teaching and learning, unit seven is on Free Audio-video Record and
Playback Tools for ELT while the last unit is on E-learning
platforms for English Language teaching. Since the methodology
opted for is a hands-on discovery learning, your involvement in the
tasks is very vital.

This training generally aims to enhance English Language Teachers
skills of using ICT tools for teaching English. The training
specifically aims to enable teachers use, websites and MOOCs for
English Language teaching, English Language mobile applications
for English Language teaching, Microsoft PowerPoint for audio-
video supported lessons, Facebook group for English language
teaching and learning, Free Audio-video record and play back tools
for ELT (e.g. Snagit), e-learning platforms for English Language
teaching and mobile devices (e.g. cell phones and tablets) for
accessing ICT tool supported lessons.

AMU, DECEMBER 2019 7
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Unpacking your
thoughts

Objectives

Getting Ready

TRAINING MANUAL

1. What do you expect from this training?
Individually write three things you expect
from this training.

Now in pairs, make six expectations. If your
former expectations are similar, add new ones
Now.

Unit | — Basic Computer Skills for ELT
Professionals

At the end of this unit, you will be able to:

Identify parts of a computer
Open a computer

Use a computer

Shut down a computer properly

1. What do you know about computers? Write all the words you

2.

know in relation to computers?

In pairs, explain the functions of the parts in the following
picture. You should also explain how these tools can be used
in ELT.

AMU, DECEMBER 2019 8
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Introduction

TRAINING MANUAL

In order to properly use a computer or computing device it is
necessary to have a basic understanding of what a basic computer is
and how it operates. All computers have two things in common,
hardware and software.
~ Hardware is what the computer is physically made up of;
which includes the monitor, keyboard and mouse, and all of its
internal components which allows it to store, receive, and
process information and data.

o The central processing unit (CPU), or processor, contains
logic circuitry and performs the instructions of a computer’s
programs. It is the “brain” of the computer.

o Read-only memory (ROM) is the memory that comes with
your computer that is pre-written to hold the instructions for
booting-up the computer. Information can be read from
ROM, but not written back to it. ROM will retain data when
the computer is powered off. It is known as non-volatile
memory.

o Random access memory (RAM) is the memory available
for the operating system, programs and processes to use when
the computer is running. RAM can be read from, and written
to, for processing information and instructions. Data in RAM
is not permanently written and therefore known as volatile
memory. When you power off your computer the data stored
in RAM is deleted.

~ Software is made up of informational data and code that acts
as a set of instructions informing the hardware what actions it
is to perform or initiate. (ie. Software applications: The
computer’s operating system, Microsoft Word (word
processing), Excel (spreadsheets and data calculation), Web
browsers: Internet Explorer, Mozilla Firefox, Google Chrome,
and Apple Safari, Search engines: Google, Bing, Yahoo)
There are several different kinds of computers. The most common
computers are desktop computers, laptop computers, tablet or
touchscreen computers, and servers which allow computers to
network and connect with each other via the local area networks
(LAN) or the Internet. Other examples of computers may also
include smart phones, gaming counsels, kiosks and computers that
may also be found in home appliances such as TVs, refrigerators,
and vehicles which make use of software applications or apps to
connect and communicate with Internet service.
A computer is more than just another household appliance. The vast
amount of information and possibilities can be overwhelming.

AMU, DECEMBER 2019 9
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keyboard and mouse

You interact with a computer mainly by using
the keyboard and mouse, or a trackpad on laptops. Most people
find it comfortable to place the keyboard on the desk directly in front
of them and the mouse to one side of the keyboard.

The mouse controls the pointer on the screen. Whenever you move
the mouse across the desk, the pointer will move in a similar manner.
A mouse usually has three buttons (left, right and middle button).
You will often interact with the computer by moving the mouse
pointer over something on the computer screen, then clicking one of
the buttons.

SHOPPING CART

MY ACCOUNT ’;

LOG-OUT

On laptops, you can use the trackpad, located below the keyboard,
instead of a mouse. Simply drag your finger across the trackpad to
move the pointer on the screen. Some trackpads do not have
buttons, so you'll either press or tap the trackpad to click.

The keyboard allows you to type letters, numbers, and words into
the computer. Whenever you see a flashing vertical line—called
the cursor—you can start typing.

®@ O 2% goldiesfabfinds & google

F = O Www.gcﬂearnfree.org|
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Turning on a
computer

Using a computer

The very first step is to turn on the computer. Make sure all the
cables are plugged in correctly, and locate the power button. It's in
a different place on every computer, but it will have the universal
power button symbol (shown below).

Once turned on, your computer takes time before it's ready to use.
You may see a few different displays flash on the screen. This
process is called booting up, and it can take anywhere from 15
seconds to several minutes. Once the computer has booted up, it
may be ready to use, or it may require you to log in. This means
identifying yourself by typing your user name or selecting your
profile, then typing your password. If you've never logged in to your
computer before, you may need to create an account.

Juan Robinson
Password

The main screen you'll start from is the desktop. From here, you can
access the programs and features you need to use your computer.
Icons are used to represent different files, applications, and
commands on your computer. An icon is a small image that's
intended to give you an idea at a glance of what it represents, like a
logo. Double-clicking an icon on the desktop will open that
application or file.

TRAINING MANUAL

AMU, DECEMBER 2019 11
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Scroen Shot - /e
2015.0..3:05 pm

oo

A button is a command that performs a specific function within an
application. The most commonly used commands in a program will
be represented by buttons.

® O AA Picz Editor 4000

ﬂﬂﬂl:ll!gkﬂ

Menus are organized collections of commands and shortcuts. Click

a menu to open it and display the commands and shortcuts within.
Then click an item in the menu to execute it.

4,0
I 4 i) =

i ‘ :. ‘

When you open an application or folder, it is displayed in its
own window. A window is a contained area—Ilike a picture within
a picture—with its own menus and buttons specific to that program.

TRAINING MANUAL AMU, DECEMBER 2019 12
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You can rearrange multiple windows on the desktop and switch
between them.

www.goldiesfabfinds.com X

SHOPPING CART

MY ACCOUNT

ﬂﬂﬂﬂnﬂ,iﬂ

www.randomeolorsandsuch.com

Opening file and The file system icon will be in the bottom-left part of the screen.
application systems On a PC, the File Explorer icon looks like a folder, as in the
image below.

Computer View
* 1 ™, ThisPC
~ - =
43¢ Favorites Folders (6)  Devices and drives (4)
B Desktop j Desktop iy Local Disk (C:)
% Downloads | Documents &4 DVD Drive (D:)
1/ Documents 18 Downloads
B Movies
@ OneDrive ¥ Music
& Pictures

& Homegroup

4 1% This PC
m Desktop

!'| Documents v

12 items

When you double-click a file, your computer will automatically use
the correct application to open it. In our example, we're opening a
Microsoft Word document (Chicago Trip Details), which will open
in Microsoft Word.

TRAINING MANUAL AMU, DECEMBER 2019 13
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Basic navigation

Home Share View

-@- ‘:-_D} ~ 4+ B » ThisPC » Documents w O Search Documents

“ @ Sales Estimates 2013

W Favarites
Bl Desktop || Chicago Trip Detail
& Downloads J Personal Docurmen

o Documents . Tax Decuments

. Work Documents

f@ OneDrive

Y Homegroup

/% This PC

m Desktop
¥

B Mmmiirmmmd e

5 items 1 itern selected 11.4 KB

However, there may be times you may want to open an application

directly, instead of just opening a file.

e To open an application, click the Start button, then select
the desired application. If you don't see the one you want,
you can click All Programs to see a full list, or simply type
the name of the application on your keyboard to search for
it. In the example below, we're opening Internet Explorer.

‘d] Notepad
m Catculator b

! ‘ Getting Started

. Connect to » Projector

Sticky Notes

"% Saipping Tool

(W nticrosofe Waord 2010

Help and Support

ﬁ’ Windows Fax and Scan

% Remate Desktop Connection

> All Programs

If you see the file you want, you can double-click it with your
mouse. Otherwise, you can use the Navigation pane on the left side
of the window to select a different location.
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Deleting files

Home Share View

@ - 4 [EI ¥ This PC » Documents » v &
[l8 Downloads “  @% Sales Estimates 2013
&l Recent places Chicago Trip Details

|| Personal Documents
'H Tax Documents
'H Wark Documents

[> #@ OneDrive

[ I% Homegroup

4 M| This PC
2 m Desktop

12 |E| Docum-enls[

| g Downloads

b | @ Movies

b b Music

2 LEl Pictures o
Windows use Recycle Bin—to prevent you from accidentally
deleting files. When you delete a file, it is moved to the Trash can.
If you change your mind, you can move the file back to its original

location.

=l =» Mowve to Recycle Bin
s

Home

Share View

~ 1T E » This PC » Documents

_- Desktop > . Work Documents

@ Downloads | Tax Documents

¥| Documents J. Personal Documents

4. School Projects 2014-2015
37| Seles Esti 2013 |

& OneDrive

«& Homegroup

™ Thas PC
i Desktop
E Documents
8 Dowmloads ~
5 iterms 1 item selected 28.6 KB

If you want to permanently delete the file, you will need to empty
the Recycle Bin. To do this, right-click the icon and select Empty
Recycle Bin.
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Adjusting
computer’s settings

When you start using a new computer, you may want to begin by
adjusting the computer's settings. Adjusting your settings can range
from simple tasks such as changing your desktop background to
more advanced tasks like adjusting your security or keyboard
settings.
e InWindows 10, click  the Start button,  then
select Settings.

LE File Explcrer
o]

"'.!r' e TS

() Power

E— All apps

= 0O
o In Windows 8.1 and earlier, click the Start button,
then locate and select the Control Panel.

Admanistrator

Documents
Pictures

Music
§ Seting Started
= Computer
! Connect to a Projector —
Control Panel
Sticky Nates

Help and Support

TRAINING MANUAL

AMU, DECEMBER 2019 16



EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

Shutting down
computer

Introduction

Getting Ready

When you have done everything that you want using your
computer, it's important to shut it down properly.
e To shut down Windows, click the Start button, then
select Shut down (in some versions, this may say Turn Off
Computer or look like the power symbol).

4 /l Notep=d
/e Internet Esplorer

= Documertts
Calculztor
Pictures
= [ i Getting Started

Admanistrator

: Music

g' Cennect to a Projector

e Computer

£ . Sticky Noles
Control Panel

66%’ Snipping Taol

Devices andd Pranters

WA s
M sicrosoft Word 2010

Default Programs
& Paint
—-‘«.;ﬁ - Help and Support

4“ XPS Vieaer
ey "
&54 WindowsFax2nd Scan

% Remnate Desktop Connection

»  ANPrograms

I Search programs ond fiics

Unit Il - PowerPoint for Audio-video Support
ELT lessons

At the end of this unit, you will be able to:
® Produce contents into a slide
e Add different visuals into a slide
e Record/narrate slides

Microsoft PowerPoint is the app used to give presentations. You're
likely to see PowerPoint presentations used for everything from the
world's largest companies to grade school teachers sharing lessons.

Like any tool, PowerPoint is incredibly useful when used properly
for present. You can use it as an aid on your speaking engagements
to build comfort and drive points visually with your audience.

Has anyone of you used PowerPoint? If yes,
for what purpose?

What functions do you think PowerPoint can
have? Share your ideas in threes.
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PowerPoint's
Ribbon

1. The Ribbon
The ribbon menu is found across many of Microsoft's apps, such as
Word, Excel, and PowerPoint. It lives above the main area of the
application.

Design Transitions Animations Slide Show

-

'"'i_b % o | [ Layout ~ A - — | 4=
The PowerPoint ribbon lets you swﬂch between various tabs
contains a series of tabs that you can switch between. Each of these
have a unique set of tools to work with your presentation differently.
When you switch tabs on the ribbon, you'll see new buttons and
options to modify your presentation:
o File - Save, share, and export your presentation.
e Home - A general purpose collection of the most common
tools that you'll use in PowerPoint.
e Insert- An all-in-one tool to add every imagine-able type of
content, such as tables, pictures, charts, video, and more.
e Design - Controls the overall look and feel of your
presentation with theme and style settings.
e Transitions - Add animations when you switch slides.
e Animations - Controls the order and style that objects will
enter or exit your slide with.
e Slide Show - Control settings related to the way your
presentation appears when sharing it with an audience.
2. Home Tab
Use it for: a general selection of the most popular tools in
PowerPoint.
| usually stay on the Home tab when I'm working in PowerPoint.
The Home tab is the default and has many of the most commonly
used tools, all in one bar from adding a new slide to changing text
and raph settings.

Meet Techbox - PowerPoint Andrew Childress [ - 0

jl

s X I:l [ELayout~ ‘ — [’6) On _‘ ) Shape Fill - A Find

D ] = ‘ A APz is-
S dkﬂd ) ‘ (7 Shape Outline - | 3 Replace +
Paste AN A~ : " | Shey Am e Quick

. @ 5[,“ G Section~ BRIUS S sk Sy =ha (A B .ng Styles - Q Shapefffects~ | [} Select~

Clipboard 1 Slides Font f Paragraph fi Drawing L Editing
3. Insert Tab

When you're working on adding content to a slide, the Insert tab has

every possible tool to add new content to a slide. The Insert tab has

the tools you need to add tables, pictures, charts, and more.

Meet Techbox - PowerPoint Andrew Childress

Design Transitions Animations Slide Show Review View

I;I @ L_] [@ Online Pictures [—1<> S \EI D Q - 4 L

Screenshot ~
New | Table | Pictures o Shapes 1y Chart Add- Ll"kS Comment | Text Header WordArt Syml
()

Slide ~ & =) photo Album ~ v ins~ Box & Footer & =

Slides Tables Images Tllustrations Comments Text
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4. Views
PowerPoint has a variety of views which are simply different ways
to work with the same presentation. You can change the view in
order to get a different perspective on your content.

H -0 © = Meet Techbox - PowerPoint Andrew Childress

- — D— ——— - —— e oo e View R -
F E 1 1 T
=0 (2 =@ 3 Ruter = Color = B 3
FEIfEEEE A B E B gw (B Q @ S =2 B
N = . . [ Gridlines | = &= Grayscale <
[Normal Outline Slide Notes Reading = Slide Handout Notes 5 |Notes | Zoom Fitto | — 1 New Switch
I | View Sorter Page View Master Master Master [ Guides | | Window | mm Black and White | window E" Windows ~
Presentation Views Master Views Show 1) Zoom Color/Grayscale Window

In the screenshot below, you can see the difference between the
default Normal view and Slide Sorter view. Normal view shows
each slide front and center, while Slide Sorter view creates
thumbnails that you can drag and drop to reorder the presentation.

echbox - PowerPoint

Insert  Design  Transtions  Animations  ShdeShow  Review [ File Home  Inset  Design  Transitions  Animations.

desoner  [C]Slide Master [ Ruler I@ Q [EE Slide Sorter | [EJslide Master Ruler It—j Q =
— - : - L= =

idlis = Notes Page Handout Master Grid|
ites Page [ Handout Master [ Gridlines e | Zoom: Fito Celormal Outline B g 62 ] ines T ey )

adingView  [] Notes Master | [ Guides | | Window Grayscale - View [JReading View | [Z] Notes Master Guides Window Graysca
s Master Views Show 6l Zoom | Presentation Views Master Views Show i zoom

Meet
(® Meet Jechbox. @ Techbox

A full service firm. BOX

By Anchew Qrioms
P

A complete web
design firm that
builds your site.

5. Design Tab
An attractive presentation can really grab your audience's attention.
We use themes and styles in PowerPoint to add visual appeal to the
presentation, and the Design tab really controls these settings.

Meet Techbox - PowerPoint Andrew Childress e O

ok

This Presentation [+ @

Aa Aa Aa — Customi

Variants
Aa (€4

Custom

Aa TECH

e Y&

Office

Aa

. _______________________________________________________________|
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Quick Access
Toolbar

Adding Slides

Like the tabs and ribbon with other Microsoft Office products, you
also have the Quick Access Toolbar. As the name implies, this
feature allows you to perform quick actions.

fr) . H S - (-) IECIE Presentation

AutoCorrect

File Home Insert| itiens Animaticns Shide Show)

: Typing :
Slide Layout 1 Rul
= =E| [ uler
~-Shde Transition (] Gridii I
[ ; ridlines
Normal Qutline Slide Not-lNew Slide Handout Notes ) N
| View Sorter pagNewSlide r Master Master | [] Guides |

New Slide
MNew Slide

5, . | _
Presentation Views k '|V|EStEI’ Views Show

The Save button lets you easily save the file you are working
on with the current file name.

If you make a mistake and want to undo it, just click
the Undo button. If you click it once, it will undo the last
action you took. If you keep clicking it, it will undo each
previous action by moving backward. Alternatively, you can
click the arrow next to the Undo button and highlight all
actions you want to undo.

If you undo an action with the button, the Redo button will
then be clickable. This lets you redo what you have just
undone. Like the Undo button, you can redo your last action
with one click or use the arrow next to the Redo button to
redo multiple actions.

The Presentation button lets you start your slideshow as it
will be viewed by others. It should take up your entire screen
for a nice view of the presentation at any time during your
creating or editing processes.

You can select the arrow on the right of the Quick Access Toolbar
to add or remove buttons from it easily. You can also see more
commands available or move the toolbar below the ribbon.

To insert a new slide, go to the Insert tab on PowerPoint's ribbon.
Then, click on the New Slide button to add a new slide to your
presentation.

: - Click to add title 2
I == I~ Click to add text = |
3 con

2 - &0 aln

el &

7|

A new slide will have basic placeholders to add your content to in
PowerPoint.
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Adding Content

Choose Theme and
Style

Adding Audio &
Video

Content is what defines each and every slide. PowerPoint
accommodates a wide range of content like text, graphs, tables,
charts, and more. The easiest way to add content is to start off by
choosing a Layout, which you can choose from the Home tab.

Meet Techbox - PowerPoint Andrew Childress s}

DARK MIDDLE DARK BOTTOM
SLIDE

1_BLANK TITLEand LOGO ~ DARK TOP SLIDE

IMG-SLIDE CPT-5 | Title an nten!

screen 02 copy

Title Only

leand Content  Section Header  Two Content Comparison

These layouts have content boxes that are easy to add your own
content to. Simply choose a layout, and then start adding your
content.

After you build out your presentation's content, it's a great idea to
think about adding visual style. For this, you'll jump over to
the Design tab, and click on one of the thumbnails for a theme.

Meet Techbox - PowerPoint

Animations Slide Show

This Presentation

e (e [[2e |
‘ title

Custom

2]

Office

‘| Aa | ’7Aa El Aa 2
B e (e | = i =

Using a PowerPoint theme is the preferred alternative to adding
backgrounds, color and type styles to each and every slide.
Changing the theme typically will adjust the entire presentation
simultaneously. This greatly reduces the time involved with

building a presentation.

Variant
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The following steps will help you add audio or video file to the
slides which can be played during the presentation.

Step 1 — Go to the Media group under the Insert ribbon

Insert Ribbon

Title Slide2.pptx - Microsoft PowerPoint | I@—“El@

Home | Insert | Desion T Slide Show

Media Group

View & @
== - Clip Art P Shapes - 2, . [ [ [=2 | *9
&=+ Screenshot ~ R smartart |
Tabte Picture Links Text | Symbols Medla
= =3 Photo Album ~ | gilg Chart - ~
Tables Images Illustrations |

&= =2~ S =

= = < -

-

i

Wl

| - | Click to add notes
Stide 15 of 17 | ~Office Theme- | <5 |

{)

EBlsm e 37% o 0O+ & B3 .

Step 2 — To insert video file select Video as media type and Video
from File to insert a video from your computer or hard drive.

Video options

Video media

Title Stide2 pPag - Mi i [ESSf=RE==)
tome | e | Orsn Tarsivend frmatons_stosshem _fsiew Ve (16
[ Clip Art. Shapes ~ N\ |
== R = =@ ) a| | 4]
&5 Screensnot = sas.“mm |
Tabie. | Picture Lk Text  symbols Mefia
= | =) Proto Album ~ | gl Chart ~ ~ -
Taores | images | Sudisiations I | |
H9-06 < &3] <®
= = = — Video | audio g =
1o E— =
Se
oo

€3 Video from Eile...
Video from web Site...

Ciip Art Video...

(8]

4

L OV an

Click to add notes
Stid=15 o117 | “Office Theme: | &5 |

EleEaz 370 0 @&
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Step 3 — In the Insert Video dialog, browse for a video file and

click Insert.
[B] Insert Video e o2 Ziomm]

9'17 » Libreries » Videos » Sample Videos - |f3 | I,E,‘-f’fhiglr'fe{ff Vigeos ,Og

Organize v New folder =~ o @
4 Downloads - v —
33 Dropbox Arrange by: Folder ~

Desktop
=) Libraries =

3] Documents 3
< Music | Wildlife.amv
&= Pictures b
1. Podcasts
E Videos
+3 Homegroup
A Ram
1% Computer
€ Network
= Control Panel
2] Recycle Bin

Ll Farnitiors

File name: Wildlifeavmv - [Video Files (*.asf;".asc . wpl*.w v]

Tools [ Insert ]V] { Cancel ]

Step 4 — You will now see that a Video file is added to the slide.
[ﬂ Title Slide2.pptx - Microsoft PowerPoint \11%! lcﬂ—E]&

Home | Insert | Design | Transiti | Animati | Slide S¥ | Review | View || Format “ Playhack| o @

p %' ga, T, 31 8ring Farward '|;_a.— g*: 31420 em =

4 send Backwara - g3
Crop 3254 cem 3

=
Corrections o Video

Pia;
Y = B3~ stylesw <2~ S, Selection Pane Sk~
Praviews Adjust Video Styles o | Arrange ‘ Size =
H9-06 =
= -
‘°
I
=]

~
) 2
» I <i > oocooos () | =
J Click to add notes =
Slide 16 of 18 .| ~Office Theme~ | <£ | |[[Bes e = 37% (0O @ a

Step 5 — To insert audio file select Audio as media type and Audio
from File to insert an Audio from your computer or hard drive.

Audio media

Audio options

Title Stide2.pptx - Migrosoft PowerPoint |E= EESHEST)

| | Home | fnsert | Design Teansitions  Anhgtions  Slide Show  Reviews |view o @
i] =] =l cnp are ¥ Shapes ~ | 2 B
| &3+ S hot ~ =2 smartart -
Table | Picture __ i = Links : Symbols Media
& Pnoto Album ~ | gl Chart S ~ ~
Tables fmages Hlustrations | A 4
H9-06 = 23 (<@ l
= = [x] deo [Augio | =
= = \ I
i Audio trom File...
S
S Clip Art Audio...

Record Audio...

o

< || dlick to add notes =
Slide 15 0f 17 | ~Office Theme- | <& | |/Missm = 37 o O 1 e )
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Step 6 — In the Insert Audio dialog, browse for an audio file and
click Insert.

(2] Insest Audio B e —— [
‘w, A Lnbranes » Music » Sample Must: - I 45 ” Seorch Scmple Music ,0‘
Organize v MNews folder B=ow (| @

/ = 5 ~ M
LE] Microsoft PowerPoint : - Arrangeby:: Folder.~
i Favorites Name -
B Desktop
%] Recent Places E] Kalimba.mp3
0. Downloads |2] Maid with the Flaxen Hair.mp3
23 Dropbox [[2] Steep Away.mp3
BE Desktop
4 Libraries
Iq_] Documents
& Musnc
[ Pictures
1. Podcasts
EE videos
Q? Homegroup TR :
File name:  Sleep Away.mp3 - [Audio Files (*.adts;".ady;".aac;". vl
Tools ¥ I Insert 1vl [ Cancel ]

Step 7 — You will now see that an Audio file is added to the shde.

'P,I Title Slide2.pptx - Microsoft PowerPoint “Aa. | B[S
Home |‘xnurt Design | Transiti | Animati | Stide Sk | Review | View | Format | Playback | o @
B ol At Psnopes- (@ | (a4l [2]|[0]
&5+ Screenshot ~ Eysmartart | | = — |
Table | Picture Links | Text Symbols Meaia |
- &) Pnoto Atbum ~ | @) Chart ~ - | -
Tables l Images fMustrations ‘ |

Py
_
15 >
‘ <[> 022000 w3
16 |
17 | | I |
3
E !
| -
~

I Click to add notes ~
Stide 15 of 17 | “Office Theme® | <5 | |[Bigsea = 37 &-0——@& &3 .

Add text Select a text placeholder, and begin typing.

?. ....................................... 6 ..................................... .?
Production Demand |

(u}

S T — 4

p Click to add text

. _______________________________________________________________|
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Format your text 1. Select the text.
2. Under Drawing Tools, choose Format.

Drawing Tools = Presentation? - PowerPoint

View D Tell me what you want to do..

J— ~| £2 shapeFill - =] A Text Fill -
| Abe Abe Abec z ZShape Outline - z ﬂTﬂt Outline -
— = | L& Shape Effects - A A A T | B Test Effects -
ape Styles [F] WaordArt Styles [F]
3. You can change the format by clicking
Add pictures On the Insert tab, do one of the following:

o Toinsert a picture that is saved on your local drive or an
internal server, choose Pictures, browse for the picture,
and then choose Insert.

e Toinsert a picture from the web, choose Online Pictures,
and use the search box to find a picture.

Insert Pictures

@ Bing Image Search Search Bing
Search the web

Choose a picture, and then click Insert.

Add shapes 1. On the Insert tab, select Shapes, and then select a shape
from the menu that appears.

2. Inthe slide area, click and drag to draw the shape.

3. Select the Format or Shape Format tab on the ribbon.
Open the Shape Styles gallery to quickly add a color and
style (including shading) to the selected shape.

Drawing Tools Dod

Layout References Mailings Rewiew View | Format | Q Tell mewhg

& Shape Fill -

ﬂ ﬂ ﬂ ﬂ ﬂ : ;’IShape DUtIinev

&3 Shape Effects =

4

Shape Styles ra
Add speaker notes Slides are best when you don’t cram in too much information. You
can put helpful facts and notes in the speaker notes, and refer to
them as you present.

1. To open the notes pane, at the bottom of the window,

= HMotes

click Notes

2. Click inside the Notes pane below the slide, and begin
typing your notes.
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Using Notes in Your When you present your slideshow to an audience, only you can see
Presentations your notes. This makes it a great tool to hold your descriptions,
explanations, or instructions as you present your slideshow.

Let's Start Simple! Sy
« Classroom Number: 2A
« Lunch Hour: 1% Lunch - 12pm

» Recess Time: 1% Recess = 2pm

This is where you can add your speaker
notes. It's handy for presenting your
slideshow!

Slide 2 of 11 @

Add Animation If you are considering adding animations to your slides, it’s super
easy to do. Animations can be effective for slideshows you create
for education like classroom presentations or college lectures. These
are the basic features available on the Animations tab.

e Animation: Choose from a variety of options by clicking the
arrow in the Animation

o Effect Options: Different animations have extra options for
you to pick from.

e Advanced Animation: Here you can add an animation, open
the Animation Pane for more working room, set up a trigger,
or use the Animation Painter.

e Timing: Decide how you want your animations to appear on
the slide. You can pick a duration time, delay time, and reorder
your animations.

e Preview: Once you add an animation you can see a quick view
of how it will look without exiting the editing mode or opening
the presentation view.

Entrance

* k y1¢ ¥ Jr * w > = iy ¥

Appear Fade Fly In Flast In Split Wipe Shape Wheel  RandomBars Grow & Tum  Zoom

(=]
¥* ¥
Swivel Bounce
Emphasis
A - - - 4 - -
T A : j * iy 7 3 2y ik
Fulse Color Pulse Teeter Spin GrowfSheink  Desaturate Darken Uighten  Transparency ObjectColor Complemen.,
“% "k A A - Sk > 5 -

LineColer  FillColor  BrushCalor  Font€oler  Undedine  Bold Flash  Bold Reveal Wave
Exit
* ¥ ¥ H* w * x & He
x I 1 +* 3
Disappear Fade Fly Out Float Out Split wipe Shape Wheel  RandomBars Shrink&Tum  Zeom
¥ ¥
Swivel gounce
Motion Paths

- -1 O) <0

L

Lines s Turns Shapes Loops Custom Path
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Apply Transition Inserting transitions between your slides can be another effective
Effects way to keep your audience’s attention, similar to animations. You
can apply a unique visual, with or without sound, as you move
through the slides of your presentation.

Transition Options

These are the basic features available on the Transitions tab.

e Transition to This Slide: Pick from the transition options by
clicking the arrow in the box.

o Effect Options: Different transitions have extra options that
you can apply. For example, the Wipe, Wind, and Orbit
transitions let you pick the direction.

e Timing: Here you can add a sound to go with your transition,
pick a duration time, and apply these items to all slides.

e Preview: Once you add a transition you can see a quick view
of how it will look without exiting the editing mode or opening
the presentation view.

" ®E @ 8 ¥ E ML N OO 3 4 O
Puih

Nané Merph Fadi Wit 5t Fisatdl ] Randorn Bars  Shags Wit ot flath
Eciting
a 8 U 8 F ¥ & F B ¥ ¥ & &
Fall Cheer Drape Cutars Wind Prestige  Frachre Cnsh PeelQ  Pagelil  Aplane  Origami Dimolve  Checierboa.
HE M 0 BE & KR B £ B C 0 O O
Blads Cluck Ripgle  Homegomb  Gliner Vane Sheed Swiih Flip Gallery Cube Doars Boy
= X @B
Caml Toam Fandeen
Dynamic Comtent
B ¥ E 0 O O ©
Fan Fems Wheel  Comaryor Rotate Wirdow (bt Fly Thgugh
Use Different Not everyone works the same way when it comes being creative.
Presentation Views Luckily PowerPoint offers different built-in views to accommodate

this. Just select the View tab and take a look at the ways in which
you can work with your slideshow.
The Presentation Views section holds five unique ways to create or
edit your slideshow. One of those is the Notes Page which you read
about above. And, here are the other four with brief explanations.
1. Normal: As you can probably guess, this is the basic, normal
view. You should see your slides on the left as numbered
thumbnails and the current slide in the largest section to the
right. This view works well if you prefer to jump between
slides visually.
2. Outline View: For those who prefer to write or create using
outlines, this view is ideal. You can write directly within the
outline pane on the left or paste an existing outline from

. _______________________________________________________________|
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Microsoft Word directly in. Here again, the current slide is
in the largest section to the right.

3. Slide Sorter: This is a terrific way to see all of your slides
at a glance. Taking up the entire center window, you can see
each slide and can reorder them easily with a drag-and-drop
action.

4. Reading View: If you want to see your entire presentation
without switching to full-screen mode, then just click this
button. You can view your slideshow with animations and

transitions easily.
e ot oo porsirs s _tcin W p D e retsrioso 1535 29 |

EEEDEEE D™ [BQ@EEE &8 F E

e m =g
Gridtines | Grayeste
Normat Outine Side Notes Reading | Side Handout Notes U Gridtines IGO0l zoom Fitto  mROTY New Switch  Macros

| View | Sorter Page View Master Master Master ClGuices | Window WmBtackand White  ywindow T Windows -
Presentation Views Master Views Show i Zeom Color/Grayscale ‘Window Macros ~

1] Welcome to 2™ Grade! -
Ms. Stachowiak’s Wonderful Class

2. Let’s Start Simple!
*Classroom Number: 2A :.' .
«Lunch Hour: 1# Lunch - 12pm AU

* Recess Time: 1% Recess - 2pm ‘Av.
Se ettt Welcome to 2nd .
-Fimbvllﬂpoinl!wrc Grade!

*Second bullet point here
*Third bullet point here Ms. Stachowiak's Wonderful Class

4 Title and Content Layout with SmartArt
5 Section Header Layout _Q
i e
Subtitle 3
6 Picture with Caption Layout d

&,

Caption
7 Add aSlide Yitle - 1 :
-
Add a Slide Title - 2 P

Along with the Slide Sorter view, the Normal and Outline Views
allow you to quickly reorder your slides. Just select one and then
drag it to its new location.

Save your 1. On the File tab, choose Save.

presentation 2. Pick or browse to a folder.

3. Inthe File name box, type a name for your presentation,
and then choose Save.

Places L] Computs
;;; Microsoft Current Folder
joym
f& ov Miller's CreDrve :
(£ Other Web Locations Recent Folders
- Documents
I‘l;l Computer —

Tip: Save your work as you go. Press Ctrl+S often.
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Give your
presentation

Record a slide show
with narration and
slide timings

On the Slide Show tab, do one of the following:
o To start the presentation at the first slide, in the Start Slide
Show group, click From Beginning.
E - 0 @ a = =

File Home Insert Design Transitions Animations Slide Show

;@ =5 E Eb‘ ’__‘ /‘9 Play Narra
; = & W,
= — .%r i .lgr ] © @ . Use Timin
From Fram Present Custom Slide SetUp  Hide  Rehearse Record Slide
Beginning Current Slide | Online~  Show= | SlideShow Slide | Timings Show~ [¥] Show Me
Start Slide Show Set Up

o Ifyou’re not at the first slide and want to start from where
you are, click From Current Slide.

o If you need to present to people who are not where you are,
click Present Online to set up a presentation on the web,
and then choose one of the following options:
= Broadcast your PowerPoint presentation online to a

remote audience
= Start an online presentation in PowerPoint using Skype
for Business
Get out of Slide Show view
To get out of Slide Show view at any time, on the keyboard,
press Esc.

Your students, would like to listen or watch back your PowerPoint
Supported classroom presentations/lessons especially those students
with hearing and visual disability. Hence, you may have to record
your lesson with your voice added to it. This section helps you to do
SO.

Narrations and timings can enhance a web-based or self-running
slide show. If you have a sound card, microphone, and speakers, and
(optionally) a webcam, you can record your PowerPoint
presentation and capture narrations, slide timings, and ink gestures.
After you have made the recording, it's like any other presentation
that can be played for you or your audience in Slide Show—or you
can save the presentation as a video file.
Record a slide show
With your presentation open, on the Slide Show tab, click Record
Slide Show.
v" Clicking the upper half of the button starts you on the current
slide.
v Clicking the lower half of the button gives you the option to
start from the beginning or from the current slide.

TRAINING MANUAL
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.

Record ;Slide
Show =

I__.' Record from Current Slide...
sl Record frem Beginning...
Clear 3

(The Clear command deletes narrations or timings, so be careful
when you use it. Clear is grayed out unless you have previously
recorded some slides.)

In the Record Slide Show box, check or clear the boxes for your
recording, and click Start Recording.

4 >

Select what you want to record before you begin recording.
5lide and animation timings
Marrations, ink, and laser pointer

Start Recording Cancel

More about these options:

v Slide and animation timings: PowerPoint automatically
records the time you spend on each slide, including
any animation steps that occur, and the use of any triggers
on each slide.

v" Narrations, ink, and laser pointer: Record your voice as
you run through your presentation. If you use the pen,
highlighter, eraser, or laser pointer, PowerPoint records
those for playback as well.

Important: Pen, highlighter, and eraser recording are available
only if you have the February 16, 2015 update for PowerPoint
2013 or a later version of PowerPoint installed. In earlier versions
of PowerPoint, pen and highlighter strokes are saved as ink
annotation shapes.

At the top left corner of the window is the Recording toolbar,
which you can use to:

x
= 1 00003 © 0:00:00

v Go to the next slide: 2!
v Pause the recording:@

v Re-record the current slide:
If you re-record your narration (including audio, ink, and laser
pointer), PowerPoint erases your previously recorded narration
(including audio, ink, and laser pointer) when you start recording
again on the same slide.
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You can also re-record by going to Slide Show > Record Slide
Show.
4. To use ink, eraser, or the laser pointer in your recording, right-click
the slide, click Pointer options, and pick your tool:

v’ Laser Pointer

v" Pen

v Highlighter

v’ Eraser (This option is grayed out unless you have

previously added ink to some slides.)

To change the color of the ink, click Ink Color.

Next

Previous

Last Viewed

See All Slides

Zoom In

Custom Show »

Show Presenter View

Screen »

~ Pointer Options > JA,/ Laser Pointer

Help 24 Pen

Pause Recording & Highlighter

End Show Ink Color »
& Eraser
rj Erase All Ink on Slide

Arrow Options 4

5. To end your recording, right-click the final slide, and click End
Show.

Mext

Previous

See All Slides

Foom In

Screen 3
Painter Options k
Help

Pause Recording

End Show

Tip: When you finish recording your narration, a sound icon
appears in the lower-right corner of each slide that has narration.
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The recorded slide show timings are automatically saved. Timings
are shown in Slide Sorter view just beneath each slide.

ke

In this process, what you record is embedded in each slide, and the
recording can be played back in Slide Show. A video file is not
created by this recording process. However, if you want a video

= < » 00:00.00 LE s

IMMENTS = — - mo g -—eag— 125% E3
Set the slide timings manually
PowerPoint automatically records your slide timings when you add
narrations, or you can manually set the slide timings to accompany
your narrations.
v"In Normal view, click the slide that you want to set the
timing for.
v/ On the Transitions tab, in the Timing group,
under Advance Slide, select the After check box, and then
enter the number of seconds indicating how long the slide
should appear on the screen. Repeat the process for each
slide that you want to set the timing for.
Tip: If you want the next slide to appear either when you click
the mouse or automatically after the number of seconds that you
enter—whichever comes first—select both the On Mouse
Click and the After check boxes.
Delete timings or narration
The Clear command is for deleting timings or narration from your
recording that you don't want or that you want to replace. There are
four different Clear commands that allow you to:
v" Delete the timings on the currently selected slide
v’ Delete the timings on all slides at once
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v' Delete the narration on the currently selected slide
v" Delete the narration on all slides at once

1. If you do not want to delete all the timings or narration in your
presentation, open a specific slide that has a timing or narration
that you do want to delete.

2. On the Slide Show tab of the PowerPoint ribbon, on the Record

Slide Show button, click the down arrow, point to Clear, and then

choose the appropriate Clear command for your situation.

Turn off timings or turn off narrations, ink, and laser pointer

After you've recorded your PowerPoint presentation, any timings,

gestures, and audio you performed are saved on the individual

slides. But you can turn them all off if you want to view the slide
show without them:

v" To turn off recorded slide timings: On the Slide
Show tab, clear the Use Timings box.

v To turn off recorded narrations, ink, and the laser
pointer: On the Slide Show tab, clear the Play
Narrations box.

Recording tips v Recordings are added to the presentation on a per-slide
basis, so if you want to change a recording, you only have
to re-record the affected slide or slides. Also, you can
rearrange the order of slides after recording without having
to re-record anything. This also means it's easy to pause for
a break while recording a presentation.

v PowerPoint doesn't record audio or video during transitions
between slides, so don't speak while advancing the slide.
Also, include a brief buffer of silence at the beginning and
the end of each slide to make the transitions smooth and
ensure that you don't cut off audible narration while
transitioning from one slide to the next.

v You can't record narration in PowerPoint for the web. Use
a desktop version of PowerPoint to record your narration.

v" You can adjust and edit the size of video and ink in edit
view.

v If it's possible that your audience may use PowerPoint for
the web to experience the recording, use the transitions that
are supported by PowerPoint for the web (Cut, Fade, Push,
Wipe, Split, Random Bars, Shape, Morph).

v Presentation recording works best with touch-screen PCs
that have a web camera.

v Use video preview to make sure everything is set up
correctly before recording.

v For slides that you want to record gestures (such as ink) on,
make multiple copies of the slide so that you can easily
record multiple takes. Then delete the extraneous slides
when you're done.

v" Record a few seconds of silence by turning off audio and
video to advance after a set time.

I ——
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v' For higher quality, use an external web cam and/or
microphone.

Built-in cameras and microphones are suitable for most tasks. But
if you want more professional-looking video, consider using an
external web cam, if you're able. If you're using PowerPoint on a
tablet or laptop and you're inking with a stylus, an external camera
and microphone allows you to minimize stylus noise.
e Assoon as you finish your first slide recording, play it back.
Before you get too far down the road of recording your
presentation, make sure your audio and video sound and look the
way you expect.

Tips for creating an Consider the following tips to maintain a clear message and to keep
effective your audience attentive and interested.
presentation ~ Minimize the number of slides - keep the number of slides

in your presentation to a minimum.

=~ Choose an audience-friendly font size - font size smaller
than 30 might be too difficult for the audience to see from
distance.

~ Keep your slide text simple - use bullets or short sentences,
and try to keep each item to one line. Some projectors crop
slides at the edges, so that long sentences might be cropped.

=~ Use visuals to help express your message — pictures, charts,
graphs, and SmartArt graphics provide visual cues for your
audience to remember. As with text, however, avoid
including too many visual aids on your slide.

=~ Make labels for charts and graphs understandable — use
only enough text to make label elements in a chart or
graph comprehensible.

~ Check the spelling and grammar — to earn and maintain the
respect of your audience, always check the spelling and
grammar in your presentation.

Unit 11 - Websites and MOOCs for English

Language teaching

Objectives At the end of this unit, you will be able to:
Identify websites for English Language Teaching/Learning
Identify MOOCs for English Language Professionals

Use websites for the different lessons you teach
Attend MOOCs for English Language Professionals
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Introduction
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Thousands of materials and free educational software can be found on
the internet for the purpose of English language teaching and learning.
In this section we selected various websites and links that are relevant
resources for the teaching and learning of English. As this is a self-
study section, therefore, you are expected to search and be acquainted
with the websites through evaluating them for your further
implementation. Teachers evaluate all kinds of materials that they use
for teaching and learning. Some criteria and questions teachers might
ask themselves when evaluating educational software, applications and
resources are listed below.
Agelyear level:
» Is the application appropriate for the age and year level of the
students?
« Isthe reading level of the text and type of media appropriate?
Curriculum links:
» Are there links between the content/functions of the
application and the expectations of the curriculum?
« Are the content and examples relevant to the curriculum?
»  Will this help teach the curriculum in new or different ways?
Instructional content:
» Is the information accurate, complete and current?
« Are sources reliable?
» Does the content encourage higher-order thinking?
 Is the content culturally appropriate?
Engaging and interactive:
«  Will the learner(s) be actively involved in using the tool?
« Is feedback provided? Is the feedback appropriate and
meaningful?
Assessment:
» Are assessment tasks included, or can the teacher develop
relevant assessment tasks that link to the use of the tool?

Flexibility:
« Can all aspects of the tool be integrated easily into classroom
activities?

« Can the tool be used for multiple curriculum units?
Media:
» Does the medium used support or distract from the learning
activity?
Usability:
» Is the tool easy to use and intuitive?
Technical considerations:
» Does the tool work consistently?
» Are there special technical requirements for using the tool?
Does the school have access to those requirements?
Support materials:
» Does the tool have multiple forms of help (manuals, context-
sensitive help, and tutorials)?
« Are teaching support materials or online resources available
to help a teacher embed the tool into lessons?
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Getting Ready

What is the following picture?
S0 LeamEnglish

and what was its content?

What benefits will websites have to language
teaching? Share your ideas in groups.

Websites for ELT This is one of the Websites with more relevant teaching
Writing process materials to supplement the teaching English Course.
Website ‘Writing Process Website’ has many sub categories, which

have relevant contents to Sophomore English Course. It has
ample information to fully support the teaching and learning
of writing English. It is possible to access this Website
through
http://www.kent.k12.wa.us/curriculum/writing/elem_writin
a/bib/writingprocess.htm. Accessing to this Website enables
both instructors and students to manipulate all the
subcategories given below (1 - 15). All of these have
relevant information and contents to the contents of
Sophomore English Course.

ABC's of the Writing Process
(http://www.angelfire.com/wi/writingprocess/). This
Website site provides resources that help in writing. It
incorporates important information that could strengthen
our writings on sentence, paragraph, essay and letters.

= Steps of Writing a Basic Essay
(http://www.essaypunch.com/) This one also helps as a
teaching and learning aid for both instructors and students
in developing short essays consisting of an introduction, a
two or three-paragraph body, and a conclusion.

= ESL teachers! http://www.kyoto-
su.ac.jp/information/tesl-ej/ej08/a2.html. This Website
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gives teachers additional information on teaching English
as a Second Language mainly in teaching writing.

= Learning Transitions
(/nttp://www.unc.edu/depts/wecweb/handouts/transitions.h
tml/) In this Website both instructors and students could
get adequate information in teaching and learning
Sophomore English.

= Writing Effective Conclusions: - This Website could be
accessed through
(http://www.kcmetro.cc.mo.us/maplewoods/writeplace/co
nclusions.html). This Website could supplement how to
write an effective conclusion. This is very important part
especially in writing persuasive essays since the
conclusion is the last chance that writer has to convince
the reader.

v' Learning to Write Hooks: - This is another important
Website that is accessed via

v (http://www.kcmetro.cc.mo.us/maplewoods/writeplace/writ
ingintros.html). In this Website students could get ample
information and model examples of introductory paragraph.

v" On-Line Writer's Workshop
(http://www3.sk.sympatico.ca/fiss/newpagel.htm). This
Website is an online workshop for classroom instructors
that are interested in implementing the writing process in
their classes. They can participate in various workshops in
their virtual office and communicate with other scholars of
the same discipline.

v Writing Terrific Paragraphs
(http://www?2.pvc.maricopa.edu/tutor/eng/engessbody.htm):
This Website has different sample paragraphs especially in
wiring terrific paragraphs.

v Writing a Basic Paragraph
(http://www.paragraphpunch.com). This Website takes
users through the actual steps of writing basic paragraphs.
Users develop an idea and write their own topic sentence,
body, and a conclusion. The Website provides questions
that help to guide users step by step through pre-writing,
writing, organizing, editing, rewriting, and publishing.

v Five Paragraph Essay
(http://www.geocities.com/SoHo/Atrium/1437/structure.ht
ml).

v In this Website both teachers and students get adequate
information in writing five paragraph essay: an
introductory paragraph, three body paragraphs and a
conclusion.

v' Learn to evaluate and edit
(http://www.geocities.com/SoHo/Atrium/1437/eval.html).
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v"Instructors and students could get ample information on the
importance of editing.

v Writer’s Corner : - It is possible students and instructors to
access this Website through
(http://ccweb.norshore.wednet.edu/writingcorner/writingpr
ocess.html). It is a Website that gives supplementary about
written communication.

v’ Teacher's Ideas
(http://www.urich.edu/~writing/wweb.html). This is a
Website where instructors get ideas for their classroom.

v Outline of the Basic Writing Process
(http://www.csuohio.edu/writingcenter/writproc.html).
Here, both instructors and students could get some exciting
ideas like the necessary steps that any writer should follow.

v Writing Examples and Fabulous Ideas: This Website is
accessed through

V' http://freedom.up.net/~msbones/ww01000.htm. It is full of
examples written by students from different parts of the
world.

Teacher Websites The second important Website for teaching Sophomore English is
the Teacher Websites
(http://thwt.org/englishteachersites.htm). Under this major
Website there are various links which could help instructors and
students to supplement Sophomore English in particular and other
English Courses in general.
v Ted Nellen's Cyber English Homepage: - This
Website is rich in information about teaching
English with technology; it indicates that language
teaching could be effective if it is assisted by
technology.
v Cyber English 9: - This Website helps students to
use the different trends of writing.
v" Cyber Comp 10: This is an important Website to
supplement Sophomore Composition class.
Sophomore English This is the third major Website identified as one of the Websites
Website that could supplement
Sophomore English teaching and learning. Its path is
http://158.91.55.1/~jeanar/Rock_files/. It has sub-categories that
could enhance reading, writing, speaking, listening and others.
These Websites could help students who take Sophomore English
Course to integrate the four language skills

http://158.91.55.1/~jeanar/Rock_files/writing.htm
http://158.91.55.1/~jeanar/Rock_files/speaking.htm
http://158.91.55.1/~jeanar/Rock_files/listening.htm
http://158.91.55.1/~jeanar/Rock_files/viewing.htm
I
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http://158.91.55.1/~jeanar/Rock_files/studentwrk.htm

http://158.91.55.1/~jeanar/Rock_files/othersites.htm
4.1. Sentence master Website
This is the fourth identified major Website. It helps to supplement
the teaching and learning of Sophomore English basically in
sentence writing practices. This Website could be accessed through
http://www.sentencemaster.ca/rules.html.
4.2. Den tips paragraph Website
The fifth major Website is Den tips Paragraph Website accessed
through
http://www?2.actden.com/Writ_Den/tips/paragrap/. It is used to
practice writing a paragraph. In this Website instructors and
students could get adequate supplements about parts of a paragraph
(topic sentence, supporting details and closing sentence), how to
write a paragraph (prewriting paragraphs, writing paragraphs,
editing and publishing paragraphs) and kinds of paragraphs
(definition, classification, description, compare and contrast,
sequence, choice, explanation and evaluation).
4.3. Other Websites
Although the above websites are identified as major ones to
supplement Sophomore English Course, they are not the only ones.
These are those with contents that match with the contents of
Sophomore English Course. Since the Internet is very vast, the
researcher believes that there are more important Websites that
could supplement Sophomore English. An attempt has done to
grouping the identified Websites according to the specific topic
they supplement. Thirty-two Websites have identified and
classified under three headings: sentence, paragraph and essay
Websites.
4.4. Sentence writing

v’ http://www.arts.uottawa.ca/writcent/hypergrammar/bldsent.

html

v http://www.eslgold.com/grammar/building_sentences.html

v’ http://grammar.about.com/od/sentencecombining/a/SBadja
dvex.htm
http://leo.stcloudstate.edu/punct/sentpatt.html
http://www.aueb.gr/lessons/english/int_engl/int_engl writ
ing.html
http://www.learnenglish.de/grammar/sentencetext.htm
http://www.storyit.com/magnets/wmagnets.htm
http://grammar.about.com/od/sentencecombining/a/SBprep

phrases.htm
v" http://grammar.about.com/od/sentencecombining/a/SBprep

phrases.htm
v' http://209.85.129.104/search?g=cache:b _XXMz9ThzsJ:ww
w.ngflcymru.org.uk/vtc/ngfl/english/118/Building%2520se
ntences/Building%2520sentences.ppt+Sentences+building
&hl=en&ct=clnk&cd=10&ql=et
I
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Check these websites
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4.5. Paragraph building

v

v

AN

v http://www2.actden.com/Writ_Den/tips/paragrap/
http://www.victoria.ac.nz/llc/academic-writing/pbuild-
reading.html

http://www.victoria.ac.nz/llc/academic-
writing/pbuild1.html
http://www.unc.edu/depts/wcweb/handouts/paragraphs.htm
|
http://www.bbc.co.uk/sKillswise/words/writing/paragraphs/
game.shtml
http://secondlanguagewriting.com/explorations
http://www.textcontrol.com/blog/permalink/2005060601/
http://contentwise.typepad.com/content_wise/2007/11/build

ing-a-bett.html
http://www.leeds.ac.uk/arts/studyskills/writtenassignments/

age 11.htm

4.6. Essay writing

v

AN

AN

http://www.leeds.ac.uk/arts/studyskills/writtenassignments/
page_11.htm

http://elearn.mtsac.edu/pmarcy/vesliwc/
http://www.esc.edu/htmlpages/writerold/menub.htm
http://education.wichita.edu/caduceus/examples/essay stud
ent/index.htm

http://www.gsc.edu/ACT T/fsherwood/RegentsTest/essay b
uilding.htm
http://members.tripod.com/~Iklivingston/essay/
http://essayinfo.com/
http://hedc.otago.ac.nz/hedc/sld/Study-Guides-and-
Resources/Essay-Writing.html
http://www.jcu.edu.au/studying/services/studyskills/essay/
http://www.monash.edu.au/lls/llonline/writing/general/essa

y/index.xml
http://www.english.bham.ac.uk/staff/tom/teaching/howto/es

say.htm

Here are lists of annotated websites. Go online, check if they work
and identify the skills you learn/teach with.
1. www.nonstopenglish.com: This site offers free English as a

Second language (ESL) and English as Foreign Language
(EFL) activities. There are many English grammar and

vocabulary tests. If one registers, they can receive free email
exercises and they can see which exercises they have done and

how well.

2. www.englishclub.com: Inits Learn English part, it includes

lessons, games, videos and other resources that help learners

speak English.
_____________________________________________________________________________________________________________|
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http://www2.actden.com/Writ_Den/tips/paragrap/
http://www.victoria.ac.nz/llc/academic-writing/pbuild-reading.html
http://www.victoria.ac.nz/llc/academic-writing/pbuild-reading.html
http://www.victoria.ac.nz/llc/academic-writing/pbuild1.html
http://www.victoria.ac.nz/llc/academic-writing/pbuild1.html
http://www.unc.edu/depts/wcweb/handouts/paragraphs.html
http://www.unc.edu/depts/wcweb/handouts/paragraphs.html
http://www.bbc.co.uk/skillswise/words/writing/paragraphs/game.shtml
http://www.bbc.co.uk/skillswise/words/writing/paragraphs/game.shtml
http://secondlanguagewriting.com/explorations
http://www.textcontrol.com/blog/permalink/2005060601/
http://contentwise.typepad.com/content_wise/2007/11/building-a-bett.html
http://contentwise.typepad.com/content_wise/2007/11/building-a-bett.html
http://www.leeds.ac.uk/arts/studyskills/writtenassignments/page_11.htm
http://www.leeds.ac.uk/arts/studyskills/writtenassignments/page_11.htm
http://www.leeds.ac.uk/arts/studyskills/writtenassignments/page_11.htm
http://www.leeds.ac.uk/arts/studyskills/writtenassignments/page_11.htm
http://elearn.mtsac.edu/pmarcy/vesl1wc/
http://www.esc.edu/htmlpages/writerold/menub.htm
http://education.wichita.edu/caduceus/examples/essay_student/index.htm
http://education.wichita.edu/caduceus/examples/essay_student/index.htm
http://www.gsc.edu/ACTT/fsherwood/RegentsTest/essay_building.htm
http://www.gsc.edu/ACTT/fsherwood/RegentsTest/essay_building.htm
http://members.tripod.com/~lklivingston/essay/
http://essayinfo.com/
http://hedc.otago.ac.nz/hedc/sld/Study-Guides-and-Resources/Essay-Writing.html
http://hedc.otago.ac.nz/hedc/sld/Study-Guides-and-Resources/Essay-Writing.html
http://www.jcu.edu.au/studying/services/studyskills/essay/
http://www.monash.edu.au/lls/llonline/writing/general/essay/index.xml
http://www.monash.edu.au/lls/llonline/writing/general/essay/index.xml
http://www.english.bham.ac.uk/staff/tom/teaching/howto/essay.htm
http://www.english.bham.ac.uk/staff/tom/teaching/howto/essay.htm
http://www.nonstopenglish.com/
http://www.englishclub.com/index.htm
http://www.englishclub.com/learn-english.htm

EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

10.

11.

12.

www.english-zone.com: This site provides different zones for
learning English. These zones include: grammar zone, reading
zone, verb zone, basic skills zone, writing zone, idiom zone,
spelling zone, pronunciation zone, study skills zone,
vocabulary zone, conversation zone, fun stuff zone and teacher
Zone.

wWww.rong-chang.com: This site contains resources, exercises
and quizzes on listening, speaking, reading, writing, grammar
and vocabulary.

www.english-at-home.com: This site includes resources and
exercises on Speaking English, English Grammar, Vocabulary
& ldioms, English Reading, Real Life English and Games &
Quizzes.

www.expertenglish.com: This site provides links to Free
Learn English Online, Grammar Exercises, English Listening,
Free ESL, ESL English Grammar, English Language Study,
Play Online Games, Free Fun Games to Play, Make a Free
Online Game and Free online Games.
www.world-english.org: There are a great deal of resources
in this site. It holds resources, tests, quizzes and exercises on
reading, writing, speaking, listening, vocabulary and
grammar.

www.learn-english-today.com: This site include Grammar
lessons, Grammar exercises, Business English, Idioms : A-Z
lists, Idioms : by theme, Proverbs, Vocabulary, New English
words, Phrasal verbs, Word games, Fun activities, Famous
quotations, Newspapers - radio, Study resources and Teaching
resources.

www.learnenglish.britishcouncil.org: This web provides
free resources for learning vocabulary, grammar, and
listening. Exercises with feedback integrated are available on
the site. It also includes exercises and resources on IELTS.
www.englishlearner.com: EnglishLearner.com helps you
learn English online with exercises on grammar, reading
comprehension, vocabulary and listening at beginner,
intermediate and advanced levels.

www.Livemocha.com: Livemocha is an online social
language learning site. Visitors who want to learn English can
take free self-study lessons and partner with other people
around the world who already speak English or are trying to
learn the language themselves. Livemocha also offers video
and audio downloads, extra help from knowledgeable tutors,
and useful tips from native English speakers.
www.1-Language.com: Students who are trying to learn
English as a second language will benefit from the free audio
tutorial found at 1-Language.com. The tutorial includes 40
audio lessons that focus on practical conversations and the
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http://www.english-zone.com/
http://english-zone.com/index.php?ID=1
http://english-zone.com/index.php?ID=6
http://english-zone.com/index.php?ID=6
http://english-zone.com/index.php?ID=2
http://english-zone.com/index.php?ID=4
http://english-zone.com/index.php?ID=13
http://english-zone.com/index.php?ID=3
http://english-zone.com/index.php?ID=7
http://english-zone.com/index.php?ID=17
http://english-zone.com/index.php?ID=9
http://english-zone.com/index.php?ID=5
http://english-zone.com/index.php?ID=94
http://english-zone.com/index.php?ID=15
http://english-zone.com/index.php?ID=8
http://english-zone.com/index.php?ID=8
http://www.rong-chang.com/
http://www.english-at-home.com/
http://www.english-at-home.com/speaking/
http://www.english-at-home.com/grammar/
http://www.english-at-home.com/vocabulary/
http://www.english-at-home.com/vocabulary/
http://www.english-at-home.com/reading/
http://www.english-at-home.com/business/
http://www.english-at-home.com/lessons/
http://www.english-at-home.com/games/
http://www.english-at-home.com/games/
http://www.expertenglish.com/
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Free%20Learn%20English%20Online&token=AG06ipD5BmcAviUU46tWw5scq7atTM4vPQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgADgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQEm2mAykQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Free%20Learn%20English%20Online&token=AG06ipD5BmcAviUU46tWw5scq7atTM4vPQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgADgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQEm2mAykQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Grammar%20Exercises&token=AG06ipAYMxpGUUXsaXPwAxmPM_64mh1VHQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgATgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQELipFFkQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=English%20Listening&token=AG06ipDu-uA6M9B9s7OEGrRApEkbNvd_qwoTCKWRyrjT57UCFQG13godBn8AnhACGAEgAjgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQHwLGNZkQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Free%20ESL&token=AG06ipD9yUNgAVluGHXf7AQd7fff-ichIQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgAzgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQEbO9qikQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=ESL%20English%20Grammar&token=AG06ipCT8Aw_RR9KlgLhSa8x2QtULnVKNwoTCKWRyrjT57UCFQG13godBn8AnhACGAEgBDgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQHj7e5ckQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=English%20Language%20Study&token=AG06ipD0TL-J5F_YMRTYJsnnB7CHbnnJOQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgBTgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQHHjzulkQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Play%20Online%20Games&token=AG06ipBPfhztQJ6a4qVPq2DazqEax8ykkwoTCKWRyrjT57UCFQG13godBn8AnhACGAEgBjgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQHWj1KmkQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Free%20Fun%20Games%20to%20Play&token=AG06ipAIOxm5Iak8nuYplKWzmuBhmRGjBQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgBzgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQFb3k0NkQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Make%20a%20Free%20Online%20Game&token=AG06ipC1UyQY75NB6a7i_JxMbM6i0YonTQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgCDgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQH9-vDwkQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Make%20a%20Free%20Online%20Game&token=AG06ipC1UyQY75NB6a7i_JxMbM6i0YonTQoTCKWRyrjT57UCFQG13godBn8AnhACGAEgCDgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQH9-vDwkQEDOgxa503zmA
http://www.expertenglish.com/search.php?uid=www5136fae872a0c9.97844286&src=null&term=Freeonline%20Games&token=AG06ipCQKKw9SxohPRcQFm3o-xM3gxA3fgoTCKWRyrjT57UCFQG13godBn8AnhACGAEgCTgwQNuchq-Ur_WS7QFQ4tXTAVD9ubAIUNPvsw5Q7fDiDlCX_ZgPUPL-mA9Q1P-YD1Cvra8PUNS2ww9Q6-TOD1C67c4PUMu63A9Q87rcD1D9yewPUJGr9g9QlIH3D1Du5K4QUOT95xBQg7q1EVCNu7URUKG7tRFQo7u1EVDg5eQRUMS85RFQy-TnEVCZlecSUIzymRNQwPynE1Ch7f8TUIjrtxVQjeu3FVC_5ekVUKT9uxZQmuuEG1DT64QbULL02x5Qz77cHlCHgv0gUNmcrSlQtbGtKVD3-sgsUPKBplFQ7P-SjwFQ-7uUlQFQ497KowFQ0o3dvAFQupnzwAFQjpmaxgJQyITYnQNQo5Xl0gZxggFKd2NcJ46CARMI5d_QuNPntQIVRdTeCh3KfQBtjQE2w1Z3kQEDOgxa503zmA
http://www.world-english.org/
http://www.learn-english-today.com/
http://www.learn-english-today.com/idioms/idioms_alphalistsA-Z.htm
http://www.learn-english-today.com/idioms/idioms_alphalistsA-Z.htm
http://www.learn-english-today.com/idioms/idioms_proverbs.html
http://www.learn-english-today.com/proverbs/proverbs.html
http://www.learn-english-today.com/vocabulary/AA-vocabulary-contents.html
http://www.learn-english-today.com/new-words/new-words-in-english1.html
http://www.learn-english-today.com/new-words/new-words-in-english1.html
http://www.learn-english-today.com/phrasal-verbs/phrasal-verb-list.htm
http://www.learn-english-today.com/wordgames.html
http://www.learn-english-today.com/fun/fun_activities.html
http://www.learn-english-today.com/quotes/quotations1.html
http://www.learn-english-today.com/quotes/quotations1.html
http://www.learn-english-today.com/news/news.html
http://www.learn-english-today.com/resources.html
http://www.learn-english-today.com/resources-for-teachers.html
http://www.learn-english-today.com/resources-for-teachers.html
http://www.learnenglish.britishcouncil.org/
http://www.englishlearner.com/
http://www.englishlearner.com/beginner/index.shtml
http://www.englishlearner.com/intermediate/index.shtml
http://www.englishlearner.com/advanced/index.shtml
http://www.livemocha.com/
http://www/
http://www.1-language.com/

EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

Getting Ready

Introduction
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type of academic language students can expect to encounter at
U.S. universities.

13. www.bbc.co.uk: The site offers free audio and video courses
that can be taken online as well as newsletters, language tips,
and other study materials.

14. www.usingenglish.com: This site provides a large collection
of free language learning resources for students who are trying
to learn English as a second language. The resources include a
language reference guide, an English glossary, ESL tests and
quizzes, worksheets, English usage articles, and an ESL
discussion forum.

15. www.about.com: The About.com Guide to English as a
Second Language offers a free eight-lesson course to help
students learn English as a second language. The course is
delivered via email and includes links to additional learning
resources as well as a community forum for students to discuss
what they have learned.

MOOC:s for Learning and Teaching English

1. Have you ever heard of MOOCs? What do you think they are?

2. Look at the words in the following picture? What do you think
they tell you about MOOCs?
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MOOC stands tor-lassive Open-ormmecuerse. Itisacourse given
on the internet, usually at college level, that is open to anyone to
enroll. In most cases, real university professors teach the courses
and they are usually free. In short, they are free online courses that
you can attend and get a certificate for. Some of benefits to taking
an open online course are:

v Itis free.

v Itisonline, so you can learn from anywhere.
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Some MOOCs for
ELT

How can we get
there?

v' Many times, you can earn a certificate that shows you
completed a course.

v Many times, the course is taught by real professors from
actual universities. You can even take a course from a
Harvard professor free!

v You can drop out anytime. Unlike with an actual university,
it does not matter if you suddenly do not have enough time
to finish your class. You can start and stop anytime and you
will not lose anything.

https://www.britishcouncil.me/en/english/mooc
https://americanenglish.state.gov/mooc-english-teaching-
professionals
v https://www.thinkinenglish.org/thinkinenglishblog/improve-
your-skills-with-9-absolutely-free-moocs-for-esl-and-efl-
teachers
v https://www.thinkinenglish.org/thinkinenglishblog/improve-
your-skills-with-9-absolutely-free-moocs-for-esl-and-efl-
teachers
v https://www.cambridgeenglish.org/learning-english/free-
resources/mooc/
v https://www.aeeteacher.org/MOOC
You got to a MOOC site e.g. https://www.mooc-
list.com/tags/teach-english
Register by clicking on the register tab or join now.

G Mooc: x | 33 EMAT X | B Egish x | @ Teacht X | @ Masivo X | § Sfveel x | @ 2We x | B MOOC x | @ MODC x | 83 Outre x | NewTh x| + - o x
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1E Apps 00 ebeaning develop. MewTab G wawpmprcom- G T Assigoment () smmamuedistus. @ YouTube Y Maps M Gral
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(I‘\l‘ooc LIST HOME  FIND MOOCS BY ~  FAQS LOGIN / REGISTER Q SEARCH

[—T

list

E Teach English MOOCs and Free Online Courses Subscribe to our mailing
ox Email Address

Join our course and explore some key concepts in the effective teaching and

learning of languages

v' Complete the registration form as below

Create new account Login Request new password

Username *

Spaces are allowed; punctuation is net allowed except for periods, hyphens, apostrophes, and underscores.

E-mail address *

A valid e-mail address. All e-mails from the system will be sent to this address. The e-mail address is not made public and will anly be used if you wish to receive a new
passwaord or wish ta receive certain news or notifications by e-mail.

‘Confirm e-mail address *

Please re-typs your e-mail address to confirm it is accurate.

~Locale settings

Time zone

| Europe/Moscow: Thursday, December 19, 2019 - 10:47 +0300 A

Select the desired local time and time zone. Dates and times throughout this site will be displayed using this time zone.

CAPTCHA
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British Council
MOOCs

A List of Courses at
https://www.britishco
uncil.me/en/english/m
00C
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English for the Workplace

This free course is perfect for people who are learning English and
who are interested in developing English language skills to help
them secure a better job. Join the course between 13 March and 10
April 2017.

English in Early Childhood

This free online course will help you explore the best way on how
young children learn English as an additional language while they’re
still learning their mother tongue.

Exploring English: Language and Culture

Increase your confidence in English and improve your language
skills with the free online course while exploring more about British
culture at the same time.

Exploring English: Shakespeare
Improve your English language skills by looking at the life and
works of William Shakespeare and his enduring popularity.

How to succeed in the Global Workplace

Beginning your career or starting a new job brings to mind lots of
questions, so we’ve designed a course to guide you through those
initial weeks and months. Join our free online course to prepare for
your first job or the early stages of the career.

Ideas for a better world
Learn about policymaking and leadership from experts and
inspirational leaders, and create your own policy action plan.

Language Assessment in the Classroom

Assessment is becoming increasingly important in language
education. That's why we've designed this online course to help you
understand it better.

Study UK: Preparing for Work
This online course will help you identify and build the employability
skills needed for the modern workplace.

Teaching English: How to plan a great lesson
Develop your English language teaching skills and learn how to plan
and deliver effective English lessons with this online course.

Understanding IELTS

Our four Understanding IELTS courses will give you a complete
guide to everything you need to know as you prepare for the IELTS
test.
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Understanding language: learning and teaching

Developed by the University of Southampton and the British
Council, last year this course was take by 120.00 people from all
over the world.

Unit IV Mobile devices for accessing ICT tool

supported lessons

At the end of this unit, you will be able to:
e |dentify parts of mobile devices
e |dentify mobile apps
e Use mobile phones for teaching English Language

A mobile device (or handheld computer) is a computing device
small enough to hold and operate in the hand. Typically, any
handheld computer device have an LCD or OLED flat screen
interface, providing a touchscreen interface with digital buttons and
keyboard or physical buttons along with a physical keyboard. New
data storage, processing and display technologies have allowed
these small devices to do nearly anything that had previously been
traditionally done with larger personal computers. Many such
devices can connect to the Internet and interconnect with other
devices such as car entertainment systems or headsets via Wi-
Fi, Bluetooth, cellular networks or near field
communication (NFC). Integrated cameras, digital media players,
the ability to place and receive telephone calls, video games,
and Global Positioning System (GPS) capabilities are common.
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Getting Ready

What are mobile devices?
What can you use mobile devices for?
Where can you use mobile devices?
How can they be used for language teaching and
> learning?

What do you understand from the following picture?

51 Y R

)

Characteristics of Mobile devices have similar characteristics. Among them are: -
Mobile Devices Wi-Fi or cellular access to the internet
A battery that powers the device for several hours
A physical or onscreen keyboard for entering information
Size and weight that allows it to be carried in one hand and
manipulated with the other hand
Touch-screen interface in almost all cases
A virtual assistant, like Siri, Cortana or Google Assistant
The ability to download data from the internet, including
apps and books
v Wireless operation
Mobile Devices and Times are changing now, and the focus has shifted mainly towards
Their Uses a mobile device populated world. Some of the most common mobile
devices we use today include:
= Smartphones — are handheld, can fit in a pocket, have a
million and one uses, and help keep us connected at all times
thanks to a constant network connection from a wireless
carrier. There are many different device choices, so it should
be easy to find a one that meets all of you needs.
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Smartphones are advanced versions of traditional cell
phones in that they have the same features as cell phones —
such as the ability to make and receive phone calls, text
messages and voicemail — but they can also be used to
browse the internet, send and receive email, participate in
social media and shop online. They also can download apps
from the internet using a cellular or Wi-Fi connection to
expand the smartphone capabilities in a vast number of
ways.

Tablets — similarly to smartphones, tablets share many of
the same benefits but in a larger form factor. Tablets are
portable, like laptops, but they provide a different
experience. Instead of running a traditional laptop and
desktop computer applications, they run apps designed
specifically for tablets. The experience is similar, but not the
same as using a laptop computer. Tablets come in all sizes,
from slightly larger than a smartphone to the size of a small
laptop. Some examples include work presentations, heavy
gaming, or even live streaming of shows in high definition
on Netflix.

Laptop Computers — devices have always been popular
because they give us the functionality of a desktop computer
that we can take anywhere. We can use the same operating
system with the same programs, which means there is no
device learning curve. Having a full-sized keyboard, the
same input/output ports and the ability to connect an external
display are some added benefits as well.
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Smartwatches — devices are relatively new and play in
somewhat of a niche market at this point in time. The main
benefits a smartwatch can provide us the ability to get
notifications and necessary information on our wrist without
having to pick up another device. With some of the new
standalone models, we can even take and receive phone calls
just like our smartphones can.
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E-readers — its primary purpose is for reading. The Amazon
Kindle and Barnes & Noble Nook have made the e-reader a
popular choice for people who enjoy reading books in a
digital format. These devices changed the whole concept of
reading and helped to bring books into a new era.

Handheld Gaming Consoles — or simply handheld console,
is a small, portable self-contained video game console with
a built-in screen, game controls, and speakers. Handheld
game consoles are smaller thanhome video game
consoles and contain the console, screen, speakers, and
controls in one unit, allowing people to carry them and play
them at any time or place.
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Basic Mobile phone
navigation . - . .
This activity might help you to navigate:

= Home and volume buttons

= Menu Button

= Power Button

= Back Button

= Swipe

= Voice Commands

This is an activity that would be beneficial at the beginning of term.
It could also form an entire lesson, or go on to form part of a series
of activities in lessons as ‘bite-sized’ ten minutes ‘tech tip of the
day’ slots. NB: This activity might equally well form part of a
professional development program for teachers. Colleagues might
also like to work together informally to further their own
understanding of their own smartphones or tablets. It should be
noted that this activity might be elementary but it is important for
the next activities.

» Individually or in group, explore and practice the navigation
buttons as shown in the figure bellow. Note that the buttons
might be different on your phone but the functions are the
same.

Press & holdto switch
the power button on/foff

Press+/-signto :

increase or reduc o

the volume

Touch/pressthis
button
Displayed Applications to return back
On Main windows
- Press themiddle buttonto
Press this button to returnto swipethe locked screen
opened program/applicaﬁons‘i. & skipthedisplayed
window

» Now, using your cell phone, go to the application menus and
navigate the “Voice recording” application. This practical
exploration of this application will help you for the next voce
recording practice.

Mobile phone This activity will help you to use:
applications and = Short Message Services (SMS),
their functions = GPS/location service,
= Camera to take video and photo,
= Browsing internet account to compose and receive
message,
= Downloading and uploading files,
= Bluetooth to send and receive files,

. _______________________________________________________________|
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= Wi-Fi to connect with internet,

= voice calls and

= gaming
This is an activity that would be beneficial at the beginning of term.
It could also form an entire lesson, or go on to form part of a series
of activities in lessons as ‘bite-sized’ ten minute ‘tech tip of the day’
slots. NB: This activity might equally well form part of a
professional development program for teachers. Colleagues might
also like to work together informally to further their own
understanding of their own smartphones or tablets.

1. switch their operating systems to English
» Go to the “settings” and click the “Language and

input” button and select/click your preference from the
list of option. After that you will see a change on your
phone keyboard.

2. log onto Wi-Fi
» Go to the “settings” and select/click the “Wi-Fi” icon.

This will lead you to the next window. Here, you can
press the button either to OFF/ON mode. If you put the
button on the ON mode, the mobile cell will search
internet connection if there is one in your area.

3. Switch on (and off) the silent mode and flight mode and
enable/disable location services can also be accessed as
stated on the above procedures. The simple way to get in it
is to swipe the top of the screen down with your finger. When
you do that you will see the screen as shown below. So

please do the activities as indicated below.

Bleerooth device Belpyor to
trazfer data from your phone Pur the ~mobile dara” icon

Th: Elocation icon. Prezsitto 10 other Prez: bt batron to is ON porition toget

=witck ON & OFF. 3“1“‘ ON& Oﬂ' Whes the coxzected, if pot pricin

The blze color indicate tharirez  3OR ZeC Blze ne resdy to OFF mode 10 zave your

ON & nhezdimmed itnin cozmereicate with orker moReY.

OFF peition device 22d Smmed 2ot -

4:02 pm. fat, 19 October ol o ﬁ
om Szt I October \

Tz a2 Wi-Fiscea /7
Prezz it to zwitch immmm—p Q *)) 0 *
ON 124 OFF ' /)

Wefi  Location  Sound Afo  Bluetooth ‘ \
rotate

0 Mode  Powst J Figt  Dorol
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]
= Put the Fhzhe Mode 1s ON
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Mobile Learning

Note: if the Wi-Fi service is available at your compound you should
put the Wi-Fi icon (icon) in ON mode to get free internet connection.
But if the Wi-Fi service is not available you need to make the mobile
data in ON position to get internet connection with fee. In either case
both the Wi-Fi and mobile data will help you to exchange date
through internet.

4. While the “location” icon is in the ON position, go to the
application menu and select/open the “Google maps” app
(alternatively, you can go to the “Settings” and select the
“Google” icons). When you open a Google maps app you
will see a list of service available. For example, In the
“Nearby” list you can find restaurants, coffee, bars, hotels
and more. If you are in Arbaminch, for instance, the feature
of “Nearby” (as the name indicates) will show/tell you the
nearby places such as bars, hotels. Note that this is only
possible if the places are recently registered in Google map.
In Google map, however, you can find locations and places
that you need by using/selecting features and/or typing the
name of the locations in the search bar.

Now, to increase your familiarity with the Google map app, practice
and explore its features repeatedly to see/get varieties of services.

Mobile Learning (M-learning) is education via the Internet or
network using personal mobile devices, such as tablets and
smartphones to obtain learning materials through mobile apps,
social interactions and online educational hubs. What makes mobile
learning different is that the content takes into account, the screen
size of mobile phones and other mobile devices.

It is flexible, allowing students access to education anywhere,
anytime. Students use mobile apps and tools to complete and upload
assignments to teachers, download course instruction and work in
online social groups to complete tasks. E.g., Duolingo is an app with
which students can learn other languages by completing small daily
tasks on their mobile phone.
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Application
Software

The word "app™ is an abbreviation for "application.” It's a piece of
software program that is designed to run through a web browser or
offline on your computer, and on a smartphone phone, tablet or other
electronic devices, including smart TVs and smartwatches. Apps
may or may not have a connection to the internet.

Types of Apps

There are three main types of apps: desktop, mobile, and web.

e Desktop apps are usually much fuller than mobile apps and
consist of all the features of a program, whereas the

e mobile equivalent is a simpler and easier-to-use version.

Most desktop and web apps are built to be used with
a mouse and keyboard along with a large display, but mobile
apps are intended to be accessed with a finger or stylus on a small
screen.

Mobile Apps

Mobile app allows us to do and accomplish various tasks. An
application can be inbuilt or downloadable. Example of inbuilt
applications are: window and android applications which are
primarily designed to communicate with hardware devices. As the
name indicates that Downloadable applications can easily accessible
from the internet to be downloaded and installed in our device to do
different activities. Examples of downloadable application are
Internet Explores, Viber, telegram, Trucaller etc. in your mobile
phone you can access varous apps from Play store and Gallaxy
Apps. Now let us tryout.

» Use your mobile phone and Go to the application menu.
When you do so the screen like this will pop out. Here you
may find two types of application store that are
compatible/suitable apps for your mobile phone operating
system: paly store and Galaxy apps.
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Where to Get
Mobile Apps

Google Play
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Almost every platform has a repository where its users can
download both free and paid apps. These are normally accessible
through the device itself or a website so that the app can be queued
up for download the next time the user is on the device.
For example, the Google Playstore and Amazon's Amazon
Appstore are two places where Android users can download mobile
apps. iPhones, iPod Touch devices, and iPads can get apps through
the App Store straight from their devices.
Google Play is the app store that Google runs, and it's also an
important piece of Android's security as it scans apps before and
after they're downloaded and monitors them for unusual activity. It
can be a bit overwhelming when you first open up Google Play, but
don't worry, we're here to help you get started!
Searching for apps on Google Play
If you do not find an interesting application from the lists within the
play store, you should search from the play store. If you already
know the name of the app you're looking for, or have a specific app
type in mind, you can search for it rather than browsing through app
categories. In such a way, you can find out any application that is
suitable to your phone from the play store.
Note: In order to get, download, and install applications from the
store, you need to put your mobile data or Wi-Fi in ON position to
get connected (i.e. internet connection is required).

1. Tap the Google Play icon on your home screen.

2. Tap the white search bar at the top of the screen.
EESTNPO&

ForYou Top Charts Categories Editors' C. garly

New + Updated Games MORE

o (7
7 =k NIl

s [t &

a 0 Dungeon i MiniGolf  Harry i Bub
@ HunterC..  King-M.. Potter: ... Wit

4.1+ 4.5+ 4.4+ 47+

2pniffae 964100

Previously installed apps
Give one a go

3. Enter the name of the app (or type of app) you're looking
for.

4. Tap the searchicon on your keyboard (should be in the
location of the Enter key).

MORE
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e Play's Top Charts to try and find a

Browse New apps in You can browse through Googl
Google Play new app you want to install.

1. Tap the Google Play icon on your home screen.
2. Tap Top Charts underneath the Home tab.
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H .7 3 pnigqori2 - dziw (0
Previously installed apps MORE onl rdaiw u 2
Give one a go 2. -

] =l
Swipe left and right between the charts for Top Free, Top Paid, Top
Grossing, Top New Free, Top New Paid, and Trending. You can
also browse through Google Play by category:

1.  Tap the Google Play icon on your home screen.

2.  Tap Categories underneath the Home/Games tabs.

3. Tap the category you'd like to browse.
Now, some app categories are just a series of Top Charts narrowed
to that category of app, but other categories have featured apps and
subcategories in addition to the Top Charts for that category.

=

Download free apps Tap on an app in the search results or categories.
2. Tap Read more and look through the app's description and
reviews to ensure the app seems right for you.

3. Tap Install button to allow the request.

. _______________________________________________________________|
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» As a result, the automatic downloading and installation
process will begin. When the installation is completed you
may see a message like “installation is completed or
Successfully installed”.

om 2©W® & B12:38

e

€ tasks
Fasilv manaae
o e e e
Task, Any Goal. Get
Any.do: To-do list, Calenda.. Things Done

) Any:do Google LLC
Get More Done & Save Time
© EDITORS' CHOICE

INSTALL
Tasks & Notes for MS Exc..
@ Ad| UnigTec Inc

The ultimate GTD tool
&) @
THOUSAND

Google Tasks: Any Task,A. i Downloads  3,997=  Productivity  Similar
Google LLC

34+

‘€ Everyone

Simply create any task or subtask

Tasks: Astrid To-Do List Cl.. Integrated with mail for easy
AlexBakes collaboration.
4.4+

READ MORE

The app will now download and install itself, usually in a few
seconds depending on how large or small the app is. If you're on a
device running an older version of Android, you'll have to agree to
an app's permissions before it downloads. Read the permissions
before clicking Agree. Once the app is finished installing, an Open
button will appear in the same place the Install button previously
occupied.
Update apps Apps need updates from time to time, and if you need to manually
update your apps, steps are:-
1. Swipe in from the left edge of the screen OR tap the three-
line menu icon in the top white bar to open the menu.
2. Tap My apps & games.
3. App needing updates will appear at the top of the list. To
update a single app, tap the Update box next to the app.
4. Tap Update All to update all the apps needing updates.

3 © W i h12:49

Google Play
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3 © W% N 12:49
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Hunter C... King - M... Potter: ... Witc
a1s 45+ a4e 47
A Games mood messenger - UPDATE
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Toggle auto-update

Rather than manually updating apps, which is easy to forget,
Google Play is set to automatically update apps for you when
you're on Wi-Fi. If you'd prefer that it install updates automatically
even when on cellular data — or not auto-update at all — you can
change the setting easily.

1. Swipe in from the left edge of the screen OR tap the three-

line menu icon in the top white bar to open the menu.
2. Scroll down and tap Settings.

) Books
2 © W% . 812:50
D Music
je== Newsstand
< Family Library
For You Top Charts Categories Editors' C... Early,
New + Updated Games MORE =} Account
4 =) Redeem
Wishlist
Dungeon i MiniGolf i Harry i Bub
Hunter C. King - M... Potter. Witc
4.1+ 45» 4.4+ 4.7+
< Settings |
Previously installed apps MORE
Give one a go nep o reeauace
G - ‘ Parent Guide
-y
----- #
© e— WEATHER About Google Play

3. Tap Auto-update apps.

4. To turn off auto-update, select Do no auto-update apps.
To enable auto-update on cellular data, select Auto-update
at any time.

t©@ % o 012:50

< Settings

General

Notifications
Manage notification settings AUtD‘Update apps
Do not auto-update
Auto-update apps apps.
Auto-update apps over Wi-Fi only. Auto-update apps
at any time. Data
L |

Clear local search history
Remove searches you have performed
from this device

Auto-update apps
over Wi-Fi only.

User controls CANCEL

Parental controls
off

Fingerprint authentication
For Google Play purchases on this
device

If there are individual apps you do not want auto-updated, you can
opt them out of auto-update while allowing your other apps to stay
updated.
1. Tap the app you don't want auto-updating.
2. Tap three-dot menu icon in the top right corner of the
screen (next to the search icon).
3. Tap to uncheck Enable auto-update.
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Uninstall apps
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BN ERECECE
Managing E-mail Trainee teachers are expected to use electronics technology in and
out of the classroom to foster the teaching learning process. Because
the traditional lecturing method alone did not bring the desired effect
and allow learners to be effective communicator as the 21% century
community demands. Technology brought rich educational
materials to simplify the teaching and learning. And we need to
utilize such materials. To do so we have to have the skill and
knowledge to operate technological tools and explore appropriate
materials to use and consume them for the required purpose. So, in
this tutorial, you practice input the address of a website, send and
receive emails, and downloading files from the internet using the
mobile phone.

In previous “basic computer” training you have learned and created
your internet account. Now, using your account, you are going to
practice to input the address of a website, send and receive
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emails, and downloading files from the internet using the mobile
phone.
» Go to the app’s menu on your mobile phone and use any
browsers like Internet explorer, Chrome, Gmail and
Google. For the purpose of this tutorial, we use Gmail to
input your address on the address bar. Now, press the
Gmail icon as indicated below.

QA AHAADAO DWW WY | 85%N 1509

= ® Press this
a icon to input

your address

Google Chrome Gmail

Maps YouTube Drive
oo @ =
Play Music Hangouts Photos

» Now a new window will pop out to enter your address.
In “email address” section, enter your address which
looks like this: melakuhailemichael7@gmail.com;
melaku20@yahoo.com. Next, enter your password in
the space provided below. And press the “log in” button
to go to “in box”. The inbox the place where you will see
email messages sent to you.

» Now practice the following steps as shown below. Note
that while you read the message, you may encounter an

attachment icon Attachments This indicates that you have
attachment file that you need to download. So, if you see
thing, you should press/click it and “View & Save”
options will be displayed. So, select the SAVE button as
a result the process of downloading will emerge.
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» Now the next step is to write a message and attach file to
your friend. Note that before writing the message, you
should have your fiend’s email address. So do the following
steps to complete the process.

ACTtAABARORA= % E 83%H 1516

< Compose @ >

From melakuhailemichael7@gmail.com
To | v
Subject

Compose email
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Make free phone
calls and send free
texts [using cross
platform apps]

In this tutorial we practice using VIBER app. Note that in order to
use this application, your friends’ must install the VIBER
application. It should also be noted that the communication through
Viber requires internet connection. So, you should turn ON the
packet/cellular data or Wi-Fi to get the service (how to turn the ON
& OFF the packet/cellular data or Wi-Fi has shown in the above
activities.)
> Go to the application menu and select/press the “Viber”
application icon as shown below. As you do so it will

lead you to the new window.
£ MASNU 346 pm

SEARCH AZ EDIT

DB - <

Goimn Microsoft Play Store Phone
Apps

qo». .

Camarm Gallery Clock Conmacis

D@

ettings 3 Plannet 0 Calculator

@ T e
Galaxy Apps SHAHID
true 7
Truecaller Viber WPS Office

» In the main Viber window, you will see features like
CHATE, CONTACTS, & CALLS. Press CONTACT if
you were already contacted with your friends using
Viber application previously. If this is so select your
friend’s phone number and press a “Free Call” button to
start calling.

» If your friends’ contact number is not displayed in the
dropdown list, press CALL button and enter the phone
number you wish to call. Here two options (Viber Out
Call and Invite to Viber) are displayed. If your friend is
not the user of Viber app, press “Invite to Viber” button.
As a result, a notification message will reach to your
friend. Otherwise press the “Viber Out Call” button to
call him/her.
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Take and share a
photograph

Storing and sharing
files

TRAINING MANUAL

Sometimes, you may need to take a photograph and share it to your
nearby friends to discus and comment on it. This can easily be
done using technological tools in your mobile phone. So in this
tutorial, you are going to practice how to use a camera in your
mobile and share it to your colleague through the use of Bluetooth
infrared technology. To do that you should follow the following
step-by-step procedure.
=~ Go to the application menu on your mobile and press the
“camera” icon to take photo. Next the clear scree with
camera icon will appear as shown in the figure bellow.
And hold the camera straight to the direction of the
objects that you want to take and:

Remember that the data transferring process will be carried out only
when the Bluetooth device is in the ON position and paired with
your friend’s mobile. Also, the data transferring process depends on
the size of the file. Usually transferring video file will take some
time because its size and capacity is big and thus your friend’s data
space on the phone to hold the file should be enough.

In this tutorial you are going to practice the Storing and sharing files
in Google apps. It can be done quickly and easily if you know the
location of your files.
Now, follow the following steps to store the files in Google drive
and share the files to anyone you like.
~ Now, using your mobile phone, go to the “My File/ file
manager” folder and open it. From the dropdown lists,
select “documents”. Here you may see some files that are
stored in your phone.
~ At the top-right side of the screen, there is a “More”
button. Press/select the “More” to get list of instructions
and,
~ Select “share”. When you do so, rectangular shapes will
appear in front of each file (ready to be selected and
waiting for you to select them).
~ Select one or more of this rectangular shape
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Note that when you select the file, a mark  will appear inside the
rectangle.
~ When you do so, the “share” menu will appear in the top-
right side of the screen. So press it to go to the next step.
~ Now lists of applications will emerge. From the lists,
select the “save to drive” icon. And then select “save”
button.
Now you have stored your files in the Google apps. The advantage
of storing your files and photos in Google apps is that you can access
and use them anywhere and anytime (even if you lost your mobile)
as long as you remember your Google account and password.
Similarly, using mobile phone, you can also share files to yours over
the internet. The following practices will help you to share files to
anyone you like. So, let’s tryout the activities.
~ Now, using your mobile phone, go to the “My File/ file
manager” folder and open it. From the dropdown lists,
select “documents”. Here you may see some files that are
stored in your phone.
~ At the top-right side of the screen, there is a “More”
button. Press/select the “More” to get list of instructions
and,
~ Select “share”. When you do so, rectangular shapes will
appear in front of each file (ready to be selected and
waiting for you to select them).
~ Select one or more of this rectangular shape
Note that when you select the file, a mark \ will appear inside the
rectangle.
~ When you do so, the “share” menu will appear in the top-
right side of the screen. So, press it to go to the next step.
~ Now lists of applications will emerge. From the lists,
select the “Gmail or Yahoo Mail etc” icon. And then it
will redirect you to the place where you write/compose
email message as we have practice in the previous
tutorial.
~ Now enter your and your friend address into the address
bar as shown in the previous tutorial.
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Introduction

Getting Ready

Mobile Apps used
for ELT

TRAINING MANUAL

Unit V - Mobile Applications for English

Lanquage Teaching and Learnino

At the end of this unit, you will be able to:
¢ |dentify mobile apps for English Language
Teaching/Learning
e Describe different functions of mobile apps for ELT
e Use mobile phones for teaching English Language

Mobile phones with high capabilities extend into all areas of human
life, so wireless communication technology is growing rapidly.
Consequently, mobile learning can be considered as the next
generation of e-learning. So, mobile devices are not substitute for
existing learning devices, but they serve as extension for learning in
a new environment having new capabilities, though, not all learning
content and activities are appropriate for mobile devices.

Before discussing and presenting possible examples as well as
specific activities that are designed for and used on mobile phones,
I would like to ponder on some questions related to the issue of m-
learning. These questions may help teachers to find out what
difference m-learning might make to their teaching. The issue of m-
learning may induce curiosity, or excitement.

1. Isit really possible to learn/learn a foreign language with
such small devices?

2. What sort of people use mobile devices for teaching and
learning/learning a foreign language?

3. What sort of subjects and situations are appropriate for
mobile learning?

4. Are our students already using handheld computers for

learning?

There are a few free language learning mobile apps will guide you
through learning a language from start to finish or help you sharpen
language skills that you may already have. Learning a new language
with these free apps is particularly helpful because you'll always
have them at your fingertips. Even a few minutes waiting for an
appointment, or 15 minutes in the back of an Uber, gives you time
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to complete a lesson. You can use these language learning apps to
learn words and phrases in lots of different languages,
including Spanish, English, French, Italian, German, Irish, Dutch,
Russian, Chinese, and many others. Just check each description to
see which app teaches what language.

Hello English covers all the aspects of language learning, including
vocabulary, translation, grammar, spellings, spoken, and reading
skills. However, you should already be able to understand basic
English structure and alphabets, the app can’t help you learn
English from scratch.

When you’ll first launch the app, you’ll have to select your native
language to continue. There are 22 languages supported, and
make sure you choose the right one as the app will work in your
native language from here.

CHOOSE YOUR ENGLISH Q =
COlIRSE ! N ‘ Somt =aly kel 3551 ol Ls
e 6335551 w9351 ﬂ £ _J S Jobszs O
ENGLISH FROM URDU
B _J _sExam/Test O
O el zall e s3] zalll @les
@ ENGLISH FROM ARABIC
B S SsShhe She Gosa O
FROM HINDI u = S Slasis o5 93w O
Gt 3 nigraw e B S 595 Lisalee sig (]
ENGLISH FROM PUNJABI
i o 7 ’7 B s ) ekl 5 jeald 630550l O
- ENGLISH FROM ASSAMESE |

e ———————

Afterwards, you’ll be given a 20 questions test that the app will
use to assess your current English level. According to the test
results, you’ll be recommended lessons that will work best for you.
For example, when | did a perfect score on the test, the app
recommended me to start from the lesson 351. Although, when |
did very poor on the test, the app recommended me to start from the
lesson 1.

Please take a short test to assess P
your English level

Have a conversation
it ©on the body stand up?
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Hello English uses interactive games to teach different English
lessons, and you’ll earn coins to unlock more difficult lessons.
Even experts can find some good lessons to sharpen their English.

v Duolingo uses interactive games to help you learn up to
23 different languages, including English from the scratch.
For beginners, the app focuses on helping you learn verbs,
phrases, and sentences. Although advanced users can also
improve their language by completing writing, speaking,
and vocabulary lessons.

v" You’ll have to choose the language you want to learn and
your native languageto start the learning process.
Afterwards, you can confirm whether you want to
learn the language from scratch or you just want to improve.
Telenor = A 71%0 627 PM

| want to learn... < Pick a Daily Goal

®

Spanish

Casual 5 minutes a day
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v Depending on your selection, the app will make you go

through a simple test. This test will help understand your
proficiency in the language and Duolingo will provide
learning material accordingly. If you’ll make a mistake, the
app will immediately use a different game to help you
learn and correct it. If you’ll still make a mistake, it will use
a different game to further help you understand.
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It’s a community-based app where people help each other and
share their native language. It connects you with real people on
call that are native in the language you are looking to learn. It has
a language exchange system. To get talking minutes to learn a
foreign language, you’ll have to first talk with someone in your
native language and help them learn it. So it’s basically a give and
take app where you are both the teacher and the learner. Overall, it’s
afun way to make friends, learn cultures, and learn a new
language.

Telenor O = 445%R11:33PM 1 Q R 134 PM O T £ 44%811:35PM

& Login With Facebook My profile = Lingbe

Continue as [l

Welcome to Lingbe |

Lingos is our virtual
currency. To get more
time to practice you
need to earn lingos. The
easiest way to that is to
put yourself available
and help other users to
practice  your native
language. You can
change your lingos
anytime to continue
practicing.  You can
explore other
alternatives of earning
lingos in ‘Get more time*
section. Enjoy practicing
and helping our
community!

Lingbe will receive:
your public profile, friend list, birthday, photos
and email address.

(Z Edit This

| am native In Q
& This doesn' let the app post to Facebook. | wanna practice Q

v The main interface only consists of a button to start a call,
and a button to confirm you are available or unavailable to
receive calls. After your call, you can Like the person in
the app to connect with them later. If they like you back,
then they will appear in your Chats section as a friend.
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: practicing or assisting other lingbers to
Get more time make new friends. If you had a pleasant
experience give them a like after the lingcall.

» If they like you back they will appear in your
® Ready to help other lingbers? chat room so you can talk and practice again
at anytime.
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It offers alarge variety of courses for a lot of different
languages, including English. These courses are actually
constructed by other members of the Memrise community,
making Memrise a crowd-sourced learning platform.
Most of the lessons are gamified, and Memrise offers all the
tools to let regular users create courses.

3 c—— 2017 Google Play Awards
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It is quite similar to Memrise as the courses here are
also created by native speakers in the community. You’ll
have to start from a custom difficulty level and the courses
will be provided accordingly. It additionally works as a
social media platform where people with different
languages can chat and share their experience.
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A completely free app that helps you learn over
4000 common phrases and vocabularies. The app works
completely offlineand there aretons of data to
improve your English. The app offers translations, audio
and video lessons, and a bunch of language learning games.
You’ll also get daily speaking, listening, and memorizing
tests that ensure your skills stay fluent.

EASY LANGUAGE
LEARNING

Learn English, Korean,
Spanish, French, German
and more languages for free.

PRACTICE LISTENING TOPICS

COMMUNICATE & VOCABULARY
Improve quickly listening skills,

gain more useful

Support a lot of lessons
and practical Languages.

from easy to difficult

vy 0 % G0 40 4 560 nn
1wantto learn ...
@® English
OFrench
O German
Ohalian Vasotros /-35 estsls oqui.
O Japanese
OKorean
O Portuguese =
O Russian =
O $spanish
Ol

Wi are hore,

You are here.

It uses audiobooks to help you learn different languages. You just
have to listen to stories and novels in the language you want to learn
and side by side read the text in your native language. Audiobooks
lovers will surely love this app as they can listen to audiobooks of
their interest and at the same time learn a new language. There are
many free audio books to hone your English skills, but some are
pald

‘ Filter by: Language - Level T NS

The Legend of La ||
Llorona

Un dia, la tortuga -muy enojada- le CPLAR S5 ML TR U O

ccontesté: “;Quién te crees que eres?

Eres muy veloz, jpero incluso ti The Three Little |
Plg s

onceu Mna\memce s 0 hare wen Storles

Then one day, the angry tortoise
answered back: "Who do you think
you are? You are very very fast, but
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~ Hello Talk It is similar to Lingbe as it connects you with native speakers to
help improve your language skills. However, it adds a few extra
features that might interest you. You can view the profiles of users
manually to find a match that interests you. Additionally, you can
also send text and audio messages, and even do video calls with
other people.

Learn a language by chatting Powerful Language Tools Search for Partners Anywhere

with native speakers Built-in translations, corrections, Filter by language, location, age,
voice to text and more nationality and more
150+ 7 million+

Language ted  Members to chat with

Best Match »

It’s a practicing tool to help you improve your pronunciation and
create confidence to have a conversation in English. The app
has hundreds of recorded conversations where you can listen to
native speakers and then speak and record yourself. You can listen
to yourself and a native speaker to compare and improve your

pronunciation.
vy =  English Speaking Pra.. <¢ = English Speaking Pra.. <
S Offline Mode: [Complalnts & Feelings & Opinions
English Speaking Practice "con:re-rsamnnm English Class
http://www.talkenglish.com Al g: Failing a Class
Offline Mode : All the audio files will 50—
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— N i I
W  Bookmark Before purchasing, please make sure Al Conversations About English Class
you have 250mb of free space on your - Speaking Too Fast
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Remove ads Purchase: »y 4
l)‘f’ﬂ'icnea myde :E'x:,\ Conversations About Being Late
Instructional Video Traffic
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Category - Top a Button, Get a Ride Getting
B O oung Tourr

TRAINING MANUAL AMU, DECEMBER 2019 69



EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

" Evgin iy

"Learn English Daily" is a free application for learning to speak
English. This app follows a simple approach to learning English by
listening and speaking. The app consists of thousands of words and
phrases narrated by native speakers. The app contains lessons that
give special attention to English pronunciation and everyday
language. You can listen to those phrases to improve your
pronunciation and memorize them. It also notifies you to speak
sentences every day to keep your English fluent.

This mobile app is compatible with all of your devices.

U 2143

€ 100 Common Conversations bLeam English Daily i € wouldyoulike

m 1. Where are you from?
Where are you from?

foe PECRIEVDRILEESONS L i \Vhere would you like to meet?

@

I')) Pronunciation Guides

m 2. Do you speak English? L e Where would you like to go?
)
Do you speak English? < )
[a English With Mr Duncan
E 3. What's your name? ' Who would you like to speak to?
What's your name? T— ‘ ))
i i i =
E 4. Aitng siieesone. el Would you like water or milk?
Asking directions. ‘ 2 | ‘ )
[ ] Basic Grammars
5. I'm hungry. ,
m i i What would you like to drink?
I'm hungry. < )

v' LISTENING:
= Listening to thousand English phrases by native
speaker
v' SPEAKING:
= Try to speak common sentences everyday will help
you improve your English speaking
v" "Learn English Daily" include:
= A hundred Common English Conversions
= Thousand Essential Phrases and Words
= Online lessons
= Translation to most common languages.
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Open and Use Mobile App (Learn English Daily)

You should search for the app on your mobile device

S8 e

SAT, NOV 23

Assistant

Learn English Daily

You can select one tab among
*d w2144

bLearn English Daily

FOMNS ONLINE VIDED LESSONS MORE ENGLISH APPL|

ONLINE LESSONS
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© = il 77% (8 5:23pm

rQLearn English Daily g

... © = il 76% (M 5:23pm

rQLearn English Daily

BONS BBC LEARNING ENGLISH

B

LISH PRACTICE ENGLISH READING SKILL

6 Minute English
Web Reader

LingoHack

218

Everyday Phrases

News Review

You can tap one option among different options under Offline Lessons tab. Example: tap “100

Common Conversations”.
y

100 Common Conversations

1. Where are you from?

Where are you from?

2. Do you speak English?
Do you speak English?

3. What's your name?

What's your name?

4. Asking directions.

Asking directions.

5. I'm hungry.

You can tap one conversation among these listed under “100 Common Conversations”.
Example: tap “Ask directions”.
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< Asking directions.

p e

Hi Michael.

Hi Amy. What's up?

I'm looking for the airport. Can
you tell me how to get there?

Mo, sorry. | dont know.

| think | can take the subwai

You can search for special phrases by taping “Essential Phrases” under Offline Lessons. Then
you can search for any phrase like “would you like”.

*4 & 21:44

(5 would you like >

Where would you like to meet? ‘ )
)

Where would you like to go? ‘ )
)

b |
Who would you like to speak 10?7 * )
)

—_—

Would you like water or milk? * ) y
)

What would you like to drink? ‘ )
)

A
0
a
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If you want to set your native language to practice on the app, you can tap three-dot menu
icon in the top right corner of the screen (next to the Learn English Daily text).

"4 E 1137

bsngnsh Conversation € Choose Your Native Tongue

BPONS ONLINE VIDEO LESSONS MGORE ENGLISH APPLI

I' )) Pronunciation Guides Purtuguese
PRONUNCIATION
- Russian
English With Mr Duncan
——
I Thai
|
Advanced Lessons
(@ Turkish

. YVietnamese
Basic Grammars

* .
Chinese

4 O O

You can tap one option among different options under Online Video Lessons Tab. Example: tap
“Pronunciation Guides” or “Basic Grammars”.

S wWEmDEn

VZI-@NEﬁIl

< Pronunciation Guides < Basic Grammars

Learn Pronunciation of English Vowel Sounds 1 -
Introduction

R
ﬁ-;;‘fﬁ O How o use 'To Get' - English Vocabulary Lesson

»
Pronunciation of English Vowel Sounds 2 - Front Fhrasl Common English Expressions with ‘'make’ & 'do’
Vowrels, Part 1

Pronunciation of English Vowel Sounds 2 - Front

To Have' - English Vocabulary Lesson
Vowels, Part 2

FPresent Simple vs Present Continuous - Learn

Pronunciation of English Vowel Sounds 3 - Back !
English Tenses (Lesson 1)

Vowels - Part 1 (with captions)

Present Continuous f Present Perfect Continuous

Pronunciation of English Vowel Sounds 3 - Back
- Learn English Tenses (Lesson 2)

Vowels - Part 2 (with captions)

Present Perfect Continuous vs Present Perfect -
Learn English Tenses (Lesson 3)

Pronunciation of English Vowel Sounds 4 - =
Central Vowels - Part 1 (with captions)

s  Pronunciation of English Vowel Sounds 4 -

X _ Present Perfect vs Past Simple - Learn English
[ Central Vowels - Part 2 (with captions)

Tenses (Lesson 4)

Pronunciation of English Vowel Sounds 5 - ction Werlld Action Verbs vs State Verbs - Learn English
Diphthongs (with captions) = ote Verdel Tenses (Lesson 5)

English Accents - Bonus Lesson on the birng Lo i Future Simple vs 'Going to' Fulure - Learn English
Pronunciation of Vowel Sounds __ Tenses (Lesson G)

o e = — [ | =
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Mobile devices for
Different Activities

TRAINING MANUAL

Apart from the downloadable apps from the play store and website,

the m

obile phone by itself can be used for English language

teaching. Examples of mobile learning and mobile learning

situat
>

>

ions can be the following:
SMS-based learning — receiving wanted text messages
supports learning outside classroom.
GAME-based learning — in which learning materials are so
designed to be integrated with aspects of physical
environment, they serve as a link between the real world of
knowledge and the visual world of the game, e.g. Timelab is
a game about climate change and its effects. Players get
information about possible new environmental changes and
laws as they progress in the game. The results of the game can
be later discussed in the classroom.
M-learning can be used to teach such skills as: vocabulary,
pronunciation, grammar, listening, reading comprehension,
speaking and spelling. Variety of activities related to language
learning can be supported by mobile devices:

e SMS - vocabulary, reading, writing;

e Internet access — reading comprehension, listening,

speaking;

e camera — speaking when e.g. describing a picture or a
scene;

e audio/video recording - listening, speaking,

understanding and listening to other speakers;
e Video messaging — MMS — sending recorded scenes,
role-play situations, recorded speaking tasks.

Now let’s practice using the ‘ideal self’ language user; reflecting on

learni

ng and motivation

This activity might help with:

>

YV V

A\

learners getting to know themselves and each other and
building confidence in their second language identities
developing speaking and writing skills

focusing on language - modal verbs

identifying useful and not so helpful language learning
strategies and providing help with identifying new ideas to
try

Introducing learners to digital literacies involved in creating
multimedia recordings and sharing these in an online space;
negotiating rules for etiquette, privacy and safe online
practices.

1. Introduce learners to the ideal second language self as a concept,
relating to the various characteristics that learners would ideally
like to possess as a fluid and fluent ‘ideal self” language user.
Learners might like to discuss their own sense of identity as a

la

nguage learner.
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Further sources of
ELT apps

TRAINING MANUAL

2. The following ideas for sentence stems relate to learners’

thoughts about their L2 Language

‘Self’:

Tam...

I could be...

I might be...

I will be...

I was...

I ought to ... (but I don’t...)

Something what helps me learn is...

I learn best when...

Now, I need to...

One thing I could do tonight/this week is...

My learning goal (this week) is...

My learning goal (last week/today) was...

Learners choose one or two sentence stems (or write their own)
to complete and record (audio or video) in or out of class.
Learners might like to post these to a shared space with
additional multimedia (using sound, image combinations or just
a photo from the surrounding environments of their lives, e.g.
places around campus, home, job, place of worship, etc.).
Learners could write/record one sentence in their current or
ought-to self, go on to their ideal L2 self, and comment
on/discuss their own and each other’s representations.
Reflection should involve considering how far they have come,
and how far to go in their own ‘language learning journeys’ as
well as identifying appropriate learning goals and strategies for
achieving these.

Learners should be asked to document the process and
achievement of one or two of their goals (and challenges) by using
the audio voice or video recording functions of their mobile phones
or by taking a photograph.

~ Android apps for ELT

o http://list.ly/list/6a4-android-apps-for-elt
~ Apps for iPad

o http://ipadapps4school.com/category/college/
~ Android and 10S apps for ELT

o http://ist.ly/list/6qC-byod-apps-for-elt
=~ British Council Apps

o http://learnenglish.britishcouncil.org/en/apps
=~ Collins ELT Apps

o www.collins.co.uk/page/ELT+Apps
=~ Cambridge University Press Apps

o www.cambridgemobileapps.com/
=~ Macmillan Apps

o www.macmillanenglish.com/educational-apps/
=~ Reviews of the latest ELT apps

o http://eltjam.com/?s=product+review
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Unit VI - Facebook group for English language

teaching and learning
At the end of this unit, you will be able to:
Objectives ® Recognize different social media for ELT

e Describe how Facebook can be used for ELT
e Create Facebook for ELT

Introduction Social Media has been defined as websites which allow profile
creation and visibility of relationships between users. They are web-
based applications which provide functionality for sharing,
relationships, group, conversation and profiles. Social media has
been referred to as “social media sites” or a set of information
technologies which facilitate interactions and networking. Social
media, such as Facebook, Twitter, and LinkedIn, provide people
with a pervasive network connectivity (Asur & .

Some of the social media is going to be around for a long time are

as follows: -
=  Twitter
= Facebook
= Blogging
= Skype
=  WeChat
= Instagram
= Google+
= Viber

= Telegram and
" many more.

Getting Ready 1. Whatissocial media? What social media types do you know?

2. How can vyou wuse social media for language
learning/teaching?

3. Do you think your students are already using Facebook? For
what purpose?

4. How can Facebook be used for language teaching and

learning purpose? What will be the role of the teacher?
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Using Social Media
in the Classroom

Facebook

Instead of fighting against students’ digital habits, there are positive
ways to incorporate social media in the classroom and into
educational settings that both the teacher and students will love.
Today’s classrooms are full of digital natives — kids who have
grown up uber-connected through technology. Teachers want their
students involved in the classroom process and not pulled away by
apps like Instagram and Facebook. While the first inclination is to
keep students completely away from social media, the reality is that
technology is a huge part of their future. But how to use social media
in the classroom?

There are many dlfferent ways that social media can be used directly
in the classroom for education that can be taken advantage of for
students of any age, from elementary all the way through college.

a social network that both teachers and students can comprehend and
one they both know how to use quite well. Facebook gets a lot of
criticism as a spot for wasting time, but there are some pretty
significant ways to use it for good, especially when it comes to
learning pursuits. Take a look at some educational uses for
Facebook:

o Broadcast updates and alerts - Have students follow the
class’s Facebook Page, and the instructor can use it to post
class prompts, updates, share homework assignments and
encourage discussion. Even if a student isn’t active on
Facebook, these pages are still accessible when signed out. If
you want help moderating the page, assign one or two
students as administrators. However, keep in mind Facebook
Page are public and anyone with a Facebook account can
comment on the posts.
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1k Like | A Share

@1 Arkansas Tech University College of Business shared an

figs event.
ARKANSAS October 30 at 12:36 PM - Q

TECH Be sure to tune in and have your questions ready or submit them in
advance!

UNIVERSITY

“ollege of Busines*

Arkansas Tech
University College
of Business
@ATUBusiness
Home
About
Photos
Reviews
Join my email list FRI, NOV 15 AT 1:00 PM CST
T MBA Virtual Information Session

Arkansas Tech University - Graduate College * Russellville, AR
Videos

Like Comment Share

Welcome [f) O »

o Stream live lectures and host discussions - Instructors can
also create Facebook Groups for each of their classes—both
public or private—and stream Facebook Live lectures, post
discussion questions, assign homework and make class
announcements.

= Keep students engaged during school breaks or snow
days by posting reminders and assignment to avoid
having to review once class resumes from the break.

= When using social media for education, it’s
important to ensure a professional boundary, so
when setting up a Facebook Group, teachers do not
need to send friend requests. Email both parents and
students a direct link to the Facebook Group for
access.

Skype widely known videoconferencing software that allows one to

effectively bring in people from around the world. Since a trip to a

specific location (such as a different country) probably isn’t feasible,

you can always bring the location into the classroom with Skype.

Through video chat, your class can speak with other classes in

different parts of the world.

o Use for Guest Speakers - Some educational destinations
may also provide lectures or tours through Skype, allowing
your students to experience a culture in real time with full
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Twitter

Instagram:

Pinterest

TRAINING MANUAL

interactivity. Therefore, teachers can make good use of the
platform to reach out famous authors and subject related
experts to talk to the students, share valuable insights and
knowledge through videoconferencing feature of Skype.

o Use Twitter as a class message board - Twitter can be great
as a discussion board or message board for a class. Teachers
can create a single Twitter handle per class and reuse it every
year, or they can create a new handle each school year. The
280-character limit makes students think critically on
communicating concisely and effectively, a beneficial skill to
develop.

= Teacher can use Twitter to post reminders for
assignment due dates or share inspirational quotes
and helpful links to practice quizzes or resources.

= Teacher can also create discussions and Twitter chats
surrounding a specific hashtag that they create.

A picture really does say a thousand words (or more) so tap into
your students’ attraction to visuals with this popular social media
app. Consider these classroom-friendly Instagram uses:

o Use Instagram for photo essays - In a visual heavy class,
students can use Instagram to present a series of photos or
graphics in a visually appealing manner. Instagram allows
students to practice digital storytelling in ways that other
social media platforms may fall short.

= Students can create class-specific Instagram
accounts and may delete them after the course is over
if they so choose.

o Assignment resources - When students have an assignment
due that involves a local resource, encourage them to
physically go to that resource and see/experience it for
themselves. If the student has access to a smartphone, have
them upload an Instagram photo of that trip and tag it with an
assigned project hashtag so that you and the other students
can access it.

o Redo famous images - Assign a historic image project where
each student picks a famous image -either a photo or
illustration- to recreate in his or her own way. Encourage
students not to simply copy the original images but to
interpret them in their own way, whether by taking photos or
using Instagram features. Group students into pairs for this
assignment to ensure that everyone has access to a
smartphone.

The idea of “pinning” things to a board is nothing new in

classroom settings. Teachers have asked students to create

posters, corkboards, and other physical collections of themed
ideas for decades. Pinterest simply expands the reach of what
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Facebook as a tool
for English teaching
and learning

TRAINING MANUAL

students can pin and makes it electronic. Here are a few specific
ways to use this platform of social media in the classroom:

o Group work - Have students share a Pinterest board to
collaborate on upcoming projects. When they are ready to sit
down and actually create an essay, poster, or presentation, all
of their ideas are located in a central spot.

o Encourage students to scan images of their strongest work
for an online board portfolio - They can add to it throughout
the year and even add more segmented options.

o Brag boards - Create a board and pin the best work of your
students for all to see. This is an easy way to encourage
students and allow their peers to see their hard work. You can
even invite parents to join the board to see the students’
handiwork.

Technology is ingrained in high school students today, so why fight
that inclination? Social media is a part of students’ lives, and
teachers can use that to their advantage in the classroom. Find ways
to connect with students through social media in the classroom, and
it will lead to a more streamlined experience for you and all of the
kids.

Exchanging ideas on various platforms makes learning very easy.
Whether the Student is from high school or college going, it is the
best idea to make them unite on a common topic. When you decide
to go to the Facebook for learning, there are many ways to fulfill
this task. Today Facebook gives more options to use it as a learning
platform. Let us look at some of the advantages of using Facebook
for students. They can start to practice it and learn a lot.

~ Facebook groups
Check the number of students in your school. Make sure that they
are on Facebook. This is necessary for learning the Facebook in the
classroom. Create a Facebook group of all the students in your class.
Make this group private because student's information and courses
get shared in it. This is a good option for Facebook learning.

~ Documenting
Ever seen the younger generation on Facebook? They want to
publish, share and record every part of their lives. Where they go, to
whom they meet, and what they do in their day to day lives. Take
advantage of this and use this for Facebook for educational
purposes. For example, if the class has organized a picnic or an
educational trip, the teachers can put up the pictures as a part
of Facebook learning. They can share information or reviews about
it on the site.

~ Facebook Live
Facebook life can prove to be an excellent learning feature for
students and for educational purpose. Students can use the Facebook
in the classroom to stream videos. They can post it later for others.
This medium is not only for educating them but also good if students
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want to use it for their referencing later. Students can record difficult
chapters. They can use it in the study by watching and learning later.

~ Facebook Polls
Polling can be an exciting medium for students. They can seek and
give their opinions about a particular topic or a situation of debate.
Students through Facebook learning can create their polls for their
classmates. They can ask for their vote about simple day to day
things or class materials.

~ Digital citizenship
Using Facebook for educational purposes encourages students to
meet and talk online. The teachers can guide them to get digital
citizenship skills. Students through Facebook learning can learn
how to create content. They can comment and share the right kind
of material online. Digital citizenship also allows the students to
identify, analyze and differentiate fake content. These contents run
online from the real ones.

~ News Feeds
Students can create news webcasts for themselves. This is one of the
most exciting points of Facebook for students. Later, they can share
it on the page for their friends and classmates. Webcasts contain
clips, local news, favorite stories, breaking news. Students can share
it with the classmates belongs to each field. For example- academic,
fashion, sports, inter-school competition or inter-school standings
etc.

~ Challenge your mind
Big companies have the capabilities to nurture and bring up new
talents. They have contests and web challenges or quiz to identify
talents of all age groups. Facebook learning is a suitable medium for
this purpose. These challenges offer business and mind bender case
studies for students. Students can take up these challenges online.
Then they can apply and show their skills on these platforms.

~ Post events
Facebook for educational purposes has not limited functioning. It
provides more than studying and sharing bookish knowledge.
Facebook for students can also have a fun piece. Schools often
organize or take parts in matches or a charity event or festivities.
Students can put up all the events that are taking place in their school
on Facebook. They can invite participation while informing
everyone about the events. This approach enhances Facebook
learning and develops a synergy among all students. Students can
sync up their calendars with Facebook since it offers that feature.

~ Make global connections
Facebook is not a restricted medium to a city or country. It is a
worldwide platform. Then why not make the Facebook in education
also that broad? Students from different parts of the world can come
together on various topics. They can debate and discuss to draw a
conclusion or have a common opinion on a particular issue. That
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What is Facebook
Group?
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doesn’t affect their own demographic rather it is a part of a more
prominent and common global problem.

~ Book/Journal Reviews
Books or educational magazines are a part of every child’s life.
Learning is must whether he is learning from a textbook or using
Facebook for education. What if you have read an excellent book
which you feel your friends should also read? You are studying for
a competitive exam and feel this book has unique contents. It may
help analyze faster. You have a paper to write and need reference
or guidelines. Do you want to access another friend's published
journal? Facebook in education helps students find and improve
each other sail through.

Facebook Page

« Built-in analytics (Page Insights).

e Call-to-action button (e.g. Sign Up, Book Now, Learn
More) on your Facebook Page.

e Boost your Facebook Page and Page posts
with Facebook ads.

o Like and comment as your Facebook Page.

o Add apps and services to your Facebook Page, so that
your fans can easily order a product, make a booking,
get a quote and more.

Facebook Group

« Built-in analytics (Group Insights) now.

e Set your Facebook group as private (Closed or Secret).

o Post documents, create polls, and even buy and sell in
your Facebook group.

e Group chat with your group members.

e Members receive notifications about new posts to the
Group.

Note: You can link your Facebook groups to your Facebook
Page.
A Facebook Group is a page that any Facebook user can create in
order that others can join, allowing group members to interact based
on a common interest, affiliation or association (Cary Janssen,
2010). The main purpose of groups is to help users socialize around
any topic or community and to share information/knowledge for
students. Some important significant features are: -
- ability for administrators to message members of the group
directly and
- all members of a group have the ability to engage in a single
chat window.
Therefore, in education students can learn actively and interact with
classmates and teacher more and easily. Interaction through
Facebook is not a face-to face interaction so that students felt less
anxiety which resulted in increasing motivation in language
learning.
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Create a Facebook
Class Group
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Let’s see some important steps to create a Facebook group here:

1. Open Facebook page
If you do not have a Facebook account you should create your new
Facebook personal account. However, if you already have created
and familiar with this application, follow the following steps.

(a) Double click on one of internet browsers (such as Internet
Explorer, Firefox, Opera, Google Chrome, etc.) on your
compulter.

(b) Type www.facebook.com address on the URL address bar
and press inter key or click the search button.

(c) Enter the security username and password code into the
provided Textboxes and then click Login button to go to the
next step.

2. Create Facebook Class Group

To start, click on “Group” under the “CREATE” section at the
bottom of the left sidebar.

EXPLORE
|| Pages
@ Groups
Events 1
I Saved

|2L| Friend Lists

#%) On This Day

| Pages Feed
'."EJ Insights
& Games

w See More...

CREATE
Ad - Page - Group - Event

You can also find the same option under the drop-down menu in the
upper-right corner of any Facebook page:
-~ s smoH

SRS ST

apszzom ¢ IGi=0Z witus B

Espozeam =0T e 2

=
: — - |

BT e

sped sfnon
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Next, fill out the basic info in the pop-up:

later.)

have to add or invite at least one person.)

Closed, or Secret)

e Choose a name for your Facebook Group (You can change this

« Enter the names of friends you want to add or email addresses
of the people you want to invite to your Facebook Group (You

o Select the privacy setting of your Facebook Group (Public,

Create New Group

¥ b
< '--“‘-gf
i3

Name your group

conversations, make plans and more.

Outside Warwick University «

Groups are great for getting things done and staying in touch
with just the people you want. Share photos and videos, have >

| Alfred's Test Group

Add some people

Ash Read

Hey Ash! Would you be interested in joining my cool new Facebook Group? ;)

Suggested: =3 . =

Select privacy

@ Public Group

Anyone can see the group, its members and their posts.

] Pin to Shortcuts

Learn more about groups privacy

Here’s a quick overview of the differences between the three privacy

Public Closed Secret
Wh ey Anyone can join or be added | Anyone can ask to join or be Anyone, but they have to be
0 can join?
L or invited by a member added or invited by a member added or invited by a member
Who can see the
Anyone Anyone Current and former members
group's name?
Who can see who's
. Anyone Anyone Only current members
in the group?
Who can see the
o Anyone Anyone Current and former members
group description?
Who can see the
Anyone Anyone Current and former members
group tags?
Who can see the
R Anyone Anyone Current and former members
group location?
Who can see what
members post in the | Anyone Only current members Only current members
group?
Who can find the
B Anyone Anyone Current and former members
group in search?
Who can see stories
about the group on
Anyone Only current members Only current members
Facebook (ex: News
Feed and search)?
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Group Name | ¢ ~ | Alfred's Test Group

Group TyPe " & pick a Group Type

Group types help pecple see what the group is about.

Description

P

Potential members see the description if privacy is set to public or closed.

Tags |write up to 5 tags (ex: soccer)

Tags help people find groups they might be interested in joining. You can change these at any time. Learn more

Locations This can help people find your group more easily if they're looking for groups in your area.

Add Locations

For example, a public or closed Facebook Group could be suitable
for a community of your customers while a secret Facebook Group
could be great for exclusive groups such as VIP customers or beta
testers.

e Ifyour Group is public it’s also worth noting that anyone can
see the posts and comments in your Facebook Group without
having to join. If you want to protect the privacy of your
members, a closed or secret Facebook Group will be more
appropriate.

Once you’ve decided on the privacy options, hit “Create”.
You’ll be prompted to select an icon for your Facebook Group. If
you don’t have a preference, Facebook will default to the generic
Group icon ( (129 ).

3. Fill out Facebook Group’s info
Head over to your Group settings, by clicking on the three-dots
button below your cover photo and then choose “Edit Group
Settings”.

A best practice is to work your way down the list of and fill each out
accordingly. Here are the key things to do:
e Add a cover photo - The ideal cover photo size is 820px
wide by 462px tall.
On the desktop, Facebook will crop the cover photo a little from the
top and bottom.
e Select a group type to help people understand what the
group is about - types available:
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AMU, DECEMBER 2019 86


https://buffer.com/library/ideal-cover-photo-size

EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

* Buy and Sell * Project
* Close Friends » School or Class
* Club » Study Group
» Events and Plans » Support
+ Family * Team
* Neighbors *  Travel
e Parents e Custom
2qyT quad 5 3219
‘“oqque e “HME“‘“ 3 coang el ar )f«“‘la abnnc»\nuf
maaT q navq ":; albraid aecld \,}.'
boaT E' 1ok (8 D
modaud ‘ . 22610 w looria3 e 2nol boe 23 %
quond oura é Yimz3 Q
[ minneo [

Write a description to tell people what the group is about in more details - to share

information that they want the entire group, especially new members, to know such as the
dos and don’ts of the group.

Add (up to five) tags to help people find your group. For example, when I search “social
media” on Facebook, Facebook groups with the “social media” tag will show up.

n social media
All Posts People Photos Videos Shop Pages Places Groups
Filter Results
@ Groups Sea All Eng
POSTED BY - Py Por
=y@llos, Dirty Little Social Media Questions v Joine
*/ Anyone :-?gg'?l 361 members - i
| You %’i [ S“c
EY i 2 c
_ Your Friends <0 v °
- Your Friends and
CETD Social Media - New York City |4 Join |
(+) Choose a Source... 1,000 members
POSTED IN GROUP
* Any group
_ Your Groups See All
Once you start typing, Facebook will offer some suggestions such as this:
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Tags  Social medial

Social Media Today
503,205 like this n joining. Y\

ocations Social Media Examiner @ fre looking

496,093 like this

Social media
nd Email 55,358 like this

Address

bosts using

Social media marketing
13,642 like this

e Add your location if you are a local Group. It makes it easier for people who are looking
for Facebook Groups in your area to find your Facebook Group. You can add multiple
locations if your group is present in a few places:

Set Group Location e

[United Kingdom * | | United States = || Singapore =

g H
T
™ j. . Russia

el :

N\

e Customize your URL. Using an easy-to-remember URL makes it easier to share your
Facebook group with others during meetups and conferences.

Customize Web and Email Address »

Create a name to use for your group's web and email address.
Names should be less than 50 characters.

alfredtestgroup

facebook.com/groups/falfredtestgroup
alfredtestgroup@groups.facebook.com

MNote: Once your group has more than 5000 members, you
won't be able to customize your address again.

Customize Address Cancel
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4. Add or invite friends and promote the Facebook Group
Facebook Group is now ready to be shared, Add or invite people using the ‘Add Members’ field
on the right of your Facebook Group.

Add Members

tofVideo =4 Live Video B more ADD MEMEBERS
+ Enter name or email address... =]

MEMBERS 2 Members

‘eate Poll Feeling/Activity o
SUGGESTED MEMBERS Hide

e To add a friend, enter their name in the field. Your friend will join the Facebook group
automatically without having to accept any invitation.

e To invite a friend or customer, enter their email address. If you want to add a personalized
note on the invite, click on the tiny blue icon on the right.

n Facebook

Alfred Lua has invited you to the group Alfred's Test Group.

Ash Read is a member.

« Share photos and videos

« Collaborate on projects

« Create events and polls

Hey, Alfred! I'm starting a new community for in-house content marketers to get together. Interested? )

Groups are separate spaces where you can:

= sent to alfred.lua@hotmail.com. If you don't want to receive email invitations from this group in future, please unsubscribe.

This message

Facebook, Inc., Attention: Community Support, 1 Hacker Way, Menlo Park, CA 94025
If you are certain your invitees would love to be part of your Facebook group, you can go ahead
and add them. Otherwise, | would recommend inviting them and letting them decide if they want
to join.
Tip: There’s a “Share” button just below your cover photo for you to share your Facebook Group
to different parts of Facebook (e.g. timeline, Messenger, and Page.)
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TRAINING MANUAL AMU, DECEMBER 2019 89



EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

Personal o Edit Groups Select None

Q%ﬁ o

o Just started a community for testing things in a Facebook group. Interested to join m...

o Now that you have seen my test posts, want to join my test group? & &
@ Testing helps make sure your social media posts look great. Here's a Facebook grou... &
@ Testing is fun (and sometimes, awkward). Here's a community for you to test things i... &

Add to Queue ~

5. Link the Facebook Group page to Facebook Page
Here are the advantages of linking your Facebook Group to your Facebook Page:
o It’s easier for your Facebook Page fans and visitors to find (and join) your Facebook Group.
e You can post, Like, and comment as your Page in your Facebook Group.
e Your community can have a separate space to interact and build relationships with one another.
This is how it looks on HBO’s Facebook Page:

1. R
¥

HBO @

Home
About

Photos ol Like 3\ Follow | 4 Share | - Watch Video

Events

Videos Groups

Posts

Big Little Lies Official Group
Groups ? 23 <+ Join Group
Notes Wt Welcome to the official Group for HBO's new limited series, Big Little Lies. Thisis a ...

Community

About  Create Ad Create Page Developers  Careers Privacy  Cookies Ad Choices[> Terms Help

Facebook © 2017
list ) Polski Espafiol Frangais (France) ltaliano Lietuviy Romand 3Z(iEf) Portugués (Brasil) Deutsch Luall 4

To link your Facebook Group to your Facebook Page,
= click on “Groups” on the left sidebar of your Facebook Page.
= [fyou don’t see the “Groups” tab on your Page, go to “Settings” - “Edit Page” and add
the “Groups” tab to your Page.
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Alfred's Test Page

Page Messages

i+ General
¥ Messaging

£+ Edit Page

= Post Attribution

& Notifications

Motifications B

Insights

© Messenger Platform

[

Page Roles

People and Other Pages

Preferred Page Audience

i Partner Apps and Services

%" Branded Content

Instagram Ads

J Featured

m« Crossposting

1 Page Support Inbox

= Activity Log

Q 52 atfrea

Home 20+

Settings

Publishing Tools Help =

Edit Page

Configure actions and tabs for your page

Templates

Choese a template with default buttens and tabs designed to help your Page.

Current Template:

“:- Standard |i|

Tabs

Click and drag a tab name to rearrange the order. The tab erder also determines the order of

the sections people see at the top of your Page.
| OFF

Use default tabs

Turn en default tabs to use the tabs we think will be most successful for
your type of Page.

Home | Settings ‘

= Posts | Settings ‘

- - . | |
=  When you click on “Groups”, you’ll be prompted to link a group to your Page. Hit “Get
Started”. (If you have not created your Facebook Group, you can click “Create Linked
Group” to start a brand-new Group.)
= A pop-up will appear for you to select the groups you want to link. Hit “Link™ and then
“Link Group”.

And you’re set!

Link a Group

Groups You Manage - 6

Buffer Happiness testing
Public Group Link
7 friends - 8 members

CIM

Secret Group Link
4 friends - 5 members

Family

Alfred's Test Group
Public Group Link
1 friend - 2 members

University of Warwick Triathlon & Ro...
Closed Group Link
64 friends - 565 members

T~
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A

Alfred's Test Page
@alfredtestpage

Home
Posts
Reviews
Videos
Photos
About
Community

Groups

Manage Promotions

Introduction

Lead in Task

Overall - 820px wide by 462px tall

Visible on desktop - 820px wide by 312px tall

s Like 3\ Follow = 4 Share | --- Learn More #
Groups Create Linked Group

Alfred's Test Group
- Public Group A Share
1friend - 3 members

About Create Ad Create Page Developers Careers Privacy Cookies Ad Choices[> Terms Help

Facebook ® 2017
English (US) Polski Espafiol Frangais (France) Haliano Lietuviy Romé&nd 3Z(#fk) Portugués (Brasil) Deutsch iuall 4

Unit VII - Free Audio-video Record and Playback

Tools for ELT

At the end of this unit, you will be able to:
e Recognize different Audio-video record for ELT
e Describe what snagit is
e Record a video with a snagit

A screen capture is a snapshot or recording of anything on your
current computer screen—your desktop, a window, an application,
a region, a hidden window, or an entire webpage and turning into an
image or video. Screen captures allow you to communicate quickly
and efficiently with others. Screen captures are one of the most
useful ways of sharing what we see.

While they may seem similar, a screenshot and screen capture are a
little different. A screenshot only refers to a static image. A desktop
screen capture involves grabbing anything on your screen, including
images, animated GIFs, or videos. It sounds a little bit like arguing
semantics, we know, but it can make a difference depending on what
end result you want.

1. What is a screen capture?-

- 2. What would you do if you want to record what

you do gjn your computer as yqu do (teach)?

TRAINING MANUAL
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Some screen Some of the best Screen capture applications are: -

recorder tools e TechSmith Camtasia Studio (Windows, Mac, iOS) for

detailed video editing

o Techsmith’s Camtasia Studio is an all in one screen
recording and editing suite.

o Camtasia Studio can be used by hobbyists and
professionals alike. Its capabilities include recording
the screen, recording the webcam, editing video, editing
audio, adding transitions and animated callouts.

o Italso features comprehensive editing features. You can
cut, join and render the screen capture video based on
various options.

o Pros

v Powerful screen capture capabilities

v’ Professional editing features including green
screen, callouts, and transitions

v’ Built in extensive media library

v' Export to MP4, WMV, MOV, AVI, M4V, and
GIF

v Export project files to continue editing
elsewhere or share with other people

v Various mouse effects (sounds, clicks) to make
the video look realistic

v Multi-layer editing with timeline capabilities

v Expensive compared to other software
v"In the free version, videos are watermarked
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TRAINING MANUAL AMU, DECEMBER 2019 93


https://mythemeshop.com/blog/best-screen-capture-software/#techsmith

EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

What is Snaglt
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Atomi’'s ActivePresenter 7 (Windows, Mac) — full-Scale
Screen Recording and Tutorial Creation for LMS software
or interactive screen captures

Bandicam (Windows) for hi-res screen recording

Ice Cream Screen Recorder

iSpring Free Cam — Free Unlimited Screen Capture with
Editing

ScreenPresso — Simple Screen Capture Software
CamStudio — Free and Powerful Screen Capture

OBS Studio (Windows, Mac, Linux) — Open Source for
live streaming/Broadcast webinars and Desktop Capture
Apowersoft Screen Recorder Pro (Windows, Mac,
Android, i0S) — Screen Recording with Powerful Export
Options for mobile screen capture

Chris PC Screen Recorder — Record Your Screen at High
Framerates

Movavi Screen Recorder Studio 8 (Windows, Mac) —
Limited Free Version Desktop Recorder

Snagit — Powerful Screen Recording

FlashBack Pro (Windows) — Screen Capture with
Powerful Editing audio post-capture

Screencast-o-matic — Easy Screen Recording

GoPlay Editor — Professional Video Editing and Screen
Capture

Showmore — Web Based Screen Recording

Wink — Create Interactive Screen Recordings

VLC Player — Media Player with Screen Capture

Fraps — Benchmarking and High-Quality Video Capture
Fast Stone Capture — Powerful Screenshot and Video
Capture

Tiny Take — Screen Recorder with Cloud Storage

Snaglt is an application that records desktop images, sounds and
videos and saves them as a video or audio output file. Faculty can
use Snaglt to create simple videos on their desktop for use in flipped
or online classes. It did not allow you to capture the entire website
page and you were limited to capturing only the portion visible on
the screen. Not only can you create photo images of the screen, but
you can also create screen captured videos. Short, simple recordings
that won’t require much editing can be done with Snagit as
compared to others.

There are many reasons for using Snagit:

Gather inspiration for a project

Show the CTAT Department or NTS exactly what’s
happening on your computer

Create handout graphics from a video capture

Create several thumbnail images for a blog or webpage
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Provide directions for your students
e Hide sensitive information

e When soliciting feedback, include a video so reviewers

know exactly what you’re looking for
e Make infographics
e Quickly create how-to documents
e Grab important screens from webinars
e Provide feedback or grade assignments

e Conduct research
e Watermark an image

Snaglt Tool Main Interface

Image View Help SampleSNAG1.snag - Snagit Editor Sgninv A — O X
= Ubrary @ Capture XK a ®[] 0P A vee « » IEJCOpyAum
Quick Styles +
o0 PO
Helpful Tips A @ &)
& Images on a transparent 21l o wh A b
(checkerboard) canvas e e I
lave no backgroul en
ggcu‘::"a‘::‘(hmlnanolhor =] 3 C :z.,v; Shape  Shadow
- TJ ’;':'
ERVo e =
F @ Tag Q /e Efiects L} Propertie
000 == . = — =
p— : = - |
Getting Started with With Snagit, you can quickly capture anything on your screen, edit
Snaglt and enhance your captures, and then send it to common sharing

and share at a later time.

destinations quickly and easily using one of the many outputs to fit
your sharing needs. Snagit helps you create and share high-quality
screen captures for your presentations, documents and blogs.
Snagit’s streamlined workflow combined with Editor’s Open
Captures Tray allows you to continuously capture then save, edit,
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Capture, capture,
capture...

E ﬁ Then... Search, Edit, Share.
\ N

Start Your First Capture
Screen capture is a snapshot of anything on your computer screen—

the desktop, a window, a region, a hidden window, or an entire
webpage. With Snagit, you can capture anything on your screen, edit
and enhance captures, and send captures.

1. In the Capture window, click the Capture button.

2. Select the area to capture:
e Region: Click and Drag to select an area
e Window: Move the cursor over the window. When an
orange dashed border appears around the window, click
to select.

Full Screen: Move the cursor until an orange border appears
around the entire screen

Scrolling Window: Move the Cursor over the window. Click an
arrow to capture the horizontal scrolling area, vertical scrolling
area or entire scrolling area

3. Select Image to capture.

. _______________________________________________________________|
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The image opens in Snagit Editor where you can edit, enhance and
share captures.

Snagit Editor

Preview, edit, enhance and share captures.

Tabas Share
Coontans ooming sndc Host o s e CopiuTes 1o
snhancamant options socisl mecia or other apos

Resize an Image
Use the resize option to enter new dimensions to scale the size of an image:
1) In Snagit Editor, select the Image tab >Resize Image

B Resize -
B Resize Image...h

_I Custom Trim...

2) The resize Dialog box appears. Enter a new value in pixels or a percentage for the width

and height
Resize Image
Pixel Dimensions
Width: 516 = pixels
Height: 428 | pixels

Print Dimensions

Units: | Percent v

Width: 100 = percent

Height: 100 = percent

3) 3.) As you change the value, a preview of the resized image appears. When you have the
desired size click OK.
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Add Shapes, Text 1.) Add a shape
and Callouts to an e In Snagit Editor, select Tools tab> Shape tool

Image

e Select a shape style from the Styles Gallery or adjust the
Outline, Shadow and Opacity options to create a custom
shape.

e Click and drag on the canvas to draw the shape
2.) Add Text and Callouts
e In Snagit Editor, select Tools tab> Callout Tool

Select a text style from the Styles Gallery

Styles

e Click and drag on the canvas to draw the text box
e Type text in the text box
e Click the cursor three times to select the text in the text
box. The text editing options appear on the Text Edit tab.
Change the font, color, formatting, or alignment on this tab.
Share your Captures
The Output buttons in Snagit Editor allow you to quickly share to
different destination such as email, Word, Google Drive,
PowerPoint and more.
1) Click to select your capture
2) Select and output button or an option from the Share menu.

S =N

Set Up the Capture Snaglt identifies a region of the screen and records the visual
information in that area, along with audio from the microphone, the
system, or both.
Before recording
o Create or plan your visual components ahead of time.
Make sure they illustrate clearly the content you want to
explain.
« Create an outline of what you will say.
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Record a Video with
Snagit

Getting ready to record

1. Open the windows you plan to record, such as a

PowerPoint presentation, a website,

2. software for demonstration, or a PDF document.

3. "Stack" the live areas that you wish to record on top of

each other on your screen.

4. If you are using PowerPoint, the Slide Show mode
automatically goes to full screen. To resize it for your
Snaglt window, hit Alt-D, Alt-V. This launches a window
you can resize and re-position.

o Open Snaglt.
o Select Video.

Recommended Settings:

Capture Type: Fixed Region
7. Properties (at bottom of Capture Type drop-

down): Rectangle dimensions: 800 x 600
8. Share: File
o Click the red button in the lower right corner to
set up the recording.

9. Move the recording region over the section you want to
record and click the mouse.

10. The yellow frame with crosshairs indicates the area that
will be recorded.

11. A window will confirm that audio is coming from the
microphone and the system. Change these settings by
clicking on the microphone or system buttons on the
control panel.

12. You may have to resize and/or reposition windows before
recording.

13. Hit the ESC key to return to the desktop without recording.

o The recording window and control panel are now
set for you to begin recording.

o Prepare any notes you want to consult while
recording.

o o

When a screenshot isn’t enough, record a video with Snagit. Start
your video capture from the All-in-One tab or speed things up by
jumping right to the Video Tab. From the Video tab, choose to
include the cursor in your video, record system audio (the sounds
that come from your computer), or begin a recording with the
webcam.
Recording

1. Click the record button in the control panel.

2. A countdown window appears.

3. The yellow frame of the window will scroll during

recording.
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Objectives

Introduction

4. Narrate as you click through your presentation,
demonstrate software, or move from window to window
as you wish.

5. Everything in the active area will be recorded.

o Click the Pause button to take a break, but not
stop recording.

6. To end recording, click the Stop button.

7. There is a message that the recording is being finalized.

o The recording will open in a Snaglt
Editor window.

o Click on the File tab of the Snaglt Editor window
to save the file to your hard drive.

~ 3 Preview in Editor D
Capture Cursor () Capture
Record Microphone On >

Record System Audio q gHntocresy

Unit VIII: E-learning platforms for English
Language teaching

At the end of this unit, you will be able to:
e Understand MOODLE basics
e Differentiate different functions of MOODLE
e Explore different functions of google apps for ELT

Thoodle

This training material is developed to introduce and equip the trainee
teachers with the basic’s skill in Moodle. As a basic (introductory
level) training, the material will not cover all the issues related to
Moodle because the bulky works in Moodle application require
great amount of time. However, we have prepared the complete
video tutorials that explicitly explain the steps to work with the
application for the required purpose. These videos will help you to
enhance your skills of using Moodle for language teaching. More
importantly, it will help you to prepare yourself for the next practical
training we have planned. So, we advise you to follow the video
lesson attentively and frequently in your spare time.

TRAINING MANUAL
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Getting Ready

Discovering Moodle
and What You Can
Do

Meeting Moodle

TRAINING MANUAL

1. Do you think you can attend and design online courses?

2. How do you think the course we see online are designed?

3. If you want to design an online version of the subject you

teach, how can you do it?

Have you ever heard of terms like google class, Moodle?

This Chapter is:

e Getting to know Moodle
Finding your way around the Moodle course front page
Checking out Moodle basic structure and organization
Understanding resources, activities, and blocks
Mastering Moodle terms and conventions
Uploading assignment
Moodle Quizzes And Question Banks

Moodle is a large, Web-based software package that enables
instructors, trainers, and educators to create Internet-based courses.
Moodle is an acronym for Modular Object-Oriented Dynamic
Learning Environment. Moodle provides a robust system and an
organized, easy-to-use interface for learning over the Internet. One
of the greatest advantages in sticking with Moodle is that developers
have kept the look and feel consistent over the years, and they
promise to continue to keep it consistent so that each upgrade
doesn’t feel like it’s a piece of new software.

Moodle enables educators and trainers to create online courses.
Moodle’s home page (Moodle also calls it the course front page)
displays, in its basic form a link to a list of participants (including
the teacher and students), a calendar with a course schedule and list
of assignments, resources, activities, updates, and news. This book
explains all of Moodle features, including online quizzes, forums,
glossaries of terms, wikis, access to documents, and links to other
Web resources, and more.

Moodle is referred to as a course management system (CMS),
learning management system (LMS), virtual learning environment
(VLE), or more recently a learning content management system
(LCMS).
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Understanding
Moodle Basics

So why would your organization use Moodle, or why should you
learn to use Moodle? I can give you a number of reasons. Moodle is
v" Widely used, domestically and globally: As of January 2011,
more than 39 million registered users are using Moodle. This list
shows you a few other stats (the numbers are from
http://moodle.org/stats):
* Registered courses: 4,303,011
* Users: 40, 590, 582,899,203
* Teachers: 1,190,743
» Enrollments: 18,794,573
* Largest site: 59,920 courses with 225,546 users
* Site with most registered users: Open University 714,310
(Moodle. org has 1,030,779)
* Countries using Moodle: 213
* Languages: 83

v' The largest community of users around the globe for a
distance learning software: Moodle has an incredibly large and
active community spanning the globe. It has been vital to the
success of Moodle, and | can guarantee that if you post a
question to the help forums, someone will be awake, somewhere
around the globe, and you will have a reply. It’s like a 24/7 tech
support group. See http://moodle.org/forums.

v/ Based on a sound educational philosophy: Moodle is based on
sound pedagogical principals and educational philosophy,
making it one of the few LCMS that’s learning-centered instead
of tool- and gadget-centered.

v Free: There’s no initial cost to purchase the software and no
license fees! Moodle is open source software, meaning it’s free
and governed by GNU Public License
(www.gnu.org/copyleft/gpl.html). You may think that nothing is
free. Moodle is in that you don’t have to pay for the software or
the upgrades or license, installation, and training (what the
marketing and sales team try to get you to commit to when you
purchase large software packages).
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If you want to explore Moodle and perhaps are excited to start
developing your first Moodle course, you need to know a few details
about Moodle to navigate it and speak the language. The following
sections help get you started.
Creating a Moodle account and logging in to your course
You need just a couple things to get started with Moodle:
An account with a username and password: Aren’t you
glad to learn that Moodle is secure? You need a Teacher, a
Course Creator, or an Administrator account in order to have
editing privileges and create courses.
You can contact your system administrator to set up an
account for you.
A URL.: The URL depends on your organization or a third-
party company that will host your Moodle site.
If you have an account and a URL, open your Web browser (Moodle
works best with Internet Explorer and Firefox) and go to the URL.
If this is your first time accessing your Moodle site, you come to a
page similar to Figure 1-1.

English (n) *
Returning to this web site? Is this your first time here?
Login hire using your usemarne and passwond Hil For full sccess b courses youll need fo lake a rinube bo creale 2
(Cookies st bie enabled in yous browse) g fiwe ALCOUAL FOF YOUFS I on This wieb sibe. Each of e indiidual
) COUPSES iy S50 havis @ one-lime "BnnalFent key", whith you won
Usamame || e Uil later Hese are e $leps
Password
E 1. Fill outthe Mew Account farm wih your detalls

2. An emall will ba immadistely sent to your emall address.
3. Read your email, and chick on e web link it contains.
SOME COUNSES Fray allow oues! access '
e allow g 4. “four accountwill be confirmed and you will ba lopged in.
Login &5 & guest 6, Maow, select thie course you want 1o padicipate in
. IFyou are prormpled for an “enrolrment ey - use the ane thal
your leacher s givien you. This will “enral you in the course.

Forgotten your usemanme or passward? T foU AW AECESS i Rl COUrS®. FrOm Ao on o will onty
- ) v Dadsy i
:I‘ms. help e log in iEed Y0 Erler yous persanal usemame and passward (n the
farm an this paged iolog in and access any course you have
enrolied in
Create new account

Figure 1-1: The Login page
Next time you return to the course, either you see just the login box
as shown in Figure 1-2 (or Figure 1-1) or you go straight to a list of
courses on your Moodle site with a login link in the top-right corner.
You have a number of options to log in, all quite straightforward and
simple.

Returning to this web site?

Login here using your usemame and password
(Cookies must be enabled in your browser) @

Usemame radena
e —

Some courses may allow guest access

(Lognes s guest ]

W your or

Figure 1-2: Returning to the Moodle Login page
I ——
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Navigating the Finding your way around the Moodle course front page is not
Moodle interface difficult when you understand some of the basic terminology and
where things are located. Before | begin to help you familiarize
yourself with the Moodle interface, you need to understand some
terms that | continue to use throughout the book, and the explanation
in this chapter will make more sense. These terms are specific to
Moodle, so it’s a good idea to use them as your reference starting
point.

v" Moodle site/Moodle site front page: Refers to the Moodle
software platform that contains all of your organization’s
courses and blocks with utilities for managing the site. Figure
1-3 shows an example of a Moodle site front page, which
includes all the courses available on the site. There is a login
link in the top-right corner, a site calendar, site news, and the
Site Administration block. When a reference is made to a site,
it’s available to all courses and all users in the site.
Organizations usually run only one Moodle site.

A Teacher or Student account would not be able to see the Site
Administration block located on the left in Figure 1-3

v Moodle course: A Moodle course is much like a real-world
course, but online: It’s a collection of lessons, assignments,
quizzes, documents, projects, grade book, and class
discussions. An instructor constructs a syllabus, which is
posted on the course front page, and students can download
instructions, upload completed assignments, and collaborate
through wikis, chats, and online forums.

v Course front page: Refers to the course home page — it’s
your work space and where your learners come when they log
in to your Moodle course. On your course front page, you have
more tools available to you than your learners do. These
additional tools enable you to build and edit your course.

Click to toggle editing on/off

Log in/out status

O L S ey Gebeate  Jods e

for peoheesorat e

T o T W e #r3 Bt
.....

Fom €0 butd on re castes IV"“M"‘"-

Recent Activity block

Courses available to everyone who can access this Moodle site

Site Administration block Calendar block

Figure 1-3: The Moodle site front page.

. _______________________________________________________________|
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A number of settings offer the instructor controls and tools to add
content (called resources) and modules such as Wikis, Forums, and
Quizzes (called activities). The course front page is broken into
course sections by week or topic (there are other settings that enable
you to set up the course to meet your teaching requirements), and
you can add resources and activities to each section.

Figure 1-4 shows what a teacher view of the course front page looks
like without the editing features enabled. Figure 1-5 demonstrates
the same page with the editing features enabled and number of
activities and resources listed under the different sections (topics or
units).

Figure 1-4: The Teacher view of the course front page.
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Understanding
Moodle terms and
conventions

The course front page includes blocks on the left and right sides with
the center column reserved for the course content. Blocks are tools
— kind of like containers for you and your learners. For example,
you have blocks for a calendar, search box, lists of activities and
resources, participants, newsfeeds, and so on. Many blocks can have
links to various activities. By default, each course front page has
specific blocks, such as Participants, Latest News, Upcoming
Events, and Recent Activity.

When you first access your course, familiarize yourself with the
course front page. Find the Turn Editing On button, located in the
top-right corner, and click it. You see your course front page come
to life, displaying colorful editing icons, including the Activity and
Resource drop-down lists appearing in each section. A new Block
drop-down list also shows up on the right side. Explore and
familiarize yourself with what you have available.

ou are logged in as Radana
Moodle 101
T ns » MD101 @ Switch roe o [ Tum edang of |
Prople . Latest News
i i Ba
Be xde Topic outfine Bix xes
@ rarice P - -
o w5 has baen postad
[ vewsforum S X d yet)
Activit N .
Jexesas Welcome to Teach On-line Using Moodle
PN Upcoming Events
& L This 10 peek course vill teach yau the basic functionality of Moadie and how to create online e xets
a b course content to supplement traditional face-to-face courses
R Foru There are na ugeoming
ZaLessor 2 Exw
A au Flovleous 3o axe
[ Re B it X i
@ Add aresourcs | (@ Add mn acthity, v
Administration
Bextas ) m] Recent Activity
& Turn edting off e xers
B8 Guestions about the curse 8 £ X § ® st
w @ | Add o resource * (@ | Add on actviy +
M Grad
o cr
o Badk . Weak 3 m}
& st 2 Week 24 - Nathing new since yaur last
&

Figure 1-5: The editing tools are available.

Moodle uses a number of terms and specific conventions particular
to the software. In the following list, | mention and explain some of
these terms and conventions to help you ease into the book:

v' User: A specific participant who is allowed to enter a
Moodle site. Each user account has a specific role, which
carries a set of permissions.

v" Roles: Roles are user accounts identifying the participants
in the site and course. Each role has a set of permissions with
capabilities to interact with Moodle. When Moodle is
installed, it automatically creates a set of default roles —
Administrator, Teacher, Non-Editing Teacher, Course
Creator, Student, and Guest

v/ Capability: Capabilities are Moodle features. Each activity
has specific capabilities and certain roles have the
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v’ capabilities assigned to interact in different capacities with
the activities. For example, a Teacher role can post
discussions to the News forum, but a Student role can only
read a news forum and not post to or reply to it.

v' Permission: Permissions are specific settings for
capabilities. You have four options: Not Set/Inherit, Allow,
Prevent, or Prohibit.

v Activities: You can add separate, interactive learning
activity modules to your course. They are robust, and each
one can be set up to work with individual students, groups,
or everyone in the course. The Add an Activity functionality
is enabled when you click the Turn Editing On button. (See
Figure 1-5.) The drop-down list appears in each
section/week of your course. Many of the activities can be

~ graded and push information to a course grade book.

M svllabus = JF 8 X =
B L3 - P
(@ | Add aresource.. * @|Addenacihity. e
Assignmamis
Advanced uploading of files
1 = Online teod |_.|
Upload & single fle v
B Questions about the cour - I & § Offne activity &
J I =X
- = | Chat n
@ | Add 8 resource ¥ @ | choics
Dasbase
Farutr
W 2 Glossary |
2 Week 2 4 Leseon =
Ciuiz L
@ Maodla REsoife nd Publications =+ B &£ % ® & SCORKMAICT &
Survey
B creative fMoodle Hdt & X & Wik '
& Miri Project 1 o dF 6 X @ & +
!'l Aligning Research with Classroom Practice 1:1 Digital Divide, and Moodle. = Jp & X =

@ Add aresource... ¥ (@ Add an actiity.. b
Figure 1-6: The Add an Activity drop-down list

v Resources: Moodle resources are types of tools that enable
you to include almost any kind of file, including multimedia
files and links to resources on the Internet. Resources include
simple text pages, Web pages including a WYSIWYG
editor, IMS packages, and more. Like activities, you add
resources by using a drop-down list when editing is turned
on. Figure 1-7 shows the drop-down list of various
resources.

v Blocks: Blocks are container-like tools that provide specific
information or functionality. There are more than 16 types
of blocks, many of which are flexible so that you can use
them for a variety of functions. For instance, the HTML
block can display a short video on the course front page. The
Blocks block appears bottom of the right column when you
turn on editing.
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Uploading
Assignments

1

g [
¥
B questions about the course < 3t o X @ § ®
v ¥
Insert a label
o o Compoze ated page 0
> Week 24 Compose aweb page
Link to a file orweb sitz ¥
e Mandin Resairss snd Publical CiERiay & dirediory &
- Add an M5 Contert Package +
B Croative Uses of Mondle + M EX® &
foMnifroject 1 S KX @ i v
E'[ tligning Research with Classroom Practice 1:1 Digital Divide, and Moodle, & §F € X &

(@) Add arszource.. % (@) Add on actity.. ¥

Figure 1-7: The Add a Resource drop-down list

Blocks

Admin bookmarks

Blog kMenu

Blog Tags

Course/Site Descnption
Global Search

HTRL

Loan calculator
Mentees

Meszzsanes

MNetwork Servers

Online Users

Cuiz Results

Random Glossary Entry
Femote RSS Feeds
Section Links

Tags

Figure 1-8: The Blocks drop-down list
In Moodle apps window, students can upload their assignment to
submit their work online using the Moodle course page as shown

in F

igure 1-3. A Moodle course page is a collection of lessons,

assignments, quizzes, documents, projects, grade book, and class
discussions. An instructor constructs a syllabus, which is posted on
the course front page, and students can download instructions,
upload completed assignments, and collaborate through wikis,
chats, and online forums. So to upload the assignment file, follow
the steps:

Open e-learning website

Click on the ‘added assignment’

Click on “Add submission”

Select the file to be uploaded from the box at the upper left
side

Click on “Upload file”
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Quizzes, Question
Banks & Interactive
Activities

Introduction to
Moodle Quizzes and
Question Banks

TRAINING MANUAL

* Click on “Choose file” (file should be below 1MB)

* Click on “Upload this file”

* Finally click on “Save changes”

If you want to change the file click on “Edit submission”

* Click on “Choose file” (file should be below 1MB)

* Click on “Upload this file”

* Finally click on “Save changes”

When you complete the procedures, the process of sending the files
will began. Now, to be familiar with, repeat the above action once
more.

Welcome to the quizzes and question banks tutorial!

In this tutorial, you will learn how to create:

e Question banks

e Several types of multiple-choice questions

e Cloze questions

The Moodle quiz engine has been recognized as one of the most
powerful and easy-to-use open-source computer apps in the world!
Instructors can create quizzes that can be set to percentage grades,
set as pass/fail, left ungraded, or taken multiple times. Because of
this versatility, online quizzes can be used for formative and
summative assessment, practice tests for students, and other types
of interactive activities.

Moodle allows for many questions’ types, including:

e Multiple-choice—Can be set to one correct answer or
several correct answers.

e All-or-nothing multiple choice—A multiple-choice
(multiple correct) question type that requires students choose
all of the correct responses in question. This question type is
different than a standard multiple-choice question with
several answers.

e True/false—Functions like multiple-choice question, but
with only two possible choices.

e Essay—Students compose long answers to questions. Essay
questions must be graded manually by the instructor.

e Matching—Students match the question to a set of
responses either in a dropdown menu or by dragging and
dropping the answer.

e Short answer—Students type in a word. The “short answer”
can only be one word or a very short phrase that a student
would most likely word correctly.

Note: Even with an answer such as “Stop, drop, and roll,” you must
code all the possible correct answers, such as “stop drop roll,” “stop,
drop, roll” “stop, drop, and roll,” “stop drop and roll,” “stop, drop,
& roll,” “stop drop & roll” and any other possible combination that
would be considered correct. For this reason, requiring students to
type a sentence rarely works well for an auto-graded short answer
question.
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Helpful Hints Before
Getting Started
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e Cloze—Similar to the short answer question type, but cloze
questions consist of a sentence or paragraph where certain
words are removed and students must provide the missing
words.

e Numerical—Similar to a short answer question, except this
question format requires students to type in a number for the
response.

e Calculated—Similar to numerical, but the possible answer
choices are drawn from a pool.

You will need some additional image files to create some of the
question types in this module. We’ve created a zipped folder that
includes all of the files you need for this training. This zipped file
can be found on the ctYOU.org website by clicking “How to
Moodle” in the top navigation bar, and then clicking the link to the
file located under the Quizzes, Question Banks & Activities tutorial.
The zipped file contains the following images:

* barn.jpg

» color-green.png

» color-red.png

» color-violet.png

» color-wheel-outline.jpg

+ drag-and-drop-house.png

» drag-and-drop-letter.jpg

To use these files, save the zipped folder to your hard drive.
Navigate to the location where you saved the zipped folder. Right-
mouse-click on the zipped folder and then click to extract the files.
This process unzips the Moodle Quiz Tutorial folder so that you can
access the individual image files.

In addition, please remember to do the following:

» Watch the video recommended for each question type before
attempting the activity for the first time. The written
instructions will make much more sense if you watch the
video first! [J

* Questions created in a question bank do not appear in a quiz
until they’ve been moved into the quiz.

» Ifaquestion you have created does not appear in the question
bank, you may have accidentally created it in the default area
for the quiz or for the course. Check the default areas, locate
the question, and then move it to the proper question bank.

» Although you can delete questions from a quiz, be careful
about deleting questions from a question bank. If you do not
like a particular question, simply remove the question from
the quiz or edit the question.

» It is possible to import entire quizzes at one time into a
Moodle course by using tests that have been formatted in
MS-Word. This method requires users to format quizzes in
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« Word in a very specific way. For example, see the YouTube
video at https://www.youtube.com/watch?v=iLPVsqJYjzk.
The video at
https://www.youtube.com/watch?v=GsDimeannOl requires
the use of the online Moodle XML Converter located at
http://VVLEtools.com. This converter allows users to log in
using a social media account. You can locate several other
conversion tools online.
Before beginning the training, set up a separate topic area in your
course or training site and name its Moodle Quiz Training. This
way, you can create all quizzes and question types in this tutorial in
one area.

VIDEO DEMONSTRATION:

Watch this 7%-minute video to see a demonstration and
explanation of quiz categories and questions.
https://www.youtube.com/watch?v=cIxXVTHxVQVk

Note: Video demonstrations were not created by Oklahoma
CareerTech, and they may use a different version of Moodle.
However, the steps are similar to the ones you will use.

Using the Moodle Quiz activity requires specific methods for
composing questions and organizing question banks. Question
banks help you categorize your quiz questions.

Note: If you do not set up question banks before creating quiz
questions in Moodle, your questions will be saved to the default area
of your course instead of the question bank, and they often can be
difficult to locate.

Follow these steps to create a question bank and question categories:

step

Action Notes

1

2

TRAINING MANUAL

Navigate to your Moodle course
page and turn editing on.

On your course page, click the
Course Management button
and then the Question bank link.
The course management features
may be in a different location,
depending on the theme you are
using.

Click the Categories tab to
create a category for your
question bank.

On the Edit Categories tab
toward the bottom of the screen
under Add category > Parent
Category, in the dropdown menu

AMU, DECEMBER 2019

By default, there will be no categories listed on the
dropdown menu on the Question Bank page, other
than the default areas. If questions have already been
created, they will be listed in the dropdown.

Think about how you would like to categorize the
questions in your test bank. You may choose to
categorize them by unit, level of difficulty, question
type, and so forth. Each question category should
have a unique name or identifier.

Selecting the top of your course ensures the questions
can be selected easily for quizzes and tests throughout
your course.
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select Top under your course
title.

5 Type in the name of your
question bank category, such as
Sample Question Bank, and
click the Add category button at
the bottom of the screen.

6 Add other categories as needed.
When finished, make sure the
new category appears underneath
the Question categories heading
for your course.

Return to your main course page.

Remember, each question bank should have a unique
name. Oklahoma CarcerTech’s CIMC uses the
product number and unit numbers to identify question
banks, such as AG1030 Unit 01 Test. If you’d like,
add descriptive information in the Category box
(however, this is not required). Students will not see
the question bank name, so use a name that is
meaningful to you.

On the Question bank tab, make sure your new
categories appear in the dropdown menu.

Creating a Quiz VIDEO DEMONSTRATION:

Watch this 5 Y2-minute video to see a demonstration showing
how to set up a Moodle quiz.
https://www.youtube.com/watch?v=Tj3hVig_vjg

Note: Video demonstrations were not created by Oklahoma
CareerTech, and they may use a different version of Moodle.
However, the steps are similar to the ones you will use.

The following steps describe how to add a quiz or test to a course page.

Steps Actions

Notes

1 | Turn editing on for the course.

Click the Edit button in the upper left to
enable editing capabilities.

2 | Under the course topic section where the

activity link.

quiz is to appear, click the Add an

3 | On the dropdown menu that appears, click
to add a Quiz from the list of possible

activities.
4 | On the page that appears under the For example, type in the name Sample Quiz 1
General section, type in a name for the in the Name box.

quiz in the Name field.

Description box.

The Description box is a good place to type

You can type in a description in the instructions for completing the quiz or test. For

training purposes, type:

Answer all questions in the quiz. When
satisfied with your answers, click the “Submit
all and finish” button to exit the quiz.

5 | The remaining options on the page allow  Clicking the question mark icons next to these

you to set the timing, grade, layout, and so options reveals information about them. The
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forth. These features are described later in
this tutorial.

At the bottom of the page, click the Save
and display link to continue setting up the
quiz.

Click the Edit quiz button.

In the Maximum grade box, type in the
point value for the quiz, and then click the
Save button next to it.

To add a quiz question from this page,
click the Add link and choose a new
guestion from the dropdown menu.

On the popup that appears, choose the
question type, and then click the Add
button at the bottom of the menu.

In the General section under Category,
choose the category the question belongs
under.

In the Question name box, type in a
unique identifier that will enable you to
easily determine the nature of the
question, such as Sample-01-TF, which
will identify the question as a True/False
sample question.

Type in a question in the Question text
box.

In the Default points box, verify the point
value is set to 1.

In the Correct answer dropdown menu,
“True.”

Scroll to the bottom of the screen and
click the Save changes button.

Return to your course page by clicking the
title of your course in the breadcrumb at
the top of the screen.
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question behavior and review options
determine whether the quiz functions as a
practice quiz or a quiz that’s graded.

Clicking Save and display reveals a page that
shows no questions have been added to the
quiz. You also have the option to click a button
to return to the main course page.

For this exercise, enter “10” as the point value.

For training purposes, click the radio button
next to True/False.

For training purposes, choose the Sample
Question Bank category you created earlier.

Use a unique code number for each question.
For example, CIMC’s numbering system
denotes the product number, the unit number,
quiz/test, and the question number in a three-
digit format with no spaces, for example
AG1030-1T-001. Only those with rights to edit
the course will see the question name—
students will not see it.

For training purposes, type:

In the U.S., Independence Day is celebrated on
July 4.

This will display a page that lists the questions
in Sample Quiz 1. From this page, you can also
add questions to the quiz from your question
bank or other courses.
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VIDEO DEMONSTRATION:

Watch this 4-minute video to see a demonstration showing how
to add a multiple-choice question to a Moodle quiz.
https://www.youtube.com/watch?v=tsnHSRpARrU

Note: Video demonstrations were not created by Oklahoma
CareerTech, and they may use a different version of Moodle.
However, the steps are similar to the ones you will use.

The following steps describe how to add a multiple-choice question to a quiz.

Step

ACTION

NOTES

1

2

TRAINING MANUAL

From the course page, click the link for
Sample Quiz 1 that you created earlier.
Click the Gear icon and choose Edit quiz
from the menu.

This setting may be in a different location,
depending on the theme you are using.
Click the Add link in the space where you
would like to add the new multiple-choice
question, and click to add a new question.
On the popup that appears, click the radio
button to add a Multiple-choice question,
and click Add at the bottom of the menu.
At the top of the Adding a Multiple-
choice question page, verify the correct
category appears in the Category
dropdown menu.

Type in a unique question name, such as
Sample-02-MC.

You can add an image to the question, if
you’d like. In the Question text editing
box, click the Insert/edit image icon,
which depicts mountains and a sun). On the
popup screen, click the Find or upload an
image link. Click the Browse button to
locate the barn.jpg file included with zip
file for these training modules. Then click
the Upload this file button. If you wish to
rename the file, you may do so. Avoid
using spaces in the file name. Instead,
consider using dashes or underscores for
spaces between words in a file name. Type
in an accurate but succinct Image
description, and click the Insert button.

This takes you to the Editing quiz page.

For training purposes, choose the Sample
Question Bank.

Use a naming convention that is meaningful to
you—students will not see the question names.
For this exercise, adding an image is optional.
For training purposes, if adding an image, type
your school name as the author and choose
Public Domain in the dropdown menu. In the
Image Description box, type: Barn and Silo.
The best protocol for naming an image is to use
a one-word name and extension, such as
“barn.jpg.” Avoid using spaces in the file name,
such as “barn drawing.jpg.”

Accurate and concise image descriptions are
very important for web-based images, and they
are required by law for accessibility reasons.
Be sure to give proper credit to the image author
if the photo was located online or is one that you
do not own.

Do not use copyrighted images without written
permission.
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Hit the Enter key after the image to move
the cursor to the line underneath the image.
Type the question in the Question text
editing box underneath the image.

Under Default points, assign a point value.
Under One or multiple answers, select
One answer only from the dropdown
menu.

Choose whether to shuffle the choices
within the question. The Shuffle the
choices box should have a checkmark by
it.

pe in a response for each Choice box,
allowing for only one correct answer. Since
the question has only one answer, select
100% in the Grade dropdown menu for the
correct answer. Leave the grade value at
None for incorrect choices.

Under the section Multiple tries, if setting
up a practice quiz, set the Penalty for each
incorrect try to 0%.

Click the Save changes button at the
bottom of the screen when finished.

Exploring the Quiz Settings
The steps below will allow you to better understand the most commonly used Moodle Quiz

For training purposes, type in the question:

Which of the following animals would most
likely be found in a barnyard?

In this case, select 1 as the default points.
Select the multiple answers option if students
are to select more than one answer that applies.

By default, the answer choices will shuffle.
However, for “all of the above,” “none of the
above,” or “a and b only” type of questions,
uncheck this box to ensure answer choices
remain in a logical order.

For training purposes, under Choice 1, type
“rooster” (without quote marks), with the grade
of 100% selected from the dropdown menu. For
Choice 2, type “lion.” For Choice 3, type
“monkey.” For Choice 4, type “zebra.” Incorrect
answers should have the Grade set to None.
Under the section Multiple tries, if setting up a
practice quiz, set the Penalty for each incorrect
try to 0%.

This sends you back to the Editing quiz page
for your quiz.

settings.
Step Action Notes
1 | Turn editing on for the course. Click the Turn Edit On button in the upper

2

TRAINING MANUAL

Under the course topic section where the
new quiz is to appear, click the Add an
activity link.

On the dropdown menu that appears,
click Quiz from the list of possible
activities.

On the page that appears under the
General section, type in a name for the
quiz, such as Sample Quiz 2.

Section: General Field:

Display Description on course page

Most often, this box is left unchecked.

AMU, DECEMBER 2019

left.

You can type in a description in the
Description box (such as instructions for the
student).

If you check the box, the message you typed
in the Description box will appear on the
course page below the quiz name.

If you do not check this box, only the quiz
name will appear on the course page. The quiz
description will still display when the student
clicks to open the quiz.

115



10

11

12

13

TRAINING MANUAL

EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

Section: Timing Fields: Open/close the
quiz

You may set an open (start) and close
(finish) time, if you so choose. This is
not required.

Be aware that the quiz feature on your
Moodle server may use military time (a
24-hour clock).

Section: Grade Field: Grade category
Select the desired gradebook category
from the dropdown list.

Section: Grade

Field: Grade to pass

Choose the desired minimum grade.
Section: Grade

Field: Attempts allowed

Use the dropdown to determine the
number of attempts that are allowed.
Section: Grade

Field: Grading method

This option is only available if multiple
attempts are allowed.

Section: Layout

Field: New page

Use the drop-down to determine the
number of questions allowed on each
page.

Section: Question behavior

Field: Shuffle within questions

You can select Yes to shuffle the
answer choices within a question to
discourage cheating. Otherwise, you
may want to leave the layout as shown
on the screen.

Section: Question behavior Field: How
questions behave

This setting determines the way
students interact with the questions.
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When setting the timing on a quiz to open and
close for a certain class period, in addition to
enabling the times for the quiz to open and
close, also enable and set a time limit (for
example, 50 minutes).

The time on the learning management system
may be a few minutes different from the time
showing on the clock in your classroom. To
compensate for this, you may need to adjust
the quiz time in the appropriate direction by a
few minutes, or add a few minutes of cushion
to either the opening or closing time of the
quiz.

This determines the gradebook category where

the score will appear.

This sets the minimum passing grade and
affects activity and course completion.

For a practice quiz, select Unlimited to allow
students to take the quiz many times. For a test
that will count as a grade, set the attempts
allowed to 1 (or the number of attempts you
choose to allow).

If students will be allowed to go through the
quiz many times, you may want to set the
Grading method to Highest grade or Average
grade.

The New page setting determines the number of
questions per screen. Having one or two
questions per screen is typical for long tests.
The navigation menu on the course screen
allows students to view any question on the
quiz.

If you have “all of the above” or “none of the
above” type questions, choose No.

Select the choices to fit your situation.

Adaptive mode allows students to check their
answers before finishing the quiz. Adaptive
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Section: Overall feedback
Fields: Grade boundaries/Feedback text
fields

This step is optional, but recommended
to provide valuable feedback to
students.

Section: Common module settings
Field: Availability

Choose to Show or Hide the quiz. You
may change the setting at any time.

Section: Common module settings
Field: ID number

Enter an ID number if desired.

Section: Common module settings
Field: Group mode

Using the Separate groups setting,
students cannot see other students who
are not in their immediate group.
Visible groups allows instructors to
assign students to work groups, but
students see everyone in the course.

Section: Common module settings
Field: Grouping

A Grouping is a set of Groups.
Section: Restrict access > Access
restrictions > Add restriction
Fields: Activity completion

If desired, select an activity from the
dropdown list and the condition that
must be met to allow access to the quiz.
Section: Restrict access > Access
restrictions > Add restriction

Fields: Date
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mode (no penalties) allows students to guess an
answer without penalty. Deferred feedback
allows students to check their answers only
after finishing the quiz.

In the Grade boundary 100% Feedback box,
you may type in the message the student will
see when they get all of the answers correct. If
students earn below a certain percentage, you
may type in the critical percentage and the
message students will see. Multiple percentage
levels can be set.

You can also choose to make the quiz available
but not shown on the course page to make the
course site appear less cluttered. If using this
option, you must provide a link to the quiz from
somewhere else such as a Moodle page, but the
quiz still appears in the gradebook.

Setting an 1D number provides a way of
identifying the activity for grading purposes. If
the activity is not included in any grade
calculation, you may leave the 1D number field
blank.

For training purposes, use the No groups
setting.

The ability to use groups is set in the course
settings. Group settings allow an instructor to
assign students to small groups, which works
well for large classes. In addition, Groups may
be used by an instructor who teaches more than
one section of the same course during the same
semester.

This field only becomes active if you have
enabled the Group Mode setting and students
have been assigned to groups.

This set of fields ensures students can only
access the quiz after completing certain
activities.

For training purposes, leave this option at the
default.

This set of fields allows students to view and

access the quiz only during the specified
timeframe.
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You must also add the date and time
for the restriction.

Section: Restrict access > Access
restrictions > Add restriction

Fields: Grade

If desired, select an activity from the
dropdown list and an acceptable grade
range that must be met to allow access
to the quiz.

Section: Restrict access > Access
restrictions > Add restriction

Fields: User profile

Select a field and a logical condition
that must be met for the user to access
the quiz.

Section: Restrict access > Access
restrictions > Add restriction

Field: Restriction set

This allows instructors to set
restrictions within restrictions.
Section: Activity completion
Field: Completion tracking

Select the desired completion tracking
status from the dropdown list.

Section: Activity completion
Fields: Require view, Require grade,
Require passing grade

Click the appropriate boxes to enable if
you are tracking completion with the
system in any of these ways

Section: Activity completion
Field: Expect completed on

If you check the Enable box for this
field, you must also enter an
appropriate date.
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For training purposes, leave this option at the
default.

These fields allow you to specify any grade
conditions from other parts of the course that
must be met prior to accessing the quiz.

You may set multiple grade conditions. If you
do, students can only access the quiz after
meeting all grade conditions that you specify.

You can restrict access to the quiz based on any
field from a user’s profile.

This setting is recommended only for
experienced Moodle users.

The user will see a checkmark next to the
activity name on the course page when the
activity is complete, if tracked.

Activity completion can be tracked manually by
the student, automatically based on certain
conditions, or not at all.

Multiple conditions may be set. If so, the
activity will only be considered complete when
all conditions are met.

For training purposes, do not indicate activity
completion.

These conditions can be used if completion
tracking is set as “Show activity completion
when conditions are met.”

You can check one, both, or none of these
items. Based on the items checked, the quiz will
be marked complete only when the student
views the quiz or the quiz is graded.

This field specifies the date when the activity is
expected to be completed. The date is not
shown to students and is only displayed in the
activity completion report
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Click Save and display at the bottom of
the page.

On the next screen, click the Edit quiz
button.

Click the small Add link to add a
question to your quiz, and click a new
question on the menu that appears.
Click the radio button next to Multiple-
choice question, and click the Add
button.

Under the General settings, click the
dropdown menu to ensure the category
for the course is selected for this
example.

Type in a question name using the
previously determined naming
convention.

Type the quiz question in the Question
text editing block.

Make the appropriate selection in the
One or multiple answers dropdown
menu.

In the Choice 1 box, type in the first
correct answer and select 50% as the
grade for a question with two correct
answers (33.33% for a question with
three correct answers, 25% for a
question with four correct answers, and
so forth).

In Choice 2 box, type the second
correct answer and select 50% as the
grade for a question with two correct
answers (33.33% for three correct
answers, etc.).

n Choice boxes 3 and 4, type in the
distracters and set the grade for the
incorrect answers to None.

Set the other features to suit your
preference, and click the Save changes
button at the bottom of the screen.
Preview the new multiple-choice
question by clicking the magnifying
glass icon.

AMU, DECEMBER 2019

The link has now been created from the course
to the quiz.

A popup window will appear on which you will
select a new question, in this instance.

The multiple choice question type assigns
partial credit in “multiple correct” questions if
the student chooses some but not all correct
responses. If you want students to select all
correct responses with no partial credit given
for only selecting some of the correct responses,
choose the All-or-nothing question type.

For training purposes, type: Sample-03-MC.

Compose a question that has two correct
answers. For training purposes, type: Which of
the following are major cities in Kansas?
Since this question will have two correct
answers, select Multiple answers allowed.

For training purposes, type Wichita and select
50% as the grade.

For training purposes, type Topeka and select
50% as the grade.

Under Choice 3 and 4, type Cleveland and
Denver as distracters, and set the grade for the
incorrect answers to None.

Your new question now appears in the default
question bank for your course.

Notice the answers have been randomized.

Clicking the Fill in correct responses button
verifies you formatted the answers correctly.
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40 | Verify that all three question created so
far appear in the Sample Question
Bank. To do so, click the Course
Management button and then the
Question bank link.

41 | On the page that appears, select the
Sample Question Bank category from
the dropdown menu, and check to see
how many questions are in the question
bank.

42 | Now, select the Default for your course
from the category dropdown menu, and
check to see how many questions are in
the default question bank for your
course.

43 | To move any stray questions to the
Sample Question Bank, click the
checkboxes to the left of the
question(s).

44

Under the With selected heading,
choose the Sample Question Bank from
the dropdown menu, and then click the
Move to button.

This places the questions in the Sample
Question Bank category. Notice that the
number in parenthesis after the category name
shows the number of questions in that category.

45 | Return to the course page and click the
link to the new quiz (in this case,
Sample Quiz 2).

46 | On the page that appears, click the gear
icon, and then click the Edit quiz link.
47 | Click the Add link and click from
question bank in the dropdown menu,
and choose the Sample Question Bank
from the dropdown menu.

48 | Click the checkbox next to the
questions you wish to add to the quiz,
and then click Add selected questions
to the quiz.

You can also navigate to your course default
questions.

The questions remain in the question bank and
can be used in multiple quizzes.

Remember, if you want to require students to select all of the correct responses in a multiple-
correct question, choose the All-or-Nothing question type.

Note: The All-or-nothing question type is a Moodle plugin, and you may need to request that your
server administer install it.

Advanced Question
Type: Cloze
Questions

VIDEO DEMONSTRATION:

Watch this 11-minute video to see a demonstration and
explanation of the Moodle cloze question type.
http://www.youtube.com/watch?v=shK7fyh3_Rw

Note: Video demonstrations were not created by Oklahoma
CareerTech, and they may use a different version of Moodle.
However, the steps are similar to the ones you will use.
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Creating a Cloze Question with One Answer
Follow the steps below to create a cloze question with one answer choice.

A cloze question can be fill-in-the-blank, multiple-choice with a list
of possible answers, numerical, or a combination of multiple cloze
question types all in one question. Although effective, cloze
questions are used less frequently because the answer choices
require special coding. Don’t let this prevent you from using this
type of question—cloze questions are easy to code!

Step Action Notes

1 | To add cloze questions to an existing question The location of this link may vary,
bank, at your course home page on the Course depending on the theme on your
Management button, click the Question bank Moodle site.
link.

2 | On the Question bank page, make sure the correct  For training purposes, select the
category appears in the dropdown menu, and then ~ Sample Question Bank you created
click the Create a new question button. earlier.

3 | From the popup window, click the radio button
next to Embedded answers (Cloze), and then
click the Add button.

4 | Type in a question name using your previously For training purposes, type: Sample-04-
determined naming convention. C.

5 | The cloze question format requires a little bit of For this example, start with a cloze
programming code (see the example in the column  question that requires a one-word
to the right). answer. For training purposes, type the
In the Question text editing box, along with the following sentence exactly as follows:
question, add the following code: This quiz question demonstrates the

* an open squiggly bracket { {1:SA:=cloze} question type.

» the number of points the question is worth

* acolon As noted in the code, the answer to the

» SA (or singleanswer spelled out with no above single-answer, 1-point question
spaces; this is the question type) is the word “cloze.”

* acolon

* anequal sign The question coding is case sensitive.

» the answer

» aclosed squiggly bracket }

6 | Click the Decode and verify the question text If you typed something incorrectly, you
button to check your coding. will see a red error message.

7 | Click the Save changes button at the bottom of the
page if the question was coded correctly, and return
to the Question bank screen.

8 | Click the magnifying glass icon next to your
question to view it.

9 | When viewing the question, click the Fill in

TRAINING MANUAL

correct responses button to ensure the question

and answer were typed correctly.
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10 | On the Question bank page, click the checkbox to  As you may have noticed, the name of
the left of the question and move it to the Sample  questions that have not been assigned to
Question Bank, if necessary. a question bank appear light gray in

color.

Creating a Numerical Cloze Question with Several Answer Choices

Step Action Notes
1 | From the Question bank screen, click the Create =~ Make sure you are in the correct
a new question, choose Embedded answers category for your quiz.

(Cloze), and then click the Add button.
2 | Name the question according to your established For training purposes, name the

naming convention. question Sample-05-C.

3 | Type your question in the question editing box. For training purposes, type the
When typing in the code, separate the answer following sentence exactly:
choices using a tilde symbol (~). An equal sign
designates the correct answer. If an item is “free,” the cost is

{1:MCV:$100~$1~=$0~$25}.
The multi-answer cloze question type uses the
following abbreviations for question types:
e MCV — multiple-choice vertical (displays
choices vertically)
e MCH — multiple-choice horizontal (displays
choices horizontally)
e MC - dropdown box (displays choices in a
dropdown box)
e NM — numerical answer
4 | Click the Decode and verify the question text If you typed something incorrectly, red
button to check your coding. text will appear.
5 | Click the Save changes button if the question was
coded correctly, and return to the Question bank
screen.
6 | Click the magnifying glass icon next to your
question to view it.
7 | When viewing the question, click the Fill in
correct responses button to ensure the question
and answer choices were typed correctly.
8 | Make sure the question appears in the correct If it is not in the question bank, move it
question bank. at this time.

Creating a Multiple-Answer Cloze Question
Follow the steps below to create a cloze question with multiple answers in a question bank.

STEPS ACTIONS NOTES
1 On the Question bank page, click For example, use the Sample Question Bank
the Create a new question button, you set up earlier.

choose Embedded answers (Cloze),

and click the Add button.

2 Name the question according to your  For training purposes, type Sample-06-C.
established naming convention.
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Type in the question code text in the
editing box. Use the following
abbreviations to designate question

types:

e MCYV — multiple-choice vertical

e MCH — multiple-choice
horizontal

e MC — dropdown box

e NM — numerical answer

Click Decode and verify the

question text to check your coding.

Click the Save changes button if the

question was coded correctly, and

return to the Question bank screen.

Click the magnifying glass icon next

to your question to view it.

When viewing the question, click the

Fill in correct responses button to

ensure the question and answer

choices were typed correctly.

Make sure the question appears in the

correct question bank.

For training purposes, type the following:
Ears of corn grow on a:
{1:MCH:stock~=stalk~stick~stump}.

The hierarchical rank of organisms is
Kingdom, Phylum, {1:SA:=Class}, Order,
Family, Genus, {1:SA:=Species}.

Poison oak usually can be identified by
the number of leaflets. As the saying goes,
“Leaves of {1:NM:=3}, let it be.”

If you edit a previously saved multiple-
answer cloze question, under the heading
The Question Will be Saved as Edited, click
to confirm you want to resave the question.
If it is not in the question bank, move it at
this time.

Note: The cloze question type can be used to create a unit review. Consider using longer passages

of text!

Google Classroom
for e-learning

Moodle requires a server for hosting our lessons but google classroom
solves this problem through cloud hosting.

Classroom

by Goog[e
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Introduction

Google  Classroom
Workflow

Signing into Google
Classroom

TRAINING MANUAL

Google Classroom integrates Google Docs, Drive, and Gmail in
order to create and collect assignments in a paperless environment.
By utilizing Classroom, you can create assignments for one or
multiple classes, and assign the assignment to each student or a
group of students. As a teacher, you can view who has or has not
completed assignments, provide feedback during and after
assignments, and assign grades. In this section you will practice
Signing into Google Classroom, Creating a Class, Changing a Class
Theme, Adding a Teacher Photo to the Class, Renaming or Deleting
a Class, Adding a Class Resource Page, Adding Student by Class
Code, Removing Students from a Class, Resetting the Class Code,
Creating an Assignment, Viewing an Assignment, Grading and
Returning an Assignment, Changing a Grade, Posting
Announcements and Adding and Deleting Comments.

1. Teacher creates assignment and attaches one or all of the
following:

v File(s)

v" Google Drive ltem(s)

v" Video(s)

v Link(s)
2. Teacher chooses to send the assignment to each individual
student, a group of students, or to the whole class along with
privileges: Edit or View.
3. Student receives a notification that an assignment is due.
4. Student turns in the assignment and loses editing privileges once
assignment is turned in.
5. The teacher edits the document to grade the assignment, returns
it to the student with feedback when necessary.
6. Student receives document with grade and has gained editing
access again to write comments.

Note:

(1 Both the teacher and students can see the list of pending and
completed assignments.

[1 The teacher can see all grades for an assignment

[J Students can see their own grades for completed assignments.

1. Type the following web address: http://classroom.google.com
2. Enter your email and password.

Note: Classroom is only available for Google Apps for Educations
users, so you cannot sign into Classroom with your personal Google
Account.

3. Click TEACHER. The Welcome to Classroom page opens.
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Creating a Class

4. Click SEE HOW CLASSROOM WORKS for a guided tour of
Classroom. To take the guided tour at a later time, Click the three
horizontal lines in the upper-left corner, and select Help.

1. Click the + icon in the upper-right corner.

2. Click Create Class

Create class

Join class

3. Type a Class Name and Section descriptions such as Section,
Grade Level, or Class Time.

Create a class

(2

CAMCEL

SN

. The Created Class will now appear.

Test Class Math

UPCONING ASSIGNMENTS

o g sssepvrents
B wcecenent [ wsgmen

LA tone Welcome to your class!
Doyou want o take & tour 10 learm more?

STARTTOUR

TRAINING MANUAL
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Changing the Class
Theme

Adding a Teacher
Photo to the Class

5. As classes are created, you can navigate and view any class by
clicking the three horizontal lines in the upper-left corner.

-l

Home

Test Class Math

FPeriod 5

Test Class ELA1

Period 1

You can choose a theme (image) that will be displayed for the class
in the stream. To change the image:

1. Open the class and click Change Class Theme in the lower-right
corner of the image.

2. Select an image from the gallery and click the Pick Course
Image button.

You can also display a profile photo next to your name in both the
class stream and on the class card on the home screen.
1. From Google Drive, Click on your Account Name.

“margie  HE QO sna SR

This account is managed by mivsc.k12.in.us
Learn more

Margie DeCraene
mdecraene@mwvsc k12 in.us

o™

Change photo Vieww profile

‘ Add account Sign out

Account Privacy

TRAINING MANUAL
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2. Click on Change photo.

3. Drag or Upload a photo.

4. Click Set as Profile photo.
Select profile photo

I Upload photos
Your photos
Photos of you

Web camera

[

R
Drag a profile photo here
Renaming or From the home screen, you can rename or delete a class using the
Deleting a Class menu icon (three vertical dots) in the upper-right corner of the class

card:

(] To rename a class, Click the menu icon and select Rename.
Enter a new name and click SAVE.

[J To delete a class, Click the menu icon, select Delete, and click
DELETE.

Rename

Test Class Math : [rest Class Math

Period 5

UPCOMING ASSIGNMENTS

No assignments

CANCEL
L

Warning: There is no way to undo deleting a class. If you click
DELETE, you will no longer have access to any class posts or
comments. However, you can still access class documents on

Google Drive.
Adding a Class Once you've created a class, you have the option to add a resource
Resource Page page for the class for your students. A resource page may consist of

helpful documents, videos, images etc. that will help your students
while they are in the classroom. For example, if you created an
English Language Arts Class, you may add documents on writing a
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poem, analyzing a story, videos explaining certain types of poems
etc.

1.From the Home page, Click the class to which you want to add
the resource page.

Home

Test Class Math

Period 5 | Click a class |

Test Class ELA 1
Period 1

2. At the top

Test Class Math

Period 5

of the page, click ABOUT.

STUDENTS

3. You will now see the following:

|Tit!e (optional)

Class description (optional)

Room Where does the class meet? (optional)

Teacher email B  @mvscki2inus

Google Drive folder [l Test Class Math Period 5

4. You can add a title for the page and a description of the class by
hovering over those fields.

5. You can add the Room location of the Class and type where the
class meets.

Note: If you choose to leave this field blank, it won't appear in the
student view of the page.

TRAINING MANUAL
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Adding Students by
Class Code

TRAINING MANUAL

Your email address and the Google Drive folder are automatically
included in the overview and can't be changed.

6. Click Add resources box to attach additional resources to the
overview.

|Tlt|€

b @ O « CANCEL POST

7. Type a title for your resources then select your attachment.
Attachment options include a file from your computer, a Google
Drive item, a YouTube video, or a link to a webpage. You can add
multiple resources under a single title or add them separately under
their own titles.

8. Click Post, when you're done. Click stream to go back to the
main classroom page.

Note: You can always edit the resource page by following the same
steps. If you choose not to add a resource page, the ABOUT link at
the top of the class stream will not appear for students.

1. Sign in to Classroom at https://classroom.google.com
2. Click on the Class.

€« > C [ httpsy/classroom.google.com,

i35 Apps (] Imported FromIE 9 Settings Learn WordPress.com () Region14 ESC | Blended Learning W

m Click on a class. -

Test Class Math g Test Class ELA 1

Period 5 Period 1

0 students 3 students

UPCOMING ASSIGNMENTS UPCOMING ASSIGNMENTS

No assignments English Quiz Sample B
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Removing Students
from a Class

TRAINING MANUAL

3. The class code is on the left of the stream.

STREAM N

UPCOMING ASSIGNMENTS
No upcoming assignments
. Announcement E Assignment

CLASS CODE Welcome to your class!

Do you want to take a tour to learn more?

* STARTTOUR
vbosfiy

4. Share the Class Code with students by:

[J Send an email to students with the class code.

[J Post the class code as an announcement on the class stream.
[1 Write it on the board in your classroom.

5. The Class Code can also be obtained by clicking on the Students
tab. It will be below the Invite button.

STUDENTS

INVITE REMOVE EMAIL CLASS CODE  vbosfiy ~

Invite students, or give them this code so they can oin: VDOSfily

6. Give the students these instructions:
= Sign in to Classroom at https://classroom.google.com.
= On the Home page, click the + icon.
= Enter the code that | gave you in the box and click JOIN.

At any time, a teacher can remove a student or several students from
a class.

To remove a student:

1. Sign in to Classroom at http://classroom.google.com.

2. Click the class from which the student should be removed.
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& = C [ nhttps:/classroom.google.com,
i Apps [ Imported FromIE 3 Settings Learn WordPress.com ) Region14 ESC | Blended Learning W

m Click on a class. -

Test Class Math g Test Class ELA 1
Period 5 Period 1

0 students 3 students

UPCOMING ASSIGNMENTS UPCOMING ASSIGNMENTS

No assignments English Quiz Sample B

3. Click on Students.

Test Class ELA T

Period 1

STREAM STUDENTS ABOUT

4. Check the box or boxes next to the student(s) you want to
remove.
5. At the top of the page, Click REMOVE.

INVITE { REMOVE \> EMAIL CLASS CODE  24piTx

D Students

b ) .
& ;‘,_ Barbie Laski Invited
L
e Brian Snelson

@ Cole Carr

D @ John Gaydula
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6. The dialog box appears with the question: "Are you sure you want
to remove or uninvite the following student?" and shows the
student's name.

Remove students?
Are you sure you want to remove the following students from the course?

* Brian i m@myvsc.k12.in.us)
* Cole | @mvsc.kl2in.us)

7. Click REMOVE to remove the student from the class.

Resetting the Class You have the option to reset or disable the class code by clicking the
Code code itself to access the drop-down menu. This can be accessed from
either the Stream or the Students Tab.

Stream Tab

1. From the Stream Tab, click the arrow down button located by
the code.

2. Choose Reset to obtain a new Class Code.

3. Choose Disable to eliminate the Class Code option.

Note: Once the Class Code is enabled again, it will automatically

irovide a new Class Code.

Share with your class.

UPCOMING ASSIGNMENTS
No upcoming assignments.
B announcement [ Assignment
GLABSCO0E Welcome to your class!
Students can join the class Doy! tour
with this code T TR
vbosfiy ~
Reset
Disable
Students Tab

1. From the Students Tab, Click on the arrow button located by
the Class Code.

2. Choose Reset to obtain a new Class Code.

3. Choose Disable to eliminate the Class Code option.

. _______________________________________________________________|
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Creating
Assignment

EFFECTIVE ENGLISH LANGUAGE TEACHING THROUGH ICT

an

Note: Once the Class Code is enabled again, it will automatically
provide a new Class Code.

STREAM STUDENTS ABOUT

CLASS CODE | wncfeTx

Invite students, or give them this code so they can join: wnefe7x

You can create an assignment in your class stream, attach materials
to it, assign it to one or more classes, and grade and return it to
students.

To create an assignment:

1. Sign in to Classroom at https://classroom.google.com.

2. Select a class.

€& > C { nttps://classroom.google.com,
232 Apps (] Imported FromIE 9 Settings Learn WordPress.com E) Region14 ESC | Blended Learning W

Test Class Math Test Class ELA 1
Period 5 Period 1

0 students 3 students

UPCOMING ASSIGNMENTS UPCOMING ASSIGNMENTS
No assignments English Quiz Sample B
[ | [
3. Click A53|inment at the toi of the stream.
UPCOMING ASSIGNMENTS e yeurchs
No upcoming assignments.
R

Welcome to your class!
1 join the class Do you want to take a tour to learn more?

STARTTOUR

TRAINING MANUAL
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4. Enter the title of the assignment, and instructions in the
Description area.

5. The assignment is due the next day by default. Click on the date
to select a different date from the calendar.

6. If you want the assignment turned in before midnight on the due
date, click Add time to set the time at 11.59 pm. Or, Click again to
select a time from the drop-down list.

7. Add other attachments to the file as needed to help students
understand or add motivation to the assignment:

Qriie(s)

Google Drive item(s)

aYﬂuTuhE Video(s)

aLink{s}
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8. To attach a File, a Google Drive item, a YouTube video, or a link,
Click the appropriate icon.

9. To attach a File, Click the paperclip icon. This will enable you
to:

@ Upload files from your computer that exist on your desktop, documents, etc.

@ Upload files from your Google Drive.

© Upload files from your Google Drive that are starred.

Or, Click the Google Drive icon to upload files from Google Drive.
Click Add.

If you attach a Drive item, and after you Click Add, you have a few
options on how the student can interact with the item. You set the
appropriate option by clicking the Students can view file drop-
down menu next to the attached item.

1. Select Students can view file if you want all students to read, but
not change, the same file.

2. Select Students can edit file if you want all students to make
changes in the same file.

TRAINING MANUAL
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3. Select Make a copy for each student to provide an individual
copy of the file for each student.

Due  Sep2 2014 11:59PM X

2014-ELA’ Test ’Students canviewfile v | X
Google Docs

y

Students can view file
ADD
Students can edit file

Make a copy for each student
@J & D oo TestClassMath v

. Announcement [B] Assignment

10. To attach a YouTube Video, Click the icon with the arrow.
11. Type your topic or partial name into the Search Filed and Click
the magnifier. Or if you know the URL for the YouTube video,
Click URL and then type or paste the link in the URL field.

Insert video
| B vt Youl@D [1 | =
URL
Type your search in the box above to find videos.
s | e
Click Add.

12. To attach a link to a website, Click the Link icon.

. _______________________________________________________________|
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Type the website or paste it into the field and Click, Add.

Note: If you decide that you don't need the attachment, click the X
button on the right of the attachment to delete it from the assignment.

13. If you want to give the assignment to another class, Click the
class name drop-down menu and select any additional classes.

Title of assignment

Description of assignment (optional)

Due  Aug30,2014  Addtime

After you specify the assignment details, click ASSIGN to send it
to students.
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Viewing an
Assignment

TRAINING MANUAL

To access students’ assignments:
1. Sign in to Classroom at classroom.google.com.
2. Open the class and click the assignment in the class stream.

ASSIGNMENT 4ug 27 DUESEPS :

| Story Star for The Lightning Thief
Use the Story Star Template to analyze the story and theme of the book: The Lightning Thieft
Use the following link to help you recall how to analyze a story! Watch the trailer (video clip) for
basic recall.

DONE NOT DONE
Copy of Story Star Each student will get a copy
Google Docs

Percy Jackson & the Olympians: The Lightning Thief HD Movie Trailer
YouTubevideo 2 minutes

!!;

Analyzing Novels & Short Stories | University Writing Center
http //writingcenter tamu edu/2005/types-communication/academic-writing/analyzing-novels-short-stones/

i
il

i

. Copy of Story Star
= Google Docs
4

“ Add a comment..

3. The Student Submissions page shows the current status of the
students’ work on this assignment. You can see if a student has
started the assignment and review any work in progress (any files
the student added to the assignment). You can also see which

students have comileted the assiinment imarked as DONEi.

Assignment: Story Star for The Lightning Thief DUESEPS
RETURN EMAIL & FOLDER ¥ DOWNLOAD
O Student Status Grade  Poits 100  ~
O ’ Brian s""“" 7 - NOT DONE No Grade
O 0 Cole Carr | DONE No Grade
O . J°"" ‘?‘Y‘“‘ NOT DONE No Grade

Note: If you chose to create a copy of a Google Drive item for each
student in the assignment, the copy is created and appears on the
Student Submissions page when the student opens it. You can review
the work in progress, comment on it, and give feedback to the
student before the work is submitted. The file submitted back to you
will also automatically be name with the same Title but will also
include the student’s name on the file.
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If you don’t see an attachment on the Student Submissions page
under a student’s name, it means the student has not opened the
Google Drive item or attached a file, and there is nothing for you to
review.

4. To open all of the students’ assignments at once, click the
FOLDER button to open the Google Drive folder where all of the
work is stored. Click any item in the folder and begin reviewing
the student’s work.

5. You can view an individual student’s work by clicking the
student’s name and then the item. You will be taken to your Google
Drive and be able to view all the students’ documents within the

already created assignment folder.
B Test Class 1Period 1~ +

I Engish Quiz Sample B
I Story Star for The Lightening
[ Templetes - DONOT EDIT

1 oy o for e Liering Tl » 0 mu
Wy Orwe » Cosmnon » Toat Oua t Pernt 1 0 Story Star for Tha Lighaeesng et
ma OANER LASTHOCFED
| [ Story Star - Bran Sowlicn svwer Bnan Snalscn 1057 e s
3 Story Star - Cola Cow svree ™ 1030

6. You can edit or comment right in any document on Google Drive.
Simply Click on Comments make any comments and close the
document. g -

& Editing -
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7. It's automatically saved and ready for the student to review when

they open the document again.
Percy Jackson: The Lightning Thief

Pirections: Use the following Story Star to anlyze ‘the theme and story of Percy
Jackson's The Lightning Thief!

Complete the chart below double-clicking on the drawing and writing over the prompts!
Remember to use complete sentences!

x Margie DeCraene
1:03 PM Today

Cole, Please redo this assignment as
hargreid itis incomplete

8. You can also view who has or has not submitted an assignment
by Clicking on the Assignments Tab, and Clicking on Done or Not

Done.
Aasigment:Sory ta for The Lighning Tt -
wHaNET oy I
Story Star for The Lighting Thiet 2 1
L we NOTOONE
[ )
-7 z‘::‘h ok skaberd wil i
! Buerp s L e by The Ligvwn Thad ) oee.
Toulite nom I rowin
T T amtrgnenn ot e ety sy
T omeinmye
g ey
-
.-l“.
Asogament ey St for T Lipenng 247 Agsipment Story Starfr The Lightning Thif .
. @ow @ oom B om0 n [ FOOER & DOWMOAD
- - |
U.."-" ATINED sl 0100 0 e - ™
o @= S5T806D m #10 o @ o o

. _______________________________________________________________|
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Grading and 1. Sign in to Classroom at https://classroom.google.com.
Returning an 2. Open the class and Click the assignment in the class stream.
Assignment STREAM STUDENTS ABOUT

Click the
Assignment

DUE SEPS

3

DONE NOT DONE

| Story Star for The Lightning Thief

Use the Story Star Template to analyze the story and theme of the book: The Lightning Thief!

Use the following link to help you recall how to analyze a story! Watch the trailer (video clip) for
basic recall

Copy of Story Star
Google Dot

Percy Jackson & the Olympians: The Lightning Thief HD Movie Trailer
ouTube video 2 minutes

Analyzing Novels & Short Stories | University Writing Center
writ enter ta edl 05 /types-cor Nication/acaden ting/analyzin

Copy of Story Star

3. The Student Submissions page lists the students who have
completed this assignment.

ASSIGNMENT DETAILS ASSIGNMENT STATUS

Assignment: Story Star for The Lightning Thief DUESEPS
& FOLDER ¥ DOWNLOAD
D Student Status Grade Points 100
D e Brian Snelson NOT DONE No Grade
D @ Cole Carr DONE No Grade
El @ John Gaydula NOT DONE No Grade

4. To grade an assignment, Click No Grade which is on the same
line as the student’s name.

The default point value for an assignment is 100. To change this,
Click the Points drop-down menu on the right and select the point
value for the assignment, or Click the number and enter a new
number.

Note: Only whole number grades are supported at this time. You
cannot enter a letter grade or a decimal point.
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5. Enter the grade in the box.

6. Enter grades for any additional students.

Warning: The grades that you enter on this page will not be saved
unless you return the assignments to the students.

7. Check the box next to the student or students whose grades you
want to return.

If you want to return an assignment without assigning a grade,
simply skip the grading steps above and just check the box next to
the student or students.
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8. Click the RETURN button.

Assignment: Story Star for The Lightning Thief DUE SEP
ﬁ EMAIL & FOLDER & DOWNLOAD
0O Student Status Grade  Points 100~
' Brian Snelson NOT DONE 0/100
Not Retuned
0 it DONE Aug 29, 12:45 PM 75/100
See submission history Not Retumed
B story Star- Cole Carr
‘ Add a comment.
O . John Gaydula NOT DONE No Grade

9. A dialog box appears showing the student’s name and the grade
awarded. Click RETURN.

Return unsubmitted assignment?

Some of these assignments aren't done yet. Are you sure you want to return them?

CAMCEL 0K, GOTIT

10. Add any additional feedback in the box and click RETURN.

Return assignment?

When you retum this assignment, the student will be able to edit the returned files and you will be able to comment on
them.

Feedback for 2 students

Please do this assignment again and return by September 7, 201 41

CANCEL RETURN ASSIGNMENT
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11. On the student submissions page, a message tells you that the
assignment has been returned. The list on the page is updated to
show the student’s work which you graded and returned.

Assignment: Story Star for The Lightning Thief PLESEPS
m @ FoER ¥ DOWNLOAD
0 Student Status Grade  Points 100
° Brian Snelson
0 RETURNED Aug 29 0/100
0 o Cole Car RETURNED Aug 28 75/100
0 . John Gaydua NOT DONE No Grade

12. After you click RETURN, the student receives an email telling
them that you've returned their grade. Also, the student regains edit
access to any Drive items that were part of the assignment.

From: (Classroom) [mailto:no-reply+62609d5d@classroom.google.com] aNed | Blast
Sent: Friday, August 29, 2014 2:50 PM
To: Cole

Subject: Your "Story Star for The Lightning Thief" assignment was returned

Margie returned your "Story Star for The Lightning Thief"
assignment.

Grade: [75/100]
View the assignment:
hittp://classroom.google.com/c/MTUINDY2NFpa/a/MjczNiM1MLpa

You are receiving this email because you are signed up for Test Class ELA 1. Click to unsubscribe from these emails:
http://classroom.google.com/s

Google Inc., 1600 Amphitheatre Pkwy, Mountain View, CA 54043 USA

Changing a Grade 1. Sign in to Classroom at classroom.google.com.
2. Open the class and click the assignment in the class stream.
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STREAM

Click the
Assignment

ASSIGNMENT -.2 77 CUE SEPS :
[ Story Star for The Lightning Thief 3
Use the Story Star Template to analyze the story and theme of the book. The Lightning Thieft
DONE NOT DONE

Use the following link to help you recall how to analyze a story! Watch the trailer (video clip) for

basic recall

Copy of Story Star

- Each student will get a copy
00qie Docs

Percy Jackson & the Olympians: The Lightning Thief HD Movie Trailer

YouTube video 2 minutes

=" Analyzing Novels & Short Stories | University Writing Center

1tp //writingcenter tamu edu/2005/types-communication/academic-writing/analyzing-novels-short-stones

Copy of Story Star

Google Docs

y

‘ Add a comment

3. The Student Submissions page lists the students who have
completed this assignment.

Assignment: Story Star for The Lightning Thief DUz sERS
& FOLDER ¥ DOWNLOAD
0  student Status Grade  Points 100
D e Brian Snelson RETURNED A2 0/100
0 @ (ol Car RETURNED Avg23 75/100
D @\ John Gaydula HOT DONE Ho Grade
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4. Click on the grade of the student whose grade you want to

change.
INER 50 740 DI/ / Al
0 S an RETURIED Aug 23 245l (75/100 /!
See submission history

Edit grade

& Story Star- Cole Car

Margie DeCraene 24271/

Please do this assignment again and retum by September 7, 2014,

5. Click the Points drop-down menu on the right and select the
point value for the assignment. Or, Click the number and enter a
new number.

6. A dialog box appears showing the student’s name and the grade
awarded, and states that the student will be notified that their grade
has changed.

Change Cole Carr's grade?

ICG|E Carr will be notified that their grade has changed. I

Cd D
@ Feedback for Cole Carr

CAMCEL UPDATE

7. Click UPDATE.

8. On the student submissions page, a message tells you that the
grade has been updated. The list on the page is updated to show the
student’s new grade.

ASSIGNMENT DETAILS ASSIGNMENT STATUS

Student grade updated.

. _______________________________________________________________|
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You can post announcements in your class stream at anytime to add
guidance, feedback, motivation, humor etc.

1. Sign in to Classroom at http://classroom.google.com

2. Select the class to open the stream.

Home

Test Class Math d
I Click a class |

Test Class ELA 1

3. Click Announcement or just Click in the text box at the top of
the class stream.

Share with your class

Ao

ASSIGNMENT 2.5 29 DUEAUG30

Rounding Decimals to the Nearest Tenth 0 1
Open the Document labeled: rounding_decimals (1) pdf as this will contain your problems. Then

open the document labeled Rounding Decimals Answer Key Use the Rounding Decimals 1one NOT DONE
Answer Key to type your answer in the spaces and then retun back to the teacher. Use the
attached link for help if you need it.

Google Docs Each student will get a copy

4. Enter your announcement.

Enter announcement
within this field.

I & O oo TestClassMath Period5 v CANCEL

- Announcement E Assignment

TRAINING MANUAL
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5. To attach a file from your computer, Click the appropriate
icon(s).

Q-5
Google Drive item(s)
e‘fouTube Video(s)

OLinkl[s]

0000
LK

Test Class Math Period 5 v CANCEL

- Announcement E Assignment

6. Locate and select the relevant item and click Add. If you attach
a link, you enter the relevant link text and click ADD. When you
add the item, it appears in the announcement.

Insert wdea

3.,..

[ ==
Check cut this new way to muitiply karge numbers l
_,s/.,..,..,,.,cm..p, i
ubsvideo 3 es

B © . = Test Clasatiath Period 5 Ersica =

Note: If you decide that you don't need the attachment, click the X
button on the right of the attachment to delete it.
8. If you want to share the announcement with another class,
Click the class name drop-down menu in the lower-right
corner and select any additional classes.

. _______________________________________________________________|
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Adding and Deleting
Comments

Il & D« EstCIassMatheriodﬁv CANCEL

Test Class Math

. Period 5
. Announcement E Assigrment

l:l Test Class ELAT

Period 1

8. Click POST when you're done.

9. If you decide that you don't need to post the announcement or you
want to edit the announcement, Click the three dots to the right of
the announcement. Choose from the following: Edit or Delete.

ANNOUMCEMENT 1.21 FIM m

Check out this new way to multiply large numbers

Edit

Delete
Multiplication tips
YouTube video 3 minutes
g Add a comment...

Anyone in the class can add a comment.
1. Click the Add a comment box, enter text, and Click POST.

ANNOUNCEMENT :21 P

Check out this new way to multiply large numbers

Multiplication fips
YouTubevideo 3 minutes

0 )

Enterted
g | enjoyed this videi CANCEL POST

2. All comments are visible under the announcement in the stream.
Note: As the teacher of the class, you can delete any inappropriate
comments.

3. Click the menu icon (three vertical dots) in the upper-right
corner of the comment and Click Delete.
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How to Create a
Google Group
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NGEG
Heo gz, -

Vi3l 2s[R00 <7 T !
e BlSU 20600 721, — :

» A google group is a free online group where people get
together to share issues of interest.

» A Google Group is an email list or forum.

P Teachers’ can create a google group with their colleagues to
share issues of professional interest or may be social interest
too.

» Most importantly, teachers’ can create a google group with
their students to share ideas, announcement, files, tasks, etc.

To create your group:
1. Open the Google Groups website. Go
to https://groups.google.com/ in your computer's web browser.

This will open the Google Groups creation page.

about:blank X <+
[

SN dhttps://groups.google.com/‘

2. Sign into your Google Account if necessary.
» If you aren't signed into a Google Account, click the
blue Sign in button in the top-right corner of the page, then
enter your Google Account's email address and password.

T

20 - o I

3. Click CREATE GROUP. It's a red button in the upper-left
side of the page. Doing so opens a new group form
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B Inbox (927)- M: temari a How to Create 2 Google Grot @ aeating a google group - Go F\ Google Groups

C @

Go g|e Search for qroups or messages n i 9
Groups L %

My groups

e My groups ‘
Starred

* Favarites N
All of your discussions in one place
Click on a group's star Organize with favorites and folders, choase to follow along via emai, and quickly find unread posts
ican fo add it to your
favorites

Express yourseff
Use rich-text editing to cusiomize your posts with fonts, colors, and images.
* Recently viswed
Qs People power discussions
Use photos, nicknames, and automatic iranslations to share your thoughts with the warld.

Common Course .

™ Recently postzd o Speed matters
Common Course .. Keyboard shoricuts and a sireamlined design mean you won't spend fime watting to read and getinvolved. Press 7" to sea the full st of shortcuts.
10A=tAMU

Mobile friendly
Access Groups fom anywhere using your mobile device with our opfimized site
Privaty - Terms of Service

4. Complete the blank spaces

Groups - crente [
4
My groups
Home Group name I
Starred
Group email address @ googlegroups com
Favorites

Click on & group's star Group description
icon to add it fo your

favorites
Recently viewed y
1QAatAMU
Commen Course .. Group’s primary language English (United States) »
This is the language emails from the
Recently posted to Gongle groups service il be senlin
Common Course .. For example: digest emails, email
foolers, etc.
10Aat AMU

5. Select a group type. In the "Group type" section, click the
"Select a group type" drop-down box, then click one of the
following options in the resulting drop-down menu:

v" Email list — Allows you to contact all group members
at once by emailing the Google Group email address.
v" Web forum — Allows group members to post and reply

to topics.

v Q&A forum — Allows group members to post
questions, add answers, and mark addressed questions as
answered.

v Collaborative inbox — Allows you to assign questions
or topics to specific group members.
See the picture below.
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Group type Group types are pre-configured settings for your Google group &
easier. You can always change the specific settings and enable ;
Select a type to get more information.

Select a group type m ﬂ

Email list

An email list allows Web forum

Q&A forum

. v Collaborative inbox
Basic permissions + Y Alme

6. Set your group's permissions. You can determine who can view
your group's topics, post in the group, and join the group by
doing the following:

View Topics

v View Topics — Click the Select Groups of Users box,
then click a privacy option to check or uncheck it.

v Post — Click the Select Groups of Users box, then click
a privacy option to check or uncheck it.

v" Join the Group — Click the Select who can join box, then
check the option you want to use.
See the picture below.

Easlc permisslons View Topics Salect groups of users » ¥ All members of the group

These Lsers can view topics in 1his group.

Post Selact groups of users + v Al members of the group

These users can post messages o this group,

Join the Group Selectwhocanjoin + ¥ Anyone can ask
G Moocsforkng X | 88 BMELT Ben X | © Ehotsplorer x| © eamswons x | mm enasnsnn X | P Mesagesks X | Newmab x| B usiedtom x | + - o %
How to use Google € 5 O O (RSO B SRR Y EEICE
15! Apps Q0 elearning develop... @ NewTab G wwwpmpacom - G.. i Assignment @ smsamueduetis. € YouTube ¥ Maps Gmail
Forms for -
researchlng and QUESTIONS  RESPONSES
quizzing Untitled form
Email address *
nmled Question) @ Multiple choice o
O optien1 T
O & =
o

H O 1ype here to search
I ——
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You can use Google Forms to create online surveys and quizzes
and send them to other people.
Step 1: Set up a new form or quiz

1. Go to forms.google.com.

2. Click Blank * .
A new form will open.

M Inbox (976) - hops X ‘ u Mail - Tesfaye Hat X ‘ € EthioExplorercom X | G howtorecord nar X ‘ 27 Record aslide she X ‘ G how tostop sounc X E GoogleForms X 4 &

€ 5 C @ docsgooglecom/forms/u/0/ e 4 & \e

NewTab G wwwpmpacom-G.. T Assignment @ smisamueduetius.. 0 YouTube PP Maps M Gmal
Q Search i @

Startanew form Ternplate gallery 5

i Apps O elearning d

= a Form

Blank

< Untitled form

QUESTIONS RESPONSES

Untitled form

Email address *

This form is collecting email addresses. Change settings =)
T
Untitled Question| @ wuttiple choice
option 1 [+ ]
-

A ADD "OTHER" = (] J

. a . 11:42 AM
H QO Type here to search i = 3 B A@woe) e TN 0

Create a form from When you create a Google Form, it’s saved in Google Drive. To
Google Drive create a form directly from Google Drive:

1. Onacomputer, go to drive.google.com.

2. Inthe top left, click New.

3. Click More * Google Forms.
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Create a form in
Google Sheets

M Inbox (976) - b X ‘ ﬂ Mail- Tesfaye - X ‘ € EthioEsplorer.: X ‘ G howtorecord X ‘ H Record aslide X ‘ G howtostopsc X ‘ G createaform X @ MyDrive-Go X = + =

*B¢eQ

€ 5 X Q @ drive.google.com/drive/my-drive

HoApps 3 elamingdevelop.. @ NewTb G wwwpmpacom-G.. T Assignment ) smisamueduetius.. [ YouTube B} Maps M Gmal

0 e TASKS
LDnve Q  SearchDrive v @ {33 i @ Loading..

My Drive ~ H
-|- New ¥ @
N
Quick Access B
4 My Drive
gfe :
Starred
m Trash B Ssurveyoncourse and le.. B Howto use Google Docs Survey on course and le...
YYou edited in the past month Edited in the past month by Cha.. You shared in the past year

E« Backups ']

Name 4 Ouner Last modified

E Storage
BB Classroom me Jan 29,2019 me

M Inbox (976)- 1+ X | (@ Mail-Tesfaye X | & EthioExplorerc X | G howtorecord X | B Recordaside X | G howtostopsc X | G createaforn X & My

& > C {} & drivegoogle.com/drive/my-drive

H Apps QO elearmingdevelop.. @ MewTab G wwwpmpacom-G.. T Assignment (D) smisamueduetius.. @B YouTube ¥ Maps M Gmail

L Drive Q  search Drive v @ fs] i e

2> H ® a
[ Ca Folder L
ess
| File upload @
Folder upload in ﬂ
mm w] °
B Google Docs >
Google Sheets >
O Google Slides 4 eyoncourseandle.. | | [B Howtouse Google Does Survey on course and le...
More > ‘ - Cha... You shared in the past year
1 B Google Forms > L
[ Backups | B coogle Drawings
Name Owner Last modified
K Google My Maps L
= Sstorage
- 9 B c: [ GcoogleSites me Jan 29,2019 me
5.6 GB of 15 GB used | M@ Google Jamboard I
BUY STORAGE | me Dec 11,2012 me
[ | -+  Connect more apps ]
B g me Dec 11,2012 me
x
|:| Get Backup and Sync for 0  1.3it_docx me Feb 3,2014 me -

When you create a form in Google Sheets, the responses will be
saved in a new sheet. Learn more about where you can save

responses.
1. On acomputer, open a spreadsheet at sheets.google.com.

2. Click main menu *> Form.
3. A new sheet will appear in your spreadsheet, and your form

will open.
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M Inbox(376)-+ X | Mal-Testaye X | € Ethioplorerc % | G howtorecors x | B¥ Recordasice x | G howtostops: X | G cremteatom X Google Sheets X | 4 - 8 X
€ 3 C } @ docsgooglecom/spreadshests/u/l) e e+ 0

H odpps K deamingdeviop.. @ NewTb G wwpmpacom -G f Assignment @) smisemucducths. 0 YouTube BY Meps M Gmai

= [§ sheets Q oo 0

Start a new spreadsheet Template gallery §
:F

Blank Schedule To-dolist Annual budget Monthly budget

Earlier Ownedbyanyene v Lastopenedbyme EB AZ [

Survey and learning strategy pr R 2 me Sep9,2018

Coninous Assessment Progress Report me Sep4,2019

AMU Al Lab courses attendance 2, ‘Abey Bruck Jul 8,2019

Quality Enhancement Pelicies and Practices in Ethicpian Hi.. me Apr 26,2018

Schedule me Apr 26,2018 H

oy o — P P o p o TEBAM
H QO Type here to search 4 ey = I~ Rl E @ 9 9 £ romdum,, LU

M Inbox(976) -+ X | @ Mail-Tesfaye X | € Ehiobxplorerc X | G howtorecor X | B¥ Recordaside X ] G howtostopsc X | G cresteafon x| [E] GoogleForms X+ - X
€ 3 C 0 @ docsgooglecom/forms/u/l/ * t 20

i Apps % eleomingdevelop.. @ NewTb G wwwpmpacom-G.. fh Assgoment ) smisamueduetis. @ YouTube Y Meps M Gmail

= H Forms Q  search # 0

Start anew form Template gallery §

Blank Contact Information RSVP Party Invite T-Shirt Sign Up

Recent forms Owned by anyone v B a0
f \ ﬂ .
= [ e
— S s S ——
Survey oncourse andlear..  Untitled form Communicative EnglishsS... Untitled form
B openeadecs 2019 3 B openeasep 10,2019 3 B openedseps 2019 3 B openeaseps 209 3
= [ N cmaceu"a0E500

Step 2: Edit and format a form or quiz
You can add, edit, or format text, images, or videos in a form.
o Edit your form
o Create a quiz with Google Forms
e Choose where to save form responses
Step 3: Send your form for people to fill out
When you are ready, you can send your form to others and collect
their responses.
How to Set Up a If you already have a Google account, setting a blog will be very
Google Blog easy on Blogger.
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Steps

How to use Google
Drive

TRAINING MANUAL

1

Visit Blogger. Go to blogger.com from any web browser. Here
you will see a sign-in box. Blogger is Google’s blog platform.

2

Log into your Google account. Under the sign-in box, type in
your Gmail email address and password. This is your one Google
ID for all Google’s services, including Blogger. Click the “Sign in”
button to proceed.

e Once you’re signed in, you will be brought to your
main Blogger dashboard. All your blogs are found
here. Blogs you follow can also be accessed from
the dashboard.

3

Click “New blog.” You’ll find this under your Blogs section on
the dashboard. After you click the button, the “Create a new blog”
window will appear. It contains several fields you need to populate
to define your blog.

4

Enter a blog Title. The first field is for your blog title. Think of
something creative and memorable for your title to attract readers.
There’s a lot of blogs out there and you need to find your niche.
Picking the perfect title can be hard, but it’s important. It’s your
name, your brand, and your trademark.

5

Create your Address. Since you’re housing your blog on Blogger,
you will have "blogspot.com” in your address. The name that goes
before it is something you can control. You can use your title or
part of it as your address. Similar to your blog title, your URL or
Internet address needs to be unique and attractive. Make it
memorable so that people can easily recognize and remember it.
Type it in the second field. If the text you’ve entered is already
taken, you will be notified since the address needs to be unique.

6

Pick a Template. The third section contains templates for your
blog. Blogger has some good templates available to help you start
your blog. Scroll through the available templates and pick one that
suits your blog. Remember, you can always fine-tune your theme
later.

7

Create your blog. When you’re done, click the “Create blog!”
button at the bottom of the window. You’re set. The blog is now
created and you can start writing.

Step 1: Go to drive.google.com
» On your computer, go to drive.google.com. You’ll see
"My Drive," which has:
» Files and folders you upload or sync
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Step 2: Upload or create files
» You can upload files from your computer or create files
in Google Drive.
» Upload files and folders to Google Drive
» Work with Office files
» Create, edit, and format Google Docs, Sheets, and
Slides
Step 3: Share and organize files
P You can share files or folders, so other people can view,
edit, or comment on them.
» Share files from Google Drive
» Share folders from Google Drive
» Make someone else the owner of a file
P To see files that other people have shared with you, go to
the ""Shared with me'" section.

THE END
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